Copyright © 2003 Parametric Technology Corporation. All Rights Reserved.

User and training documentation from Parametric Technology Corporation (PTC) is subject to the copyright laws of the United States and other countries and is provided under a license agreement that restricts copying, disclosure, and use of such documentation. PTC hereby grants to the licensed user the right to make copies in printed form of this documentation if provided on software media, but only for internal/personal use and in accordance with the license agreement under which the applicable software is licensed. Any copy made shall include the PTC copyright notice and any other proprietary notice provided by PTC. This documentation may not be disclosed, transferred, modified, or reduced to any form, including electronic media, or transmitted or made publicly available by any means without the prior written consent of PTC and no authorization is granted to make copies for such purposes.

Information described herein is furnished for general information only, is subject to change without notice, and should not be construed as a warranty or commitment by PTC. PTC assumes no responsibility or liability for any errors or inaccuracies that may appear in this document.

The software described in this document is provided under written license agreement, contains valuable trade secrets and proprietary information, and is protected by the copyright laws of the United States and other countries. It may not be copied or distributed in any form or medium, disclosed to third parties, or used in any manner not provided for in the software licenses agreement except with written prior approval from PTC. UNAUTHORIZED USE OF SOFTWARE OR ITS DOCUMENTATION CAN RESULT IN CIVIL DAMAGES AND CRIMINAL PROSECUTION.

Registered Trademarks of Parametric Technology Corporation or a Subsidiary

Trademarks of Parametric Technology Corporation or a Subsidiary

Third-Party Trademarks
Adobe is a registered trademark of Adobe Systems. Advanced ClusterProven, ClusterProven, and the ClusterProven design are trademarks or registered trademarks of International Business Machines Corporation in the United States and other countries and are used under license. IBM Corporation does not warrant and is not responsible for the operation of this software product. AIX is a registered trademark of IBM Corporation. Allegro, Cadence, and Concept are registered trademarks of Cadence Design Systems, Inc. AutoCAD and
AutoDesk Inventor are registered trademarks of Autodesk, Inc. Baan is a registered trademark of Baan Company. CADAM and CATIA are registered trademarks of Dassault Systemes. COACH is a trademark of CADTRAIN, Inc. DOORS is a registered trademark of Telelogic AB. FLEXlm is a registered trademark of GLOBEtrotter Software, Inc. Geomagic is a registered trademark of Raindrop Geomagic, Inc. EVERSINC, GROOVE, GROOVEFEST, GROOVE.NET, GROOVE NETWORKS, iGROOVE, PEERWARE, and the interlocking circles logo are trademarks of Groove Networks, Inc. Helix is a trademark of Microcadam, Inc. HOOPS is a trademark of Tech Soft America, Inc. HP-UX is a registered trademark and Tru64 is a trademark of the Hewlett-Packard Company. I-DEAS, Metaphase, Parasolid, SHERPA, Solid Edge, and Unigraphics are trademarks or registered trademarks of Electronic Data Systems Corporation (EDS). InstallShield is a registered trademark and service mark of InstallShield Software Corporation in the United States and/or other countries. Intel is a registered trademark of Intel Corporation. IRIX is a registered trademark of Silicon Graphics, Inc. MatrixOne is a trademark of MatrixOne, Inc. Mentor Graphics and Board Station are registered trademarks and 3D Design, AMPLE, and Design Manager are trademarks of Mentor Graphics Corporation. MEDUSA and STHENO are trademarks of CAD Schroer GmbH. Microsoft, Microsoft Project, Windows, the Windows logo, Windows NT, Visual Basic, and the Visual Basic logo are registered trademarks of Microsoft Corporation in the United States and/or other countries. Netscape and the Netscape N and Ship's Wheel logos are registered trademarks of Netscape Communications Corporation in the U.S. and other countries. Oracle is a registered trademark of Oracle Corporation. OrbixWeb is a registered trademark of IONA Technologies PLC. PDGS is a registered trademark of Ford Motor Company. RAND is a trademark of RAND Worldwide. Rational Rose is a registered trademark of Rational Software Corporation. RetrievalWare is a registered trademark of Convera Corporation. RosettaNet is a trademark and Partner Interface Process and PIP are registered trademarks of "RosettaNet," a nonprofit organization. SAP and R/3 are registered trademarks of SAP AG Germany. SolidWorks is a registered trademark of SolidWorks Corporation. All SPARC trademarks are used under license and are trademarks or registered trademarks of SPARC International, Inc. in the United States and in other countries. Products bearing SPARC trademarks are based upon an architecture developed by Sun Microsystems, Inc. Sun, Sun Microsystems, the Sun logo, Solaris, UltraSPARC, Java and all Java based marks, and "The Network is the Computer" are trademarks or registered trademarks of Sun Microsystems, Inc. in the United States and in other countries. VisTools is a trademark of Visual Kinematics, Inc. (VKI). VisualCafé is a trademark of WebGain, Inc. WebEx is a trademark of WebEx Communications, Inc.

**Licensed Third-Party Technology Information**

Certain PTC software products contain licensed third-party technology: Rational Rose 2000E is copyrighted software of Rational Software Corporation. RetrievalWare is copyrighted software of Convera Corporation. VisualCafé is copyrighted software of WebGain, Inc. VisTools library is copyrighted software of Visual Kinematics, Inc. (VKI) containing confidential trade secret information belonging to VKI. HOOPS graphics system is a proprietary software product of, and is copyrighted by, Tech Soft America, Inc. G-POST is copyrighted software and a registered trademark of Intercim. VERICUT is copyrighted software and a registered trademark of CGTech. Pro/PLASTIC ADVISOR is powered by Moldflow technology. Moldflow is a registered trademark of Moldflow Corporation. The JPEG image output in the Pro/Web.Publish module is based in part on the work of the independent JPEG Group. DFORMD.DLL is copyrighted software from Compaq Computer Corporation and may not be distributed. METIS, developed by George Karypis and Vipin Kumar at the University of Minnesota, can be researched at [http://www.cs.umn.edu/~karypis/metis](http://www.cs.umn.edu/~karypis/metis). METIS is © 1997 Regents of the University of Minnesota. LightWork Libraries are copyrighted by LightWork Design 1990-2001. Visual Basic for Applications and Internet Explorer is copyrighted software of Microsoft Corporation. Adobe Acrobat Reader is copyrighted software of Adobe Systems. Parasolid © Electronic Data Systems (EDS). Windchill Info*Engine Server contains IBM XML Parser for Java Edition and the IBM Lotus XSL Edition. Pop-up calendar components Copyright © 1998 Netscape Communications Corporation. All Rights Reserved. TECHNO-MATIX is copyrighted software and contains proprietary information of Technomatix Technologies Ltd. Apache Server, Tomcat, Xalan, and Xerces are technologies developed by, and are copyrighted software of, the Apache Software Foundation ([http://www.apache.org/](http://www.apache.org/) - their use is subject to the terms and limitations at: [http://www.apache.org/LICENSE.txt](http://www.apache.org/LICENSE.txt), UnZip (© 1990-2001 Info-ZIP, All Rights Reserved) is provided "AS IS" and WITHOUT WARRANTY OF ANY KIND. For the complete Info-ZIP license see
ftp://ftp.info-zip.org/pub/infozip/license.html. Gecko and Mozilla components are subject to the Mozilla Public License Version 1.1 at http://www.mozilla.org/MPL/. Software distributed under the MPL is distributed on an "AS IS" basis, WITHOUT WARRANTY OF ANY KIND, either express or implied. See the MPL for the specific language governing rights and limitations. Technology "Powered by Groove" is provided by Groove Networks, Inc. Technology "Powered by WebEx" is provided by WebEx Communications, Inc. Acrobat Reader is Copyright © 1998 Adobe Systems Inc. Oracle 8i run-time, Copyright © 2000 Oracle Corporation. The Java™ Telnet Applet (StatusPeer.java, TelnetIO.java, TelnetWrapper.java, TimedOutException.java), Copyright © 1996, 97 Mattias L. Jugel, Marcus Meißner, is redistributed under the GNU General Public License. This license is from the original copyright holder and the Applet is provided WITHOUT WARRANTY OF ANY KIND. You may obtain a copy of the source code for the Applet at http://www.mud.de/se/jta (for a charge of no more than the cost of physically performing the source distribution), by sending e-mail to leo@mud.de or marcus@mud.de—you are allowed to choose either distribution method. The source code is likewise provided under the GNU General Public License. GTK+The GIMP Toolkit are licensed under the GNU LPGL. You may obtain a copy of the source code at http://www.gtk.org/, which is likewise provided under the GNU LPGL. zlib software Copyright © 1995-2002 Jean-loup Gailly and Mark Adler.

UNITED STATES GOVERNMENT RESTRICTED RIGHTS LEGEND
This document and the software described herein are Commercial Computer Documentation and Software, pursuant to FAR 12.212(a)-(b) (OCT'95) or DFARS 227.7202-1(a) and 227.7202-3(a) (JUN'95), is provided to the US Government under a limited commercial license only. For procurements predating the above clauses, use, duplication, or disclosure by the Government is subject to the restrictions set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software Clause at DFARS 252.227-7013 (OCT'88) or Commercial Computer Software-Restricted Rights at FAR 52.227-19(c)(1)-(2) (JUN'87), as applicable. 040103

Parametric Technology Corporation, 140 Kendrick Street, Needham, MA 02494 USA
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About Search</td>
<td>2-2</td>
</tr>
<tr>
<td>About Keyword Searches</td>
<td>2-2</td>
</tr>
<tr>
<td>About the Advanced Search Page</td>
<td>2-3</td>
</tr>
<tr>
<td>Specifying Search Criteria</td>
<td>2-3</td>
</tr>
<tr>
<td>Special Characters in Search</td>
<td>2-4</td>
</tr>
<tr>
<td>Setting Search Preferences</td>
<td>2-5</td>
</tr>
<tr>
<td>Saving a Search</td>
<td>2-5</td>
</tr>
<tr>
<td>Using Search Modes</td>
<td>2-6</td>
</tr>
<tr>
<td>About Search Results</td>
<td>2-8</td>
</tr>
<tr>
<td>About Wildcards</td>
<td>2-9</td>
</tr>
<tr>
<td>Communication Tools In Windchill PDMLink</td>
<td>3-1</td>
</tr>
<tr>
<td>Communication Tools</td>
<td>3-2</td>
</tr>
<tr>
<td>Meetings</td>
<td>3-2</td>
</tr>
<tr>
<td>Subscriptions</td>
<td>3-4</td>
</tr>
<tr>
<td>Discussion Forums</td>
<td>3-5</td>
</tr>
<tr>
<td>Managing Documents</td>
<td>4-1</td>
</tr>
<tr>
<td>Understanding Document Management</td>
<td>4-2</td>
</tr>
<tr>
<td>Creating Documents</td>
<td>4-4</td>
</tr>
<tr>
<td>Viewing Documents</td>
<td>4-7</td>
</tr>
<tr>
<td>Associating Files and Documents</td>
<td>4-7</td>
</tr>
<tr>
<td>Attaching Additional Files to a Document</td>
<td>4-8</td>
</tr>
<tr>
<td>Adding Document References</td>
<td>4-8</td>
</tr>
<tr>
<td>Placing Documents in a Structure</td>
<td>4-8</td>
</tr>
<tr>
<td>Modifying Documents</td>
<td>4-8</td>
</tr>
<tr>
<td>Managing Documents with Windchill Desktop Integration</td>
<td>4-10</td>
</tr>
<tr>
<td>Installing Windchill Desktop Integration</td>
<td>4-11</td>
</tr>
<tr>
<td>Windchill Menu Options</td>
<td>4-11</td>
</tr>
<tr>
<td>Exchanging Attributes between Windchill and Microsoft Office</td>
<td>4-13</td>
</tr>
<tr>
<td>Options for Downloading Documents</td>
<td>4-14</td>
</tr>
<tr>
<td>Desktop Integration File Download Option</td>
<td>4-14</td>
</tr>
<tr>
<td>Java Applet File Download Option</td>
<td>4-15</td>
</tr>
<tr>
<td>Browser Download</td>
<td>4-15</td>
</tr>
<tr>
<td>Working with CAD Data</td>
<td>5-1</td>
</tr>
<tr>
<td>About CAD Documents</td>
<td>5-2</td>
</tr>
<tr>
<td>About the Workspace</td>
<td>5-2</td>
</tr>
<tr>
<td>Workspace Features</td>
<td>5-2</td>
</tr>
<tr>
<td>Workspace Configuration</td>
<td>5-3</td>
</tr>
<tr>
<td>Workspace Actions</td>
<td>5-3</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Overview</td>
<td>9-2</td>
</tr>
<tr>
<td>Accessing Visualization</td>
<td>9-2</td>
</tr>
<tr>
<td>ProductView Features</td>
<td>9-5</td>
</tr>
<tr>
<td>Viewing Data</td>
<td>9-5</td>
</tr>
<tr>
<td>Navigating ProductView</td>
<td>9-6</td>
</tr>
<tr>
<td>Annotating Files</td>
<td>9-7</td>
</tr>
<tr>
<td>Measuring Dimensions and Distance</td>
<td>9-7</td>
</tr>
<tr>
<td>Publishing Visualization Data to Windchill</td>
<td>9-8</td>
</tr>
<tr>
<td>Setting Preferences</td>
<td>9-9</td>
</tr>
<tr>
<td>Using Integrated Windchill Capabilities</td>
<td>10-1</td>
</tr>
<tr>
<td>Overview</td>
<td>10-2</td>
</tr>
<tr>
<td>Making PDM Data Available to Your Project Team</td>
<td>10-3</td>
</tr>
<tr>
<td>Sharing PDM Objects to a Project</td>
<td>10-4</td>
</tr>
<tr>
<td>Refreshing a Project</td>
<td>10-7</td>
</tr>
<tr>
<td>Checking Out PDM Objects to a Project</td>
<td>10-8</td>
</tr>
<tr>
<td>Using Actions and Icons</td>
<td>10-11</td>
</tr>
<tr>
<td>Examining a Usage Scenario</td>
<td>10-11</td>
</tr>
<tr>
<td>Setting Up Your Environment for This Scenario</td>
<td>10-11</td>
</tr>
<tr>
<td>Task 1. Creating a Product From an Existing Product</td>
<td>10-12</td>
</tr>
<tr>
<td>Task 2. Creating and Working in a Collaborative Project</td>
<td>10-25</td>
</tr>
<tr>
<td>Task 3. Collaborating with an External Supplier</td>
<td>10-28</td>
</tr>
<tr>
<td>Task 4. Making Design Changes in the PDM System</td>
<td>10-33</td>
</tr>
<tr>
<td>Task 5. Updating a Collaborative Project</td>
<td>10-35</td>
</tr>
<tr>
<td>Task 6. Reviewing Changes and Publishing Updates to the ERP System</td>
<td>10-37</td>
</tr>
</tbody>
</table>
The following table explains the changes made to this guide from the last release of Windchill PDMLink.

### Table 1 Changes for Release 7.0

<table>
<thead>
<tr>
<th>Change</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 1, <a href="#">Before You Begin</a></td>
<td>This new section discusses the steps you need to perform to successfully run Windchill PDMLink on your local machine.</td>
</tr>
<tr>
<td>Chapter 1, <a href="#">Using the Header Links</a></td>
<td>This section was updated to describe the changes made to the header of the screen.</td>
</tr>
<tr>
<td>Chapter 1, <a href="#">Using Special Characters in Windchill PDMLink</a></td>
<td>This new section discusses the characters that should not be used when you enter information in Windchill PDMLink pages.</td>
</tr>
<tr>
<td>Chapter 3, <a href="#">Communication Tools In Windchill PDMLink</a></td>
<td>This new chapter explains the use of certain tools with Windchill that enhance team communication.</td>
</tr>
<tr>
<td>Chapter 4, <a href="#">Associating Files and Documents</a></td>
<td>This new section explains document attachments, reference documents, and document structure.</td>
</tr>
<tr>
<td>Chapter 4, <a href="#">Creating Documents</a></td>
<td>This section contains a new example illustrating how to create a document using the new Create Multiple Document functionality.</td>
</tr>
<tr>
<td>Chapter 4, <a href="#">Exchanging Attributes between Windchill and Microsoft Office</a></td>
<td>This new section explains how to add Windchill attribute information into Microsoft Office documents.</td>
</tr>
<tr>
<td>Change</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Chapter 4, <strong>Options for Downloading Documents</strong></td>
<td>This new section explains the user preferences relating to document content.</td>
</tr>
<tr>
<td>Chapter 5, <strong>Working with CAD Data</strong></td>
<td>This new chapter explains using the HTML user interface to manage CAD data.</td>
</tr>
<tr>
<td>Chapter 6, <strong>Managing Products and Product Structures</strong></td>
<td>The term <em>product</em>, when used to describe the special part in a product structure, has been changed to <em>end item</em>. The term product remains to describe the context in which parts and end items reside.</td>
</tr>
<tr>
<td>Chapter 7, <strong>Managing Context Teams</strong></td>
<td>This new chapter explains how to set up and manage a context team.</td>
</tr>
<tr>
<td>Chapter 8, <strong>Managing Change</strong></td>
<td>This chapter includes new diagrams that illustrate the fast track and full track change processes.</td>
</tr>
<tr>
<td>Chapter 9, <strong>Visualizing Data in Windchill</strong></td>
<td>This new chapter discusses the visualization features available in Windchill.</td>
</tr>
<tr>
<td>Chapter 10, <strong>Using Integrated Windchill Capabilities</strong></td>
<td>This new chapter provides conceptual information and an extensive usage scenario for working in an integrated Windchill environment, in which Windchill ProjectLink and Windchill PDMLink are co-installed on a single server.</td>
</tr>
</tbody>
</table>
About This Guide

This version of the Windchill PDMLink User’s Guide provides an overview of the concepts and navigation in Windchill PDMLink. To view or download an updated version of this guide, see


To view procedures for specific functionality, click the help button on the relevant Windchill PDMLink screen.

This guide is intended for end users of Windchill PDMLink.

Technical Support

Contact PTC Technical Support via the PTC Web site, phone, fax, or e-mail if you encounter problems using Windchill.

For complete details, refer to Contacting Technical Support in the PTC Customer Service Guide enclosed with your shipment. This guide can also be found under the Support Bulletins section of the PTC Web site at:

http://www.ptc.com/support/index.htm

The PTC Web site also provides a search facility that allows you to locate Technical Support technical documentation of particular interest. To access this page, use the following link:

http://www.ptc.com/support/support.htm

You must have a Service Contract Number (SCN) before you can receive technical support. If you do not have an SCN, contact PTC License Management using the instructions found in your PTC Customer Service Guide under Contacting License Management.
Documentation for PTC Products

PTC provides documentation in the following forms:

• Help topics
• Tutorials
• PDF books

To view and print PDF books, you must have the Adobe Acrobat Reader installed.

All documentation is included on the CD for the application. In addition, books updated after release (for example, to support a hardware platform certification) are available from the Reference Documents section of the PTC Web site at the following URL:

http://www.ptc.com/cs/doc/reference/

Comments

PTC welcomes your suggestions and comments on its documentation -- send comments to the following address:

documentation@ptc.com

Please include the name of the application and its release number with your comments. For online books, provide the book title.

Documentation Conventions

Windchill documentation uses the following conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Item</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bold</strong></td>
<td>Names of elements in the user interface such as buttons, menu paths, and window titles. Required elements and keywords or characters in syntax formats.</td>
<td>Click OK. Select File &gt; Save. <strong>Create Document</strong> window <code>create_&lt;tablename&gt;.sql</code></td>
</tr>
<tr>
<td><strong>Italic</strong></td>
<td>Variable and user-defined elements in syntax formats. Angle brackets (&lt; and &gt;) enclose individual elements.</td>
<td><code>create_&lt;tablename&gt;.sql</code></td>
</tr>
<tr>
<td>Convention</td>
<td>Item</td>
<td>Example</td>
</tr>
<tr>
<td>------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><img src="image" alt="CAUTION" /></td>
<td>The CAUTION symbol indicates potentially unsafe situations which may result in minor injury, machine damage or downtime, or corruption or loss of software or data.</td>
<td>When you add a value to an enumerated type (for example, by adding a role in the RolesRB.java resource file), removing that value can result in a serious runtime error. Do not remove a role unless you are certain there is no reference to it within the system.</td>
</tr>
</tbody>
</table>
Getting Started with Windchill PDMLink

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Before You Begin</td>
<td>1-2</td>
</tr>
<tr>
<td>Understanding Windchill PDMLink</td>
<td>1-5</td>
</tr>
<tr>
<td>Windchill PDMLink Objects, Products, and Libraries</td>
<td>1-6</td>
</tr>
<tr>
<td>Using the Windchill PDMLink Tabs</td>
<td>1-9</td>
</tr>
<tr>
<td>Using the Header Links</td>
<td>1-16</td>
</tr>
<tr>
<td>Setting User Preferences</td>
<td>1-17</td>
</tr>
<tr>
<td>Using Special Characters in Windchill PDMLink</td>
<td>1-23</td>
</tr>
</tbody>
</table>
Before You Begin

Before you begin using Windchill PDMLink, the following steps are recommended for you to successfully run the application on your local machine:

- Ensure that you have the correct Web browser and plug-in version.
- Ensure that your ActiveX settings are configured to allow thumbnail viewing.
- Ensure that your pop-up blockers do not interfere with Windchill PDMLink functionality.
- Run the bootstrap loader, if necessary.
- If Windchill ProductView Standard Edition has been purchased and installed at your site, and you desire the additional advanced visualization capability it provides, download and install Windchill ProductView Standard Edition.

The following sections explain these steps in more detail.

Web Browser and Java Plug-In Version

Ensure that you are using a Web browser and Java plug-in version that is supported by Windchill PDMLink. Supported browsers and plug-ins are listed in the PTC software matrix.

The software matrix lists the combinations of platforms, operating systems, and third-party products that are certified for use with this release on Windows and UNIX operating systems.

To obtain a copy of the software matrix, use the following URL. This URL will direct you to the PTC Online Support Web page for reference documents. For your document search criteria, select Windchill PDMLink from the product drop-down list. Select the software matrix for this release from the returned document list.


Product and version matrix information is updated periodically to adjust to environment changes. If you cannot access the software matrix, see your System Administrator for this information.

ActiveX Settings

If you are using Internet Explorer, ensure that the ActiveX settings for your browser are enabled to allow viewing of images, such as object thumbnails.

Use the following steps to ensure that your ActiveX settings are properly enabled:

1. Select Tools > Internet Options.
2. On the Security tab, in the Security level for this zone section, click Custom Level.
The Security Settings window opens.

3. Make sure that the following settings are set to Ensure or Prompt:
   - Download signed ActiveX controls
   - Run ActiveX controls and plug-ins

4. Click OK to accept the settings and close the Security Setting window.

5. Click OK to close the Internet Options window.

For additional information, contact your System Administrator.

**Pop-Up Blocker Interference**

Many Web browsers and third-party applications offer pop-up blocker capabilities to prevent unwanted pop-ups from being opened on your local machine. This can interfere with some Windchill PDMLink operations that automatically open new windows, keeping you from being able to complete certain functions, such as downloading object content.

This interference can be avoided by designating your Windchill server domain as an allowed site. This means that if your Windchill home page URL begins with "http://www.mycompany.com/Windchill", you would add "mycompany.com" to the list of allowed sites.

For example, in Netscape 7.1, you would do this by selecting Edit>Preferences, and under Privacy and Security, select Popup Windows. Click the Allowed Sites button. In the Allow popups from the following websites field, enter "mycompany.com". Click Add, then click OK.

**Tip:** Be sure to recheck your pop-up blocker settings if you install a new Web browser. Installing additional Web browsers (for example, installing Mozilla in addition to Netscape) can change your existing pop-up blocking settings.

For purposes of popup blocking, Netscape treats port numbers as part of the host name. If your Windchill server is listening on a non-default port number, and you are using Netscape as your Web browser, you must add the host name, including the port number, to your list of allowed sites. This means that if your Windchill home page URL begins with "http://mycompany.com:8080/Windchill" or "https://mycompany.com:8080/Windchill", you would add "mycompany.com:8080" to the lists of allowed sites.

For additional information or assistance with pop-up blocker settings (including port numbers), contact your System Administrator.

**Bootstrap Loader Installation**

The bootstrap loader allows Windchill applets to work on computer networks which do not allow applets to communicate directly with the Windchill server. If
you are experiencing difficulties with your Windchill access, contact your System Administrator to determine if you need to install the bootstrap loader.

For example, the bootstrap loader may be needed to facilitate creating and modifying documents, several administrative functions, and the Product Information Manager and Annotator.

Use the following procedure to install the bootstrap loader, if necessary.

1. From the Home tab, navigate to the Utilities page, and click the Software Downloads link.
   
   If prompted, read the license agreement, and click Accept.

2. On the Software Downloads page, click the Bootstrap Loader Installation link in the Setup and Installation 7.0 section.
   
   The bootstrap installation wizard opens.

3. Follow the instructions on each page of the wizard. When you are done, click Finish.

4. Close and restart your Web browser session.

**Windchill Visualization Services**

Windchill Visualization Services provide you with the ability to view, annotate, and collaborate on data stored in Windchill. An embedded visualization tool and its necessary plug-ins are included in Windchill PDMLink to view 3D CAD data, drawings, and images, and is automatically downloaded when required. To view or annotate some documents or ECAD data, the appropriate viewing option must be purchased and installed.

Windchill ProductView Standard Edition provides advanced features such as electronic interference checking, animation tools, and real-time, peer-to-peer collaboration. If it has been purchased and installed at your site, you can download and install it on your local machine.

To download and install Windchill ProductView Standard Edition, use the following procedure:

1. From the Home tab, navigate to the Utilities page, and click the Software Downloads link.
   
   If prompted, read the license agreement, and click Accept.

2. On the Software Downloads page, click the ProductView Installation link in the Setup and Installation 7.0 section.
   
   The Download ProductView window opens.

3. Follow the provided instructions to open the Windchill ProductView setup program and complete the installation.
4. Restart your browser.

Windchill ProductView is now ready to use. You may now download additional special use Windchill ProductView executables.

Additional Downloads

The following additional downloads may be available from the Download ProductView window:

- **PVHelp_all.exe** - Installs the online help for Windchill ProductView Standard Edition. Optional, but recommended.
- **PVClientImportFilters.exe** - Adds options to the **File Open** dialog to open additional file formats from other applications, such as Pro/ENGINEER, DGN, GBF, IGES, STL, and VRML files. This download is optional.
- **PVSimulationViewer.exe** - Adds components needed to view DIVISION MockUp files. This download is optional, and is available only for Windows systems.
- **PVECADview.exe** - Adds electronic CAD capabilities, including viewing circuit designs and other electronic drawings. This download is optional, and available only if it has been purchased and installed at your site.
- **acrobat60_<language>.exe** - Provides Adobe Acrobat 6.0 functionality for use with the document viewing option. Available only if the document viewing option has been purchased and installed at your site. There are multiple versions of this executable available, supporting different languages, for example acrobat60_efg.exe supports English, French, and German languages. Your System Administrator installs the version appropriate for your site. If you already have Adobe Acrobat 6.0 installed on your machine, you do not need this download to use the document viewing functionality.
- **PVPDFPlugin.exe** - Provides ability to markup PDF files. Required for document viewing option.

**Understanding Windchill PDMLink**

Windchill PDMLink is a product data management system that provides a single source for product data for your company and facilitates the following critical processes that occur throughout the life of a product:

- release management
- change management
- configuration management

In addition, the Windchill PDMLink system
allows global and controlled access to critical product data within your company, using a familiar application and navigation paradigm, namely, a Web browser.

- provides extensive capabilities in the areas of data control, confirmation management, process control, and change management using the Windchill PDMLink certified CMII process.

- accommodates data from other critical applications.
  - Windchill PDMLink contains a light viewer to allow MCAD and ECAD tools to be directly managed and exposed to non-CAD users.
  - Windchill PDMLink integrates with ERP systems (for example, SAP) through an integration platform called Enterprise Systems Integration.
  - Windchill PDMLink is tightly connected to PTC applications such as Windchill ProjectLink and Pro/ENGINEER Wildfire.

In order to use Windchill PDMLink to locate, access, and use product information, this chapter provides information for the following items:

- Windchill PDMLink objects and their place in products and libraries
- Windchill PDMLink tabs
- Links in the header of the screen
- User preferences

**Windchill PDMLink Objects, Products, and Libraries**

The following types of objects can created, managed, and stored in Windchill PDMLink:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="icon" alt="Document icon" /></td>
<td>Document</td>
<td>A document is a content holder for a Microsoft Word, Excel, PowerPoint, or other type of file. A document can stand alone or can be associated with a part, end item, or other documents.</td>
</tr>
</tbody>
</table>
CAD Document is a content holder for CAD-derived files that can be related to parts in order to further describe the associated part. It can also be related to other CAD documents, so that dependencies created and maintained by the authoring CAD system are represented.

CAD documents are uploaded into Windchill PDMLink using a
- Gateway (for example, Pro/INTRALINK and Optegra)
- Workgroup Manager for a CAD application (for example, Catia V4, Catia V5, SolidWorks, Unigraphics, and Mentor Graphics)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon CAD Document]</td>
<td>CAD Document</td>
<td>A CAD document is a content holder for CAD-derived files that can be related to parts in order to further describe the associated part. It can also be related to other CAD documents, so that dependencies created and maintained by the authoring CAD system are represented. CAD documents are uploaded into Windchill PDMLink using a - Gateway (for example, Pro/INTRALINK and Optegra) - Workgroup Manager for a CAD application (for example, Catia V4, Catia V5, SolidWorks, Unigraphics, and Mentor Graphics)</td>
</tr>
<tr>
<td>![Icon Part]</td>
<td>Part</td>
<td>A part is a physical component or assembly used in a product structure.</td>
</tr>
<tr>
<td>![Icon Serialized Numbered Part]</td>
<td>Serialized Numbered Part</td>
<td>A serialized numbered part is a special form of part that has no children and is identified with a unique serial number when it is assembled into an instance of an end item (which is also identified by a serial number).</td>
</tr>
<tr>
<td>![Icon End Item]</td>
<td>End Item</td>
<td>An end item is a special kind of part in the product structure. It represents a unit of product functionality that is sold, assembled, and delivered to a customer.</td>
</tr>
<tr>
<td>![Icon Managed Baseline]</td>
<td>Managed Baseline</td>
<td>A managed baseline is essentially a snapshot of a collection of product data at a specific point in time. Once a baseline is created parts and documents can be added to the baseline. A baseline can contain any number of parts and documents, and a part or document can be in any number of baselines.</td>
</tr>
<tr>
<td>![Icon End Item Instance]</td>
<td>End Item Instance</td>
<td>An end item instance identifies, by serial number, a unique, manufactured instance of an end item, built according to a specific end item configuration.</td>
</tr>
<tr>
<td>![Icon End Item Configuration]</td>
<td>End Item Configuration</td>
<td>An end item configuration identifies the versions of parts used to build the end item as it is provided to customers. It allows you to track the versions of parts that were used to manufacture a specific product line for record-keeping and on-going maintenance of that end item in the field.</td>
</tr>
</tbody>
</table>
These objects can reside in products and libraries, which are accessible from the **Product** and **Library** tabs available at the top of your Windchill PDMLink screen.

<table>
<thead>
<tr>
<th><strong>Icon</strong></th>
<th><strong>Object</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>🗄️</td>
<td>Problem Report</td>
<td>A problem report is created to document a problem or request a product enhancement. A problem report can be created by a registered user of Windchill PDMLink or on behalf of someone outside the system, such as a customer or supplier.</td>
</tr>
<tr>
<td>🗄️</td>
<td>Enterprise Change Request (ECR)</td>
<td>An ECR can be created to investigate solutions to one or more problem reports or without any reference to a problem report. It details and quantifies the impact of the proposed changes necessary to correct a problem or provide the enhancement so that the appropriate people can make the business decision to proceed with or cancel the proposed change. The result of an approved ECR is the creation of one or more ECNs.</td>
</tr>
<tr>
<td>🗄️</td>
<td>Enterprise Change Notice (ECN)</td>
<td>An ECN can be created in reference to one or more ECRs. It details the tasks that need to be completed in order for the change to be implemented and enables the tasks to be assigned to individuals.</td>
</tr>
</tbody>
</table>

Tip: To locate an object within a product or library you can search for it (for more information, see **Searching in Windchill PDMLink**.) You can also click **Folders** below the tab to view the objects that are stored in the folders of the product or library.

A **product** is all the collected information that defines what is built and sold by your company. The product provides the context in which you collaborate to create this information, where only those with defined roles have access to the information. For more information, see **Product Tab** later in this chapter.

A **library** manages standard parts and documents used across products and projects in an organization. The administrator for your site will set up libraries that correspond to your company's organization and processes. For example, all engineering department policies and procedures can be grouped in a library. For more information, see **Library Tab** later in this chapter.
Products and libraries can be created by administrators or users with create permission. In addition to other details, the following is established when a product or library is created:

• The team of people that have access to the product or library
• The life cycles that objects must progress through
• The workflows that objects must accomplish
• The rules determining the people who can access and modify the corresponding objects
• The templates that will be available to create a document from a template

Using the Windchill PDMLink Tabs

When you first open Windchill PDMLink, tabs appear at the top of your page. These tabs provide access to different information and functionality. The following sections describe each tab.

Home Tab

The **Home** tab contains information specific to your interaction with Windchill PDMLink. Here, you can view your assignments, objects that you have checked out, meetings that have been scheduled, and more. The pages available from the **Home** tab are described below.

Overview

The **Overview** page displays the seven most recent objects in each of the following tables:

• **Assignments**
• **Updates**
• **Checked-Out Work**

If a table contains more than seven items, a **View All** link appears in the bottom-left corner of the table, allowing you to view all items. You can also click the link for a table to view only that table and all of the objects contained in it. Links to each table are available below the **Home** tab.

Assignments

The **Assignments** table, or task list, contains the tasks that are assigned to you as part of a workflow process. A **workflow** is a series of pre-defined tasks that
correspond to a business process in your organization. Depending on your role in these business processes, the workflow engine could deliver tasks that ask you to review, author, or approve product data.

For more information about a task that is assigned to you, click the link in the Name column of the table, or click the Actions list, and select Details.
The details page displays the information you need to complete the assignment. The example below displays details for the Analyze ECR assignment.

![Analyse ECR Details](image)

After you complete a task, click the **Task Complete** button on this page. The task is then removed from your **Assignments** table, and the workflow process moves forward.

If an object (such as a part or document) is associated with the assignment, a link to the information about the object appears in the **Subject** column of the table. From this page, you can view all available information for and perform actions on the object.

If you need to reassign the task or update the deadline, those options are available from the **Actions** column of the table.
Updates

The **Updates** table lists objects that you have recently modified. For example, you may check out a document in order to edit the text, and then check in the document with your corrections. If, the next day, the document needs additional editing, you can retrieve it from your **Updates** table rather than have to search for the document or locate it within the folders of the product or library.

Checked-Out Work

The **Checked-Out Work** table lists any objects that you currently have checked out.

You must check out a part or document in order to modify it. At the time of checkout, a working copy duplicates the original object file and becomes the copy that you modify. This copy of the object appears in your **Checked-Out Work** table. Check out locks the original object to prevent change by others.

Once you are finished modifying an object, you can check in the object from this table by clicking **Check In** from the **Actions** list. Your working copy, with all of its attributes and associations, supersedes the present iteration of the object, and the object is removed from your **Checked-Out Work** table.

Workspaces

The **Workspaces** page displays a listing of workspaces, if any, that have been created from all products and libraries to which you have access. A workspace provides a useful framework that allows you to work with many CAD documents and parts at the same time.

Selecting **Workspaces** under the **Product** or **Library** tab displays a listing of only the workspaces associated with the context.

Once on the **Workspaces** page, you can create a new workspace, delete an existing workspace, or, by clicking the link in the workspace **Name** column, go to an existing workspace.

For more information on workspaces, see [Working with CAD Data](#).

Meetings

The **Meetings** page provides access to the meetings in which you are involved that have been scheduled in Windchill PDMLink. From here, you can create and cancel meetings. Once you have created a meeting, you, as the meeting creator, can choose to host the meeting, update the meeting, or add minutes to the meeting.

You can create a standard meeting, a Web-based meeting, or a ProductView collaborative peer-to-peer session.

- A standard meeting includes an agenda, meeting participants, and the meeting details, such as date, time, and telephone information.
• A Web-based meeting includes all the features of a standard meeting but is conducted through WebEx in order to share meeting presentations or other materials in real time.

• A ProductView meeting includes all the features of a standard meeting but with the ability to share two or more sessions of ProductView with meeting participants.

  **Note:** ProductView must be installed in order to conduct a collaborative session.

For more information, see Meetings in the Communication Tools chapter.

**Notebook**

The Notebook is a collection of links to objects and URLs with which you often work. Notebooks display these links you have created and allow you to organize them in folders and subfolders. Your Notebook is similar to Internet Explorer’s Favorites or Netscape’s Bookmarks. Because the links are saved in the Windchill PDMLink database, the links in your Notebook can be accessed from anywhere and from any machine. You can also upload documents to your Notebook.

**Subscriptions**

A subscription is a request to be notified of certain events concerning documents, parts, or change objects in which you are interested. For example, if you want to know when Document A is updated, you subscribe to the document and select the Update event. Then, any time the document is updated, an e-mail notification is sent to you.

From the Subscription page on the Home tab, you can view all of your subscriptions and unsubscribe from objects.

To subscribe to a part, document, or change object, navigate to the information page by clicking or selecting Details from an Actions list. Click the Subscription link on the left side of the page. The Subscription page appears.

**Tip:** Subscriptions are not available for all object types. If notifications cannot be sent for an object type, the Subscription link will not appear on the information page.

For more information, see Subscriptions in the Communications Tools chapter.

**Reports**

The Reports page displays a report table that allows you to run the reports across products and libraries in which you are a team member.

**Note:** Only the objects or information items that you created are displayed on the page.
Select the type of report you would like to run from the **Current View** drop-down list. For example, you may want to see a list of your **Overdue Items** or your **Open Work**, relating to your **Assignments**.

**Utilities**

The **Utilities** page provides access to items used to change or enhance your interaction with Windchill PDMLink. For example, links to **Setting User Preferences**, security settings, and software downloads appear on this page. See also the information in the **Before You Begin** section about options that appear on the **Utilities** page.

**Site and Organization**

These tabs appear for administrators. For more information, see the Windchill Administrator’s Guides.

**Product Tab**

A *product* can be thought of as all the collected information that defines what is built and sold by your company. The product provides the context in which you collaborate to create this information, where only those with defined roles have access to the information.

For more information, see the **Managing Products and Product Structures** chapter in this manual.

When you click on the **Product** tab, the last page you viewed for a specific product appears. For example, if the last time you viewed information under the **Product** tab, you viewed the **Folders** page of Product A, that page appears the next time that you click the **Product** tab. To view information for a different product, click the **Products List** link below the **Product** tab and select a product from the list. You can also select a product from the **Recent Products** drop-down list on the top of the page.

Once a product has been selected, you can do the following:

- Search for objects in the product using the **Search within this product** field, which is located at the top of any page under the **Product** tab.

- From the **Details** page, view the attributes for the product and the end items that exist in the product. You can also complete actions from the **Actions** list.

- From the **Folders** page, view the objects that reside in the product and complete actions on those objects. Use the **Current View** drop-down list in the table to choose the objects listed in the table. For example, you can view documents only or parts only.

- From the **Product Structure** page, examine the hierarchical tree view of the product’s assemblies and parts, and filter product structures by a configuration specification.
• From the **Team** page, identify the members of the product team who have access to the information displayed in this product.

• From the **Change Monitor** page, gauge the progress of your company’s change process for this product and monitor the status of the change objects (problem reports, ECRs, and ECNs) within the product.

• From the **Forum** page, view and discuss topics that relate to the product. Team members can reply to existing postings or start new discussions.

• From the **Workspaces** page, view or create workspaces associated with the product.

• If you have access, a **Templates** and **Utilities** page also appear. For more information on these pages, see the *Windchill Business Administrator’s Guide*.

**Change Tab**

The **Change** tab allows you to view all of the change information for products and libraries of which you are a team member. From the **Problem Reports**, **Change Requests**, and **Change Notices** pages that appear under this tab, you can choose to view in the information pages of change objects. You can also use the Change Monitor to track the changes occurring in the system or at the product or library level.

**Library Tab**

A library can be thought of as a place for storing and providing access to business information such as documents and other objects that are not related to a single product.

When you click on the **Library** tab, the last page you viewed for a specific library appears. For example, if the last time you viewed information under the **Library** tab, you viewed the **Details** page of Library A, that page appears the next time that you click the **Library** tab. To view information for a different library, click the **Libraries List** link below the **Library** tab and select a library. You can also select a library from the **Recent Libraries** drop-down list on the top of the page.

Once a library has been selected, you can do the following:

• Search for objects in the library using the **Search within this library** field located at the top of any page under the **Library** tab.

• From the **Details** page, view the attributes that exist for the library. You can also complete actions from the **Actions** list.

• From the **Folders** page, view the objects that reside in the library and complete actions on those objects. Use the **Current View** drop-down list in the table to choose the objects listed in the table. For example, you can view documents only or parts only.
• From the **Team** page, view the members of the library who have access to the information displayed in this library.

• From the **Change Monitor** page, gauge and monitor the status of the change objects (problem reports, ECRs, and ECNs) within the library.

• From the **Forum** page, view and discuss topics that relate to the library. Team members can reply to existing posting or start new discussions.

• From the **Workspaces** page, view or create workspaces associated with the library.

• If you have access, a **Templates** and **Utilities** page also appear. For more information on these pages, see the *Windchill Business Administrator’s Guide*.

### Using the Header Links

The following links as well as a **Copy Page** button and a search field appear in the Windchill header:

<table>
<thead>
<tr>
<th>Link</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visualization Collection</td>
<td>Displays the Visualization Collection. The collection provides the ability to combine different data sets into one viewable representation for the current browser session. This portal allows you to view and print visual representations of parts and documents in ProductView. <strong>Tip:</strong> The first time you add an object to the collection, this link appears.</td>
</tr>
<tr>
<td>Learn</td>
<td>Displays Windchill tutorials, which walk through procedures for completing Windchill operations.</td>
</tr>
<tr>
<td>Help</td>
<td>Displays online help for the tab you are viewing. <strong>Tip:</strong> To view online help for a particular table, click in the upper-right corner of the table.</td>
</tr>
<tr>
<td>Publications</td>
<td>Displays the <strong>Publications</strong> page, which provides links to all Windchill manuals.</td>
</tr>
<tr>
<td>E-mail Page</td>
<td>Launches a new window that allows you to e-mail the current URL to another user.</td>
</tr>
</tbody>
</table>
Search

The Search field allows you to locate parts, documents, and other objects that have been created in Windchill PDMLink. Enter keywords in the field, and click Go. If RetrievalWare is installed on your system, this field searches the content (such as the text of the Microsoft Word document and fields such as name or number) of the objects. If you do not have RetrievalWare installed on your system, by default this field searches only the name and number fields.

To view the Advanced Search page, where you can specify search criteria for specific objects, locations, and fields, click the Search link to the left of the field.

For more information see Searching in Windchill PDMLink.

Copy Page

The Copy Page button copies the URL of the current page to the Windchill clipboard. The URL you have copied can be pasted into any table that accepts links or into a text field that has a Paste action associated to it.

Setting User Preferences

To access the User Preferences page, click Preferences on the Utilities page of the Home tab.

Windchill PDMLink has six categories of user preferences, so you can define certain aspects of your functionality.

- Display
- Content
- Search
- Tables
- Visualization
- Configuration Specification

Your preferences may differ, depending on the settings at your site.
Tip: Always click the OK or Apply button to submit preference information instead of pressing ENTER on your keyboard.

Display Preferences

To customize how certain items of your screen display, click the Display tab. A more detailed description of each preference is available when you click on the preference link.

Content Preferences

To customize your document upload and download processes, click the Content tab. A more detailed description of each preference is available when you click on
the preference link. For more information to help you choose among the
download options, see [Options for Downloading Documents](#).
Search Preferences

To customize your search process, click the Search tab. A more detailed description of each preference is available when you click on the preference link.

For information on search modes, see Using Search Modes in the Search chapter.

Tip: You must enable the thumbnail option under the Visualization preference tab before choosing to display thumbnails on your Thumbnail Display in Search Results preference under the Search tab.
Tables Preferences

To customize how information displays in the tables in Windchill PDMLink, click the **Tables** tab. A more detailed description of each preference is available when you click on the preference link.

![Edit User Preferences](image_url)
Setting Visualization Preferences

To customize your visualization options, click the **Visualization** tab. A detailed description of each preference is available when you click on the preference link.

If you choose to display thumbnails, small images of the objects can be viewed from the search results and details pages.

 Thumbnails give you a visual image to associate with the details information of a part. You can also launch ProductView by clicking the thumbnail icon. However, displaying thumbnails will increase the time needed for pages to load.
Setting a Configuration Specification View

To set your configuration specification view, click the **Configuration Specification** tab. When you look at the structure of a product, you may want to see it in different configurations, depending on your intent. For example, you may always want to see the structure from a manufacturing point of view rather than an engineering point of view. (An engineering view may show all the component parts separately; a manufacturing view may show some parts combined into assemblies.) Although you can change this view when you access a product structure, with this preference, you can set your default view.

Using Special Characters in Windchill PDMLink

The following characters have special meaning in HTML and should be avoided when entering information in the fields on pages in Windchill PDMLink:

- `<`
- `>`
- ```
- `'`
- `&`
- `&`

The following actions are not recognized by HTML and should be avoided when entering information in the fields in Windchill PDMLink:

- Adding more than one space between letters.
- Pressing ENTER.
The following should not be used in UNIX file names:

- \n
- The extension ".LNK" or ".lnk."
This chapter discusses searching for objects within Windchill PDMLink.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About Search</td>
<td>2-2</td>
</tr>
<tr>
<td>About Keyword Searches</td>
<td>2-2</td>
</tr>
<tr>
<td>About the Advanced Search Page</td>
<td>2-3</td>
</tr>
<tr>
<td>About Search Results</td>
<td>2-8</td>
</tr>
<tr>
<td>About Wildcards</td>
<td>2-9</td>
</tr>
</tbody>
</table>
About Search

Searching in Windchill PDMLink allows you to find objects (such as documents and parts) in your local database by searching the attributes, and possibly the content, of the objects.

Note: This manual and the online help for searching describe the out-of-the-box object types and search fields that are predefined by Windchill PDMLink. Both may be augmented by customizers at your site. For example, your site may have created additional object types and attributes which can be searched.

You encounter search throughout Windchill PDMLink, as you perform various actions. For example, when creating a document you can search for the folder in which the document should be located. You can use keywords to search the entire database or search a particular context from within a particular tab. You can also search from the **Advanced Search** page using multiple criteria to significantly narrow or broaden your search, as needed.

About Keyword Searches

Using a keyword search, you can search for one or more words across multiple attributes, usually the object name and number, at one time. The default is to search the name and number attributes; however, your System Administrator may have selected other fields. Using wildcards broadens the search results returned.

For example, if you do a keyword search for "eng*", then any object whose name or number contains that keyword would be returned. Object names such as "Engine" and "NewEng", and object numbers such as "eng45" would be returned in the search results.

If RetrievalWare is installed on your system, then your search results will return any objects that contain the keyword in either the object attributes or the object content as well. For example, the same keyword search for "eng*" on a system with RetrievalWare would also return documents containing the word "engine" or "engineer" in their text.

**Tip:** Since there is no visible way to see if RetrievalWare is installed on your system, contact your System Administrator to determine if RetrievalWare has been installed at your site.

You can perform keyword searches from a number of locations within Windchill PDMLink.

The **Search** field appears in the upper-right corner of the header of your screens. This field allows you to search for all objects to which you have access.
The **Search within** field limits your search to objects that reside within a particular context. For example, from the **Home** tab, the **Search within my work** field limits your search to only the objects that you created or modified.

You can also limit your search to a specific product or library by using the **Search within** field available under each tab.

You can also perform keyword searches from the **Keyword** field on the **Advanced Search** page.

### About the Advanced Search Page

The **Advanced Search** page allows you to use multiple search criteria to define your search.

**Tip:** When you are searching for data in Windchill, you will find that it is possible to execute a search without specifying any search criteria or by choosing only an object type (for example, Part) on which to search. Because your site is likely to have a great deal of data stored in Windchill, quick and effective searching requires that you specify as many criteria as possible to refine your search.

Click the **Search** link or **Search within** link to open the **Advanced Search** page.

### Specifying Search Criteria

The **Advanced Search** page displays fields for specifying search criteria. These fields correspond to object attributes. Depending on the object type or types you are searching for, different fields are displayed because each object type has different object attributes.

For example, if you select **Part** in the **Search For** field, the **View** field is among the fields displayed, as view is an attribute of a part. If you select **Document** in the **Search For** field, however, the **View** field is not displayed. Both parts and documents have **State** and **Version** fields in common.
Entering search criteria in these fields makes your search more specific. Leaving a field blank returns all available results for that field. If a **Show More Attributes** link appears below the search criteria fields, your site has added additional properties for your search. Click the link to search on those properties.

**Tip:** The more fields in which you specify criteria, the narrower your search will be, and the number of objects returned in your search results is reduced. If you are not seeing the search results you expect, try broadening your search by leaving more fields blank.

If you enter criteria in a field that does not correspond to a specific object, objects of that type are not returned in the search results. For example, if you are searching for all object types, but enter information in the **Name** field, certain objects, like end item configurations, that do not have a name attribute will not appear in your search results.

**Special Characters in Search**

If RetrievalWare is installed on your system, using the following characters in the **Keyword** field can give unexpected results:

- Wildcard characters: @, #, _, *, \, ?, [], ^
- Separators: ( )
- Characters used in dates: ., -, /

If your site uses these characters in object names or numbers, and you want to search for the exact object name or number, use the **Name** or **Number** field rather than the **Keyword** field for your search.

For example, if you are searching for an object named cad_document.prt in the **Keyword** field, RetrievalWare treats that name as three separate strings: "cad", "document", and "prt". The search results will not return the object you are searching for. To successfully find the object, search from the **Name** field, or use a partial name and wildcards in the **Keyword** field. For example, in the **Keyword** field, searching for "cad*", "*document*", or "*prt" would return results which include cad_document.prt.

Alternatively, you can also use the \ character as a wildcard in the **Keyword** field to indicate that the next character should be taken literally. For example, to search for a part named Bracket() in the **Keyword** field, enter "Bracket\()\". The \ character tells RetrievalWare to search for the parentheses as literal characters, rather than as characters with special meaning.

For additional information on specifying search criteria for certain fields, see the online help available from the **Advanced Search** page.
Setting Search Preferences

You can customize your search process by setting your search related user preferences. Your available preferences may differ, depending on the settings at your site.

To open the Edit User Preferences window, click the Preferences link on the Advanced Search page, or the Preferences link on the Home tab Utilities page. Click the Search tab.

Through your search preferences you can set the number of search results that appear on a page of the Search Results table, and whether or not thumbnail images are displayed. You can choose whether or not to have the last search you perform always appear in the Saved Searches drop-down list. Depending on your site configuration, you can also choose which available libraries are searched when you perform a keyword search. A detailed description of each preference is available when you click on the link for that preference.

Saving a Search

If your search preference is set to do so, the last search you perform is always saved in the Saved Searches drop-down list. Also, searches performed on the Advanced Search page can be saved for later reuse. This is useful if you perform specific searches multiple times.

Click Save after you perform the search to name and save the query. You can now select your named search from the Saved Searches drop-down list and click Go
to automatically populate the fields on the **Advanced Search** page with the search criteria you saved and perform the search.

**Tip:** If you save a search which includes criteria specified in fields accessed by clicking the **Show More Attributes** link, when you perform the search again, those additional search criteria will be searched upon, though they will not be automatically displayed with the search results. Simply click the **Show More Attributes** link to view the additional search criteria.

To remove a saved search from the **Saved Searches** drop-down list, select the search, and click **Delete**.

**Using Search Modes**

Search modes determine the way in which search interprets the keywords you enter in the **Search**, **Search within**, and **Keyword** fields. You select a search mode through user preferences. The available search modes are described below.

Search modes apply only when RetrievalWare is installed. Contact your System Administrator to determine if RetrievalWare is installed at your site.

**Concept Mode**

Concept mode is useful when you are not sure of exact terminology, because it allows you to search for both words you specify and words with similar meanings. For example, if you search for "part", the word might expand to query related terms such as "parts", "component", or "segment".

In concept mode, you can also specify an expansion to indicate the type of related concepts you want to retrieve. The simple variations expansion type, which is the default, retrieves variations in case, gender, number, tense, person, mood, and voice.

**Boolean Mode**

Use boolean mode to search for specific words and phrases, using standard boolean operators. If you select boolean mode and do not specify any operators, an AND operator is assumed.

For example, if you searched for "gear shaft not rotor" the search results would return those objects which include the words "gear" and "shaft", but not those objects which contain the word "rotor".
The following table explains the boolean operators used with the boolean search mode.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>( )</td>
<td>(word1</td>
<td>word2) &amp; word 3</td>
</tr>
<tr>
<td>not ^</td>
<td>not word1 ^ word1</td>
<td>Word1 must not be found. Note: Searching for &quot;not word1&quot; or &quot;^ word1&quot; excludes objects from the search results that contain word1 in their attributes, but does not exclude objects which contain word1 in their content.</td>
</tr>
<tr>
<td>and &amp; but</td>
<td>word1 and word2 word1 &amp; word2 word1 but word2 word1 word2 word1 but not word2</td>
<td>Both word1 and word2 must be found. (This is the default operator.) Word1 must be found; word2 must not be found.</td>
</tr>
<tr>
<td>within wi</td>
<td>word1 word2 within N word1 word2 wi N</td>
<td>Word1 must be found within N words of word2.</td>
</tr>
<tr>
<td>adj</td>
<td>word1 word2 adj N</td>
<td>Word1 must be found within N words of word2, and word1 must precede word2.</td>
</tr>
<tr>
<td>between</td>
<td>word1 between word2 and word3</td>
<td>Word1 must be found between word2 and word3.</td>
</tr>
<tr>
<td>or</td>
<td>(pipe) word1</td>
<td>Either word1 or word2 must be found.</td>
</tr>
</tbody>
</table>

**Pattern Mode**

Pattern mode is useful when you are not sure of the exact spelling of a word because it allows you to search for both words that you specify and words with similar spellings. For example, searching in pattern mode for the keyword "colour" can return results which include "color", "coloured", and "colorized."
Pattern mode also makes it easier to search OCR (scanned) documents, since spelling errors that sometimes result from document scanning are tolerated by the search.

About Search Results

When you perform a search from the Search field, the Search within field, or the Advanced Search page, the objects matching your search criteria are displayed in the Search Results table on the Advanced Search page. The number of objects displayed per page of the Search Results table is determined by your search preferences. Also, your search preferences determine whether thumbnail images are displayed in the table. Only those objects to which you have at least read access are included.

For example, if you performed a search for "a*" in the Name field, with your preference set to not display thumbnails, the search results returned would be similar to the following:

You can perform a number of actions from the Search Results table, including sorting the results, viewing the object details, and refining your search. Using Copy to Clipboard you can copy selected objects from your search results to paste in other locations.

Tip: If you manually sort the search results (using the Sort Ascending and Sort Descending arrows at the top of each sortable column), you need to perform your sort each time you search. If you have a particular sorting order you prefer, set that order through your user preferences.

Clicking on the hyperlinked object name or in the Actions column displays the object information page. From the information page you can view the object and perform a number of object related actions. For objects that have thumbnail images, clicking in the Actions column displays the thumbnail image.
Clicking in the Actions column allows you to view other object visualization information.

If your search preference is set to display thumbnail images in search results, the same search would return results similar to the following:

<table>
<thead>
<tr>
<th>Name</th>
<th>Number</th>
<th>Actions</th>
<th>Thumbnail</th>
<th>Context</th>
<th>Version</th>
<th>State</th>
<th>Modified</th>
</tr>
</thead>
<tbody>
<tr>
<td>AXLE SLEEVE</td>
<td>GC000034</td>
<td></td>
<td></td>
<td>GOLF_CART</td>
<td>A. In Work 10/09/2003</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ALTERNATOR</td>
<td>GC0000071</td>
<td></td>
<td></td>
<td>GOLF_CART</td>
<td>A. In Work 10/09/2003</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AXLE LATCH</td>
<td>GC000007</td>
<td></td>
<td></td>
<td>GOLF_CART</td>
<td>A. In Work 10/09/2003</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AXLE FASTENER</td>
<td>GC000038</td>
<td></td>
<td></td>
<td>GOLF_CART</td>
<td>A. In Work 10/09/2003</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ACTUATOR LOCK</td>
<td>GC000016</td>
<td></td>
<td></td>
<td>GOLF_CART</td>
<td>A. In Work 10/09/2003</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Existing thumbnail images are displayed in the Thumbnail column. If an object is capable of having a thumbnail, but no thumbnail has yet been created, then an icon is displayed which allows you to view the object’s visualization information. For example, in the above search results, the part named ALTERNATOR does not have an existing thumbnail image. Clicking displays the default configuration specification for the object type in ProductView. For additional information on visualization and ProductView, see Visualizing Data in Windchill.

If you do not see the results you expected, and you would like to modify the search criteria, click Refine Search above or below the Search Results table. This returns you to the top of the search page where you can review and modify the search criteria you entered.

For additional information, see the help available from the Search Results table.

**About Wildcards**

Wildcards allow you to modify your search. Without wildcards, search results are limited to the objects that exactly match the word or words you enter in the search.
field. The most common wildcard, an asterisk (*), indicates that one or more characters can appear in a position and can be used in any search field.

For example, to retrieve a document with the word "design" in the name, you would enter "*design*" in the search field. The asterisks indicate that the word could be preceded or followed by one or more characters.

Results like the following would be returned:

- Joe's design prototype
- A Design For Development
- Designing Engine Parts

The percent symbol (%) and underscore (_) can be used in object attribute fields (such as Name and Number) and in all search fields when RetrievalWare is not installed. The percent symbol works in the same way as the asterisk does, indicating that one or more characters can appear in a position. The underscore indicates that only one character can appear in that position.

For example, to retrieve a document with the word "design" followed by one character only, enter design_ in the search field.

Results like the following would be returned:

- designs
- DesignB

When RetrievalWare is installed, different wildcards apply in the following fields:

- The Search field at the top of your screen.
- Any Search within field.
- The Keyword field on the Advanced Search page.

Contact your System Administrator to determine if RetrievalWare is installed at your site. If RetrievalWare is installed, use the following wildcards in the previously mentioned fields:

<table>
<thead>
<tr>
<th>Wildcard</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>@</td>
<td>Match exactly one alphabetic character.</td>
<td>c@are</td>
</tr>
<tr>
<td>#</td>
<td>Match exactly one numeric character.</td>
<td>#600</td>
</tr>
<tr>
<td>Wildcard</td>
<td>Description</td>
<td>Example</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
<td>---------</td>
</tr>
<tr>
<td>\</td>
<td>Indicates that the next character should be taken literally (the next character is not an operator).</td>
<td><a href="mailto:service@mycompany.com">service@mycompany.com</a></td>
</tr>
<tr>
<td>*</td>
<td>Match any character(s).</td>
<td>spec*</td>
</tr>
<tr>
<td>?</td>
<td>Match exactly one character.</td>
<td>g?dget</td>
</tr>
<tr>
<td>[]</td>
<td>Match only one character within the brackets. You can include a hyphen to indicate a range of numbers or letters.</td>
<td>199[1-6]</td>
</tr>
<tr>
<td>[]</td>
<td>Match any character except the character specified. You can include a hyphen to indicate a range of numbers or letters.</td>
<td>199[^1-3]</td>
</tr>
</tbody>
</table>
This chapter describes the functionality within Windchill PDMLink that enables team members to effectively collaborate.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Tools</td>
<td>3-2</td>
</tr>
<tr>
<td>Meetings</td>
<td>3-2</td>
</tr>
<tr>
<td>Subscriptions</td>
<td>3-4</td>
</tr>
<tr>
<td>Discussion Forums</td>
<td>3-5</td>
</tr>
</tbody>
</table>
Communication Tools

Many companies face the challenge of working effectively together when working across multiple sites and with other companies. People usually work in several different ways to develop product concepts, update ideas for the team, and communicate these ideas; however, often issues arise when an update is made, but not clearly communicated. Windchill PDMLink provides functionality that overcomes these challenges. For example, you can use Windchill PDMLink in the following ways to communicate clearly with your team:

• Create new iterations of a document and send an e-mail to the team
• Discuss design ideas using a discussion forum
• Keep track of the work you need from other team members by subscribing to changes
• Comment on designs using the markup capabilities in ProductView
• Route the latest version of a document to the team for review
• Set up an online meeting to review proposed design changes using the ProductView or WebEx meeting capabilities

This section describes the following functionality which allow you to collaborate with your team effectively:

• Meetings
• Subscriptions
• Discussion Forums

Meetings

Meetings are a common experience in the successful project process. Although some meetings may be conducted by a group of people in a single room, because of multiple site challenges, many meetings are conducted over the telephone. Also, online meetings are conducted to enable people from multiple sites to join a meeting and view the same meeting material. Windchill PDMLink provides capabilities for all types of meetings.

You can create one of the following types of meetings in Windchill PDMLink:

• Standard -- A meeting that includes an agenda, meeting participants, and the meeting details, such as date, time, and telephone information. This type of meeting supports those held in a single geographic location and those conducted in multiple sites over the telephone.

• Web-based -- A meeting that includes all the features of a standard meeting but is conducted through WebEx in order to share meeting presentations or other materials in real time. This meeting accommodates team members in multiple sites who all need to view the same materials at the same time.
Note: WebEx is not supported in the Korean language.

• ProductView -- A meeting that includes all features of a standard meeting but with the ability to share two or more sessions of ProductView with meeting participants. This meeting enables team members in multiple sites to conduct a meeting during which they need to view and mark up a CAD image over real time. ProductView peer-to-peer meetings allow different team members to take turns controlling the image, enabling real time collaboration.

Note: To host or join a ProductView meeting, you must have ProductView installed on your system.

To see all meetings to which you are invited, go to the Meetings page on the Home tab.

To view the information page of a meeting, click on the meeting name. The information page displays the meeting details as well as any meeting minutes.

The following table lists and describes the actions available for meetings:

<table>
<thead>
<tr>
<th>Action</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
</table>
| Create Meeting   | ![Button] | Creates a new meeting instance. If it is a standard meeting, the instance contains the information necessary to attend the meeting, such as site location and telephone number. If it is a WebEx or ProductView meeting, the instance also contains the necessary links to access the meeting.  

Note: If you want to be listed as a meeting participant, you must add yourself to the list of participants. If you do not add yourself as a meeting participant, the meeting does not appear in the list of meetings on the Meetings page of the Home tab. |
<table>
<thead>
<tr>
<th>Action</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update</td>
<td></td>
<td>Updates the details of an existing meeting. Only the meeting creator can update a meeting. Select Update from the actions list next to the meeting name.</td>
</tr>
<tr>
<td>Join</td>
<td></td>
<td>Opens the meeting session in either WebEx or ProductView. Select Join from the actions list next to the meeting name. You can only join a meeting to which you were invited.</td>
</tr>
<tr>
<td>Host</td>
<td></td>
<td>Opens the meeting session in either WebEx or ProductView and establishes you as the meeting controller. Select Host from the actions list next to the meeting name. You can only host a meeting if you are the meeting creator or if the meeting creator designated you as the host. There can only be one host per meeting.</td>
</tr>
<tr>
<td>Add Meeting Minutes</td>
<td></td>
<td>Creates meeting minutes associated with the meeting. Select Add Meeting Minutes from the actions list next to the meeting name. You can only add meeting minutes if you are the meeting creator.</td>
</tr>
<tr>
<td>Reference</td>
<td></td>
<td>Opens the meeting information page to display the References table where you can associate parts, documents, and links to the meeting. See Getting Started with Windchill PDMLink for more details on notebooks and reference lists.</td>
</tr>
<tr>
<td>Cancel</td>
<td>X</td>
<td>Deletes the scheduled meeting. You can only cancel a meeting if you are the meeting creator.</td>
</tr>
</tbody>
</table>

**Subscriptions**

Subscriptions allow you to be notified of changes to objects within the system without constantly monitoring individual pieces of information stored in the system. You can also subscribe to a discussion forum, topic, or posting as described later in this chapter. You can subscribe to one or more specified events.
for a particular object, which will result in e-mail notifications concerning a change in that particular event for that object.

All of your subscriptions are displayed on the **Subscriptions** page of the **Home** tab.

To subscribe to an object, click **Subscriptions** on the navigation bar on the left side of the information page of the object. Click **Subscribe** on the **Subscriptions** table that appears. If no **Subscriptions** link is available, the object type does not support subscriptions. When you want to stop receiving e-mail notifications concerning a specific subscription, simply select the subscription and click **Delete**. Or click **Unsubscribe** on the **Subscriptions** table located on the object’s information page. For more details about creating and viewing subscriptions, see the online help available from the **Subscriptions** page.

**Tip:** You cannot update subscriptions. To modify your existing subscriptions, you must delete the unwanted ones and create new ones.

**Discussion Forums**

The ongoing exchange of ideas between project participants is an expected part of the successful project process. These exchanges sometimes occur over e-mail, in casual hallway conversations, or in impromptu meetings. Unfortunately, this often means that some team members are not involved in the exchange or the decision is not recorded and therefore lost. Discussion forums are particularly useful to asynchronously engage in conversations by posting questions and answers among geographically distributed members that cannot meet in person or even via the telephone because of large time zone differences. Windchill PDMLink provides discussion forums which enable all team members to participate in discussions about a certain facet of the product or library, such as a design idea, and which also capture the discussion for future reference.

A discussion forum consists of topics, postings, and replies. The functionality is very similar to that of message or chat boards often encountered in the World Wide Web. These discussions are located on the **Forum** page of the **Product** tab and **Library** tab.

A topic is represented by a folder icon. The topic determines the focus of the discussion. For example, if the topic is titled Design Ideas, then all of the postings beneath it should relate to design ideas. Within topics, you can either create postings or reply to existing postings. A posting is a message from a team member concerning the topic. After one posting is created, another team member can reply with comments specific to that posting, create a new posting dealing with design ideas, or create a new topic for the team to discuss. Anyone can subscribe to individual topics and postings or to the entire discussion forum.
A discussion forum can be displayed in one of the following views available in the **Current View** drop-down list:

- Tree view - The default view of all discussion forums. Displays the topics as folders with postings and replies underneath the topic. Allows individual subscribing to topics and postings as well as to the entire discussion forum.

- Table view - Displays all of the postings in a listing regardless of their relationship to other postings or topics. The name of the topic to which a posting may belong is identified in the **Topic Name** column. In table view, you can only subscribe to the entire discussion forum, rather than to individual topics or postings. You cannot reply to a posting. You can only create additional postings. When a topic is created, it does not appear in the discussion forum table. However, all created topics are available from a drop-down list on the **Create Posting** window.

**Object-Specific Forums**

Forums can also be associated with a particular object, such as a document or part. Those forums relate specifically to the part or document and are started by selecting the **Discuss** action located in the actions list next to the object.

**Forum Actions**

The following table lists and describes the actions you can perform on the **Forum** page:

<table>
<thead>
<tr>
<th>Action</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Topic</td>
<td><img src="image" alt="create_topic_icon" /></td>
<td>Creates a new topic, or folder, in the discussion forum. All postings concerning this issue are collected under or related to this topic.</td>
</tr>
<tr>
<td>Create Posting</td>
<td><img src="image" alt="create_posting_icon" /></td>
<td>Creates a posting related to an existing topic.</td>
</tr>
<tr>
<td>Reply to Posting</td>
<td><img src="image" alt="reply_icon" /></td>
<td>Creates a new posting in response to an existing posting.</td>
</tr>
<tr>
<td>Action</td>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>--------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Subscribe</td>
<td>![Subscribe icon]</td>
<td>Creates a subscription to the forum, topic, or posting so that an e-mail notification will be sent to you whenever a new posting is created. You can subscribe to the entire forum which means that you will receive e-mail notifications concerning changes to any of the topics and creation of any new topics. You can also subscribe to just a single topic to be notified of any new postings, or a single posting to be notified of any new replies.</td>
</tr>
</tbody>
</table>
### Managing Documents

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Understanding Document Management</td>
<td>4-2</td>
</tr>
<tr>
<td>Creating Documents</td>
<td>4-4</td>
</tr>
<tr>
<td>Viewing Documents</td>
<td>4-7</td>
</tr>
<tr>
<td>Associating Files and Documents</td>
<td>4-7</td>
</tr>
<tr>
<td>Modifying Documents</td>
<td>4-8</td>
</tr>
<tr>
<td>Managing Documents with Windchill Desktop Integration</td>
<td>4-10</td>
</tr>
<tr>
<td>Options for Downloading Documents</td>
<td>4-14</td>
</tr>
</tbody>
</table>
Understanding Document Management

The document management functions allow you to create, view, modify, and manage documents.

You can access these functions within Windchill PDMLink, or if you install Windchill Desktop Integration, you can access these functions within Microsoft Word, Excel, or PowerPoint. For more information, see Managing Documents with Windchill Desktop Integration.

Within Windchill PDMLink, documents reside in the folders of a specific product or library. You can perform document actions from the Folders page in the product or library or from the tables under the Home tab. A list of actions is available from the Actions column, or icons may be available in the toolbar of the table.

For example, if you select the Actions list from the Updates table on the Home tab, the following window appears. Note that Documents is selected in the Current View drop-down list of the Updates table.
**Note:** This example displays all actions available if you have both Windchill PDMLink and Windchill ProjectLink installed.

To view the attributes of a document and perform actions on the document, select **Details** and the document details appear.

The online help available on the details pages gives complete descriptions of the attributes, links, and tables shown as well as the actions that can be performed. Additionally, your site may have created custom attributes that appear with the details. For example, your site may want an attribute such as **Proprietary** to indicate whether or not the document can be released outside of the company, or **Required Security Level** to indicate whether or not the document is classified.

The following sections describe how and where, as well as the different ways, you can create and modify a document in Windchill PDMLink.

**Tip:** Information on working with CAD documents is describe in [Working with CAD Data](#).
Creating Documents

To create a document in a Windchill PDMLink product or library, you have the following options:

<table>
<thead>
<tr>
<th>Action</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Document</td>
<td>![Icon]</td>
<td>Uploads a file that you have created (for example, in Microsoft Word) into the Windchill PDMLink database. You also have the option to attach additional related files to the single Windchill document. For more information on attachments, see Associating Files and Documents.</td>
</tr>
<tr>
<td>Create Multiple Documents</td>
<td>![Icon]</td>
<td>Uploads one or more files that you have created into the product or library. Each file is created as a separate Windchill document. For example, if you have four files to upload into the database, use this action to create four documents at once, rather than completing the Create Document action four times.  <strong>Tip:</strong> When you use the Create Multiple Documents action, the documents need to be of the same type and reside in the same folder location.</td>
</tr>
<tr>
<td>Create Document from Template</td>
<td>![Icon]</td>
<td>Provides the ability to create documents from available templates. Depending on the templates that your administrator creates, you could choose from templates for several types of commonly used company documents. For example, meeting minutes, design specifications, or product requirement documents may have a template, so your Windchill document does not start with a blank file.  <strong>Note:</strong> If no templates are available for the context, this option will not appear.</td>
</tr>
</tbody>
</table>

You can complete these create actions in the following locations:

- **Folders** under the product or library.
- **Details** under the **Product** or **Library** tab.
- **Project List** or **Library List** under the respective tab.

The following example illustrates creating multiple documents:
1. From the **Folders** page of the product or library, click **Create Multiple Documents**:

![Image](image1.png)

2. The **Create Multiple Documents** page appears. Select options in the fields at the top of the page.

**Tip:** The **Type** and **Location** fields apply for all documents created on the page.

![Image](image2.png)

3. Use one of the following methods to select the files to be created as documents:
   a. Click **Add Files** to browse for files on your computer.

   **Tip:** Press CTRL to select multiple files.

   Or
b. Drag and drop files from Windows Explorer or your desktop onto the icon.

4. The documents appear in the table. Enter field information for each document, and click Next.

**Tip:** Fields may have character limitations. See the online help available from the page for the maximum number of characters you can enter in each field.

5. If your site has defined additional attributes for a document type, fields and default values for those attributes appear on the Define Details step. You can accept the default or specify a new value. Click OK.

6. The documents are placed in the location you selected. Click the Last Modified column to sort the table by that attribute. The documents you created appear at the top of the table.
Viewing Documents

In many cases, you may only need to view the details about or content of a document. If so, you have the following options:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Details</td>
<td>The information page of the document appears. This page displays all available Windchill PDMLink status information for the document. You can also perform actions on the document (such as check out) from this page.</td>
</tr>
</tbody>
</table>

**Tip:** If you would like to view a specific document each time it is modified, you can subscribe to the document. For more information see Communication Tools In Windchill PDMLink.

| View | View the content of the document (for example, the Microsoft Word or Excel file). Opens the document as it appeared when it was most recently checked into the Windchill PDMLink database. If the document is checked out, you can still view the document; however, keep in mind that the document is in the process of being modified by another user. **Tip:** You can also view the content of a document when you click the file link on the document information page, or click the name of the document in tables throughout Windchill PDMLink. |

**Associating Files and Documents**

A document can be created in the system as a "stand alone" object, or you may want files or documents to be managed with or refer to one another. One way to associate files is to attach additional files to a document. You can also add document references or place documents in a structure.
Attaching Additional Files to a Document

When you create a single document ( ) or when you update a document, you can add attachments to the document. These attached files would be considered secondary content, which is meaningful in the context of the document you are creating but would never need to be maintained on its own. You can view the attachments of a document by clicking the Attachments link on the document information page.

For example, if you create a PDF version of a Microsoft Word file, you may want to attach the PDF file as secondary content with the Microsoft Word file as the primary content of the document. Because, if the Microsoft Word file is updated, the PDF file will need to be modified as well.

Adding Document References

Documents that reference each other are maintained separately and are associated to each other from the Related Documents table on the information page of each of the documents. While a document attachment must be maintained with the document to which it is attached, related documents have separate information pages and can be modified separately. Documents must already be created in the system before you create a reference.

For example, in the Human Resources department, all forms relating to benefits could reference each other. This way, when you locate one document in the system, you simply click the Related Documents link on the information page of the document to view the other forms you need.

Placing Documents in a Structure

Like reference documents, structured documents are maintained and modified separately. You would place documents in a structure by adding child documents in a hierarchical manner under a document you created.

To view and add new documents to the structure, click Document Structure on the document information page. These documents have separate information pages and can be modified separately. Documents must already be created in the system before you add a document structure.

For example, a design specification for a golf cart could include a document structure of each of the design specifications for the assembly parts contained within it.

Modifying Documents

After documents are created in the product or library, they are managed with check-out and check-in functionality. These actions can be completed from the information page of a document (which appears when you click  or select the
Details action) or from the Folders page of a product or library. You may also be able to complete these actions on the tables under the Home tab:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check Out and Download</td>
<td>Makes a working copy of a document file, which you can download to your computer. The original document in Windchill PDMLink is locked to prevent changes by others. At the time of check out, the downloaded file (that is, the working copy) duplicates the file most recently checked into the document. Once you check out a document, the document appears in your Checked-Out Work table under the Home tab.</td>
</tr>
<tr>
<td>Undo Checkout</td>
<td>Reverses a check-out operation. This option avoids the creation of a new iteration and the appearance of your name in the Modified By field, which would occur with a checkin. For example, if you realize that the document you checked out is not the correct one, you can undo the checkout.</td>
</tr>
<tr>
<td>Check In</td>
<td>Replaces the locked, previous version of a document with your working copy. The working copy supersedes the prior iteration of the document. Past iterations are stored in the Iteration History table on the document information page.</td>
</tr>
</tbody>
</table>

The check-out and check-in functionality ensures that two people are not modifying the same document at once, and individuals who wish to view a document are made aware that the document is in the process of being changed.

In addition to checking in and checking out documents, you can choose among the following actions to modify documents. These actions can be completed from the information page of a document or from the Folders page under the product or library:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update</td>
<td>Allows you to change the content file of a document or add document attachments. You can also enter a new title and description for the document, as well as enter new values for any additional attributes that your site has defined. Note that you must first check out a document for the update action to appear. Because a document is not checked in during an update, the changes made during the update will not be visible to others until you check in the document.</td>
</tr>
</tbody>
</table>
Managing Documents with Windchill Desktop Integration

With Windchill Desktop Integration, you can complete many of the previously mentioned document management actions without leaving Microsoft Word, Excel, or PowerPoint. This means that once a document is created in the Windchill system, you do not need to open Windchill PDMLink to complete document management tasks. After installing Windchill Desktop Integration, you connect to a server to complete document management functionality in the Microsoft application. For a list of available functionality, see Windchill Menu Options.

Important Tip for Netscape Users: Windchill Desktop Integration downloads content by using a file called "data.wcdti." The first time you download content, you may get a dialog asking what you want to do with the file. If you prefer not to get this dialog with future downloads of this file, you should select the option, "Open it with the default application," and ensure that the check box labeled "Always show this dialog before handling files of this type" is not selected, before clicking the OK button.
Installing Windchill Desktop Integration

The installation for Windchill Desktop Integration is available under the Home tab. Click the Utilities link below the tab, and then click Software Downloads. After you accept the license agreement, the Software Downloads page appears. Under Setup and Installation 7.0, click Windchill Desktop Integration 2.0 Installation.

Note: Windchill Desktop Integration supports Microsoft Office 2000 and later versions.

To uninstall Windchill Desktop Integration, use the standard Microsoft Add/Remove Programs.

Windchill Menu Options

Windchill Desktop Integration provides the functionality to modify documents, but not to create them. For information on creating documents in Windchill PDMLink, see Creating Documents.

After Windchill Desktop Integration is installed, a Windchill menu appears on the toolbar of the following Microsoft Office applications: Word, Excel, and PowerPoint. The menu also appears when you right-click on a document from Windows Explorer or your desktop.

These menu options are meant to coincide with Microsoft functionality. As a result, some of the terminology is different from the terms you may see within Windchill PDMLink.

The following options appear in the Windchill menu:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Active Server</td>
<td>Connects to Windchill PDMLink. Many of the menu options listed in this table are not available until you connect to Windchill PDMLink. Your site may have more than one server that appears when you select this option from the menu. See your system administrator for information on the correct server for your use.</td>
</tr>
<tr>
<td>Disconnect</td>
<td>Disconnects the Microsoft Office application from Windchill PDMLink.</td>
</tr>
<tr>
<td>Search</td>
<td>Locates documents in the Windchill PDMLink database.</td>
</tr>
<tr>
<td>Check Out</td>
<td>Makes a working copy of a document while locking the original document to prevent change by others. At the time of check out, the working copy duplicates the original object.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Cancel Checkout (Undo Checkout)</td>
<td>If you realize the document you checked out is not the correct one, undo the checkout. This option avoids creating a new iteration and your name appearing in the Updated By field, which would occur with a checkin.</td>
</tr>
<tr>
<td>Revise</td>
<td>Creates a new version of a document. Each time you check in a document, you create a new iteration. Revising a document allows you to maintain (create new iterations in) different versions of a document.</td>
</tr>
<tr>
<td>Update</td>
<td>Allows you to change the content file of a document or add document attachments. You can also enter a new title and description for the document, as well as enter new values for any additional attributes that your site has defined. Note that you must first check out a document for the update action to appear. Because a document is not checked in during an update, the changes made during the update will not be visible to others until you check in the document.</td>
</tr>
<tr>
<td>Check In</td>
<td>Replaces a locked, original version of a document with your working copy. The working copy supersedes the original iteration of the document.</td>
</tr>
<tr>
<td>Rename</td>
<td>Allows you to enter a new name for a document. This changes the document name for all versions and iterations of the document (and could make it difficult for others to find the document if they are searching by name.)</td>
</tr>
<tr>
<td>Get Content (View)</td>
<td>Opens a copy of the document without checking out the document. This option is available only on the Windchill menu of the Search window.</td>
</tr>
<tr>
<td>Delete</td>
<td>Removes all iterations of the most recent version of a document from Windchill PDMLink. You must select and delete the most recent version of a document before you can delete any previous versions.</td>
</tr>
<tr>
<td>Revert to Windchill Copy</td>
<td>Opens the document as it appeared when it was most recently checked into the Windchill PDMLink database. Select this option if you made accidental changes and want to return to an original copy of the document.</td>
</tr>
<tr>
<td>Refresh Properties</td>
<td>Applies the current document attributes from Windchill PDMLink to the document.</td>
</tr>
</tbody>
</table>
Although the Windchill menu options appear when you right-click any document in Windows Explorer or on your Desktop, the **Revert to Windchill Copy** option is enabled if the document is a not Windchill-owned object (meaning, Windchill PDMLink does not recognizes the document in the database).

In addition, the action menu options, from **Check Out** to **Delete**, are enabled only if the document is a Windchill-owned object and you have modify permission for the document.

### Exchanging Attributes between Windchill and Microsoft Office

When you edit a document in a Microsoft Office application with Windchill Desktop Integration installed, you can use Microsoft Office functionality to place the Windchill attributes as fields within the content of the document file.

The following attributes are mapped to Microsoft Office from Windchill:

- Title
- Description
- Primary Content URL
- Name
- Number
- Type
- Context
- Version Info
- Life Cycle State
- Obid

**Note:** The Obid field should not be edited. This attribute retains the document’s relationship to Windchill.
Select **File>Properties** from the menu of the Microsoft application to view these attributes. The title and description attributes appear under the **Summary** tab. The remainder of the attributes appear under the **Custom** tab.

If your site defined additional attributes for a document, these attributes are also mapped to the Microsoft Office applications and appear under the **Custom** tab. These attributes are distinguished with the prefix "IBA".

The online help within the Microsoft application describes detailed steps for placing these attributes as fields within the text of the document file.

In Microsoft Word, search the online help for "DocProperty field."

In Microsoft Excel and PowerPoint, search the online help for "custom file properties."

### Options for Downloading Documents

This section provides more detailed information on the downloading options available under the content preferences. To view these preferences, click **Utilities** below the **Home** tab. On the **Utilities** page, click **Preferences**. Click the **Content** tab. For more information on the other preferences, see **insert link**.

#### Desktop Integration File Download Option

If you are using Windchill Desktop Integration for authoring documents, set the **Desktop Integration File Download Option** preference to **Always use Desktop Integration to download the primary file of a Windchill document**. This selection

- allows the Microsoft Office authoring tools to embed the Windchill information into the download file.
- supports download preferences. However, this selection does not always give you the option to cancel any downloads, download multiple files at once, or choose a download location other than the **Default Local Directory** selected in that content preference.

#### Desktop Integration Plug-In Auto Detect Behavior

If you selected "always" in the previous preference, and you only login from a single workstation, set the **Desktop Integration Plug-In Auto Detect Behavior** preference to **Prompt to install Desktop Integration plug-in if it is not detected on your machine**. As a result, when you get a new workstation, you will be reminded to install the plug-in again.

If you login from other workstations that may or may not have Windchill Desktop Integration installed, set this preference to **Automatically use the standard browser and applet downloads if the Desktop Integration plug-in is not detected on your machine**. As a result, you will not be prompted each time you login to a different machine that does not have the Desktop Integration plug-in.
installed. If you do get prompted on a different machine, and decline the installation of the plug-in, Desktop Integration would no longer be used automatically for downloading when you return to your other machines.

Java Applet File Download Option

This applet is the standard intelligent download mechanism for Windchill. For most users, including those using Windchill Desktop Integration, set the Java Applet File Download Option preference to Always use Java applet to download the primary file of Windchill documents. As a result, the Java download is used in select download operations in the absence of Windchill Desktop Integration. This selection

• supports all download preferences, including Default Local Directory and Download Operation Type. Also, with each download, you have the opportunity to select an alternative to your preference. For example, you can select a directory other than your default, or you can cancel your download, such as the automatic download upon checkout.

• allows downloading of multiple files at once.

• requires the applet to load before download begins, which is noticeable in a slow network environment.

Java Applet Plug-In Auto Detect Behavior

If you selected "always" in the previous preference, and you only login to workstations where plug-ins are allowed, set the Java Applet Plug-In Auto Detect Behavior preference to Prompt to install the Java plug-in if not detected on your machine. If plug-ins are not allowed in a location where you will login, selecting Automatically use the basic browser handling to download files will allow a browser to download the file if the Java plug-in is not detected on the machine.

Browser Download

If you select "never" in the Desktop Integration File Download Option preference and Java Applet File Download Option preference, a browser download will occur. This selection is most appropriate in slow-network situations. While this selection enables a quicker download, other preferences such as Default Local Directory, are not supported and neither is the downloading of multiple files.
This chapter introduces you to CAD data management in Windchill PDMLink. First, CAD documents, the containers of CAD file information, are described. Next, you are introduced to the workspace, a private area that allows you to view and manage CAD information. Later sections take you step-by-step through the processes of saving CAD data to Windchill PDMLink and creating enterprise part structures from CAD data.

**Topic** | **Page**
---|---
About CAD Documents | 5-2
About the Workspace | 5-2
Saving CAD Data to Windchill PDMLink | 5-5
Creating CAD Documents with Pro/ENGINEER Wildfire CAD Data | 5-12
Creating Part Structures for CAD Data | 5-16
Setting the Preference to Display the Workspaces Sub-navigation | 5-23
About CAD Documents

A document is a database object containing files in application format. CAD documents are Windchill objects that are used to store and manage CAD information files (the output of CAD authoring applications).

A CAD document typically has content and attributes that are relevant to the external application only, such as Pro/ENGINEER files (3-D models, drawings, viewable images, analyses, and so on). It can contain both primary content (for example, a 3-D CAD model file), and secondary content (for example, a drawing).

CAD documents have the following additional characteristics:

- Ability to be related to other CAD documents to allow representation of the complex dependencies created and maintained by the authoring CAD system (for example, model-to-model in a Uses/Used by relationship, or model-to-drawing in a secondary relationship).

- Required dependents, which are other CAD documents whose file information is needed to fully represent the total structure of the original CAD Document (those documents with file information necessary to regenerate the model in Pro/ENGINEER Wildfire).

- Ability to be related to enterprise parts so that a CAD document can Describe the associated enterprise part. The part is said to be Described By the CAD document, that is, by the primary content (often a 3-D CAD model) and optional secondary content (drawings, layouts, CAD tool-generated reports, analyses) that it contains.

As described later in this chapter, the CAD document structure of related CAD documents can be used by the Windchill build rule to build a product structure of associated enterprise parts.

About the Workspace

The workspace is a private area where you can manage multiple objects and perform basic Product Data Management (PDM) operations. Technically, the workspace is a folder in your personal cabinet in Windchill PDMLink, but it is one that allows you to conveniently view and perform actions on both enterprise parts and CAD documents.

Workspace Features

Some of the special features of a workspace include the following:

- At its creation, a workspace is associated with a Windchill context. Commands available in the workspace are appropriate for its context, and object creation, storage, and retrieval actions are, by default, within the confines of a context.
• Workspace functionality varies, depending on whether or not the workspace is your active workspace (that is, your designated workspace for PDM operations while working with Pro/ENGINEER Wildfire), or it is being used in standalone mode.

• The workspace holds data for the objects referenced in it by the use of baselines.

• The workspace holds references to configuration specifications, folders, and life cycles applicable to parts and documents, and views for parts.

• Objects in the workspace can be sorted by the principal attributes that form the column headers in the Object List table.

• You can filter object types for display. For example, you can choose CAD documents only, or parts only, or specify a custom filter defined according to a chosen object attribute.

• The workspace has an event console, available from the View menu, to view system messages that report on the success or failure of your PDM actions.

• The status of objects in the workspace relative to the database is reported both by a column in the Object List table and a graphical symbol on the type icon of the object.

Workspace Configuration

You can configure your workspace so that the objects you work with can inherit certain properties by default. For example, you can:

• Set values for common attribute sets, such as team or life cycle.
• Assign storage folders
• Assign configuration specification for CAD docs and enterprise parts

Workspace Actions

Once enabled, the Workspaces sub-navigation link on the Product or Library context tab takes you to the My Workspaces page, where you can view a list of existing workspaces, as well as create or delete workspaces.
Note: By default, the Workspaces sub-navigation in Windchill PDMLink is unavailable prior to creating a workspace via Pro/ENGINEER Wildfire, or setting a user preference to display the link. See Setting the Preference to Display the Workspaces Sub-navigation, later in this chapter.

Clicking the hyperlink for an existing workspace in the Workspace Name column takes you to that workspace.

Once you enter a new or existing workspace you have the ability to perform the following PDM actions:

- Download database objects to the workspace (obtain a read-only copy)
- Check out objects (obtain a working copy for modification)
- Create new objects
- Upload and check in objects during modification
- Undo checkout of objects
- Associate objects, either explicitly, or by using the autoassociate function (which automatically creates and associates an enterprise part for a CAD document).
- Search or browse the database for objects. Search and browse functionality is integrated with most workspace actions.
- Revise objects to be the start of a new branch of development
- Update objects with the latest database version
- Move objects to new storage locations
- Remove objects from workspace
• Set the life cycle state of an object
• Select an organization for an object
• Access an object details page
• Delete objects from the database

Detailed information about performing all of the above actions is available in the online help topics that can be accessed from the workspace and its action pages.

**Saving CAD Data to Windchill PDMLink**

This section explains how to capture Pro/ENGINEER Wildfire CAD data in your Windchill PDMLink system. The steps can be summarized as follows:

1. Create or open a product or library context workspace
2. Register the Windchill PDMLink server and workspace in Pro/ENGINEER Wildfire.
3. Set your primary server and active workspace
4. Create or retrieve CAD data in Pro/ENGINEER Wildfire.
5. Upload CAD data to your workspace and check into Windchill PDMLink.

**Note:** This is a sample workflow for illustrative purposes. Alternate workflows (for example, creating the workspace after registering your Windchill PDMLink server in Pro/ENGINEER Wildfire) are also possible. The interaction with other CAD tools may be different. If you are working with a CAD tool other than Pro/ENGINEER Wildfire, be sure to consult the user’s guide for the appropriate Workgroup Manager.

**Creating a Workspace for Your Context**

Typically, product development begins with an idea for a product. Even before an initial sketch is made, it can be beneficial to establish a container or location for all information that relates to that product’s development and implementation. A Windchill PDMLink context, for example, a product or library, is just such a common location. When you create a workspace, you associate it with a context, which by default enables object creation, storage, and retrieval actions to be within the confines of the context.

Use the following procedure to create a workspace for your context:

1. Click the Project (or Library) tab, and then select the Workspaces subnavigation link.

   The My Workspaces page for the context appears, displaying a list of any existing workspaces. You can also access the commands to create or delete workspaces.
2. Click **Create Workspace**.

   The **Create New Workspace** window opens.

   ![Create New Workspace Window]

   *Workspace name and Context are required.*

3. In the **Name** field, specify a unique name for the workspace.

4. Optionally, in the **Description** field, enter a description for the workspace.

5. Select a context for the workspace from the choices available in the **Context** drop-down list.
6. Click **Ok**. You receive a confirmation message that the new workspace has been created and the new workspace page appears in the browser window.

**Note:** Preferences for document and part life cycles, team, view, and folders are set on the **Edit Workspace Options** page. To set or modify these values, select **Edit > Workspace Preferences** on the workspace page.

**Registering Your Server and Workspace in Pro/ENGINEER Wildfire**

When you register your server and workspace in Pro/ENGINEER Wildfire you can access them through the embedded browser in a Pro/ENGINEER Wildfire session.

Use the following procedure to register your workspace:
1. From the Pro/ENGINEER Wildfire menu bar, select **Tools > Server Registry**.

The **Server Registry** dialog box opens.
2. On the **Servers** tab, click **Add**. The **Register new server** dialog box opens.

![Register new server dialog box](image1.png)

3. Specify the server name to appear in the Pro/ENGINEER Wildfire **Folder Navigator**.

   **Note:** You can enter any name for the server.

4. Enter the URL to the Windchill PDMLink server location.

5. Click **Check** to validate the server location.

6. Enter the user name and password in the authentication dialog box.

7. Select your workspace from the **Workspace->Context** drop-down list.

![Register new server dialog box](image2.png)

8. Click **OK**. The Windchill PDMLink server is added to the Pro/ENGINEER Wildfire **Folder Navigator** and is available from the **File Open** dialog box.

The procedure just described registers your server and workspace in Pro/ENGINEER Wildfire. At this point you have access to your new workspace and your other workspaces and files located on the registered server. To designate
the new workspace as your default workspace for PDM operations while working with Pro/ENGINEER Wildfire, you need to set it as the active workspace on your primary server.

**Setting Your Primary Server and Active Workspace**

Use the following procedure to set your workspace as the active workspace on your primary server:

1. In Pro/ENGINEER Wildfire, select **Tools > Server Registry** to bring up the **Server Registry** dialog box.

2. Select the server you want to make primary and click **Set**.

3. Click the **Workspaces** tab. The workspaces for your primary server are listed. The currently active workspace is shown with an active workspace icon 🔄.
4. Select the workspace you want to be active and click **Activate**.

Your chosen workspace is now indicated as the active workspace, both in the **Server Registry** dialog box and in the **Folder Navigator**.
Selecting your workspace node in the **Folder Navigator** displays your workspace in the Pro/ENGINEER Wildfire embedded browser.

**Creating CAD Documents with Pro/ENGINEER Wildfire CAD Data**

You, or your design team, can create CAD data for your product using Pro/ENGINEER Wildfire. In your workspace, you can create CAD documents and assign CAD files as the primary and secondary content of the CAD documents.

To create a CAD document with a primary content file, do the following:

1. In your workspace, select **File > New > CAD Document** or click **Create CAD Document**.
The Create CAD Document page appears.

2. Enter or select entries for the following fields:

   - **Number** -- The number you enter must be unique.
     
     **Note:** If the site preference to use auto-numbering is set, this field is inactive and you cannot enter a number manually.

   - **Context** -- Select a context from the drop-down list provided. Your workspace context is entered by default.

   - **Name** -- Enter a name for the new document. The default name is the same as the number.

   - **File Name** -- Enter the CAD file name that the new document will reference (include the file extension). Typically, this is a Pro/ENGINEER PRT or ASM file.

   - **Type** -- Select the type of object.

   - **Location** -- Enter the path or browse to a folder within your selected context where the CAD document will be saved. Click **Browse** to display the Select Cabinet or Folder page and select a cabinet location on the server. You can also create a new folder.

   **Note:** **Number** is a required field unless autonumbering is on. If autonumbering is on, **File Name** is a required field.
Note: If the site preference to display organization information is set, you can also set a value for **Organization ID**. If you select an external organization, the **Number** field accepts a manual entry even if autonumbering is on.

3. If you want to simultaneously create an associated part, select the **Create and Associate Part** check box.

   **Note:** It is recommended that you associate a part with a CAD document at object creation, not when you create a structure. For this chapter's introduction to the process, however, we will describe associating parts to documents in a separate section to follow.

4. Click **Ok**.

   You can repeat this process for whatever number of CAD files you need to represent your product.

   **Note:** CAD documents can be created from Pro/ENGINEER Wildfire session by simply saving the models to the active workspace. Secondary content (for example, images, transfer files, and ZIP files) can be created and attached to the CAD document from Pro/ENGINEER Wildfire, as well.

### Checking CAD Documents into Windchill PDMLink

CAD documents newly created in your workspace are not visible to other users until they are checked in. Use the check in command to remove the lock on an object and make it available for check out by other users.

To check in an object:

1. In the active workspace, select the object(s) that you want to check in
2. Select **File > Check In** or click **Check In**. The **Check In** page appears.

On the **Check In** page, clicking the following icons in the **Object List** toolbar enables the following described options:

- **Location** (also available in the **Location** column) -- Opens the **Select Cabinet or Folder** window to allow you to select the context and storage location for the selected object.

  **Note:** The context of an object is defined at first upload. You cannot move objects between contexts.

- **Include Drawing** -- Selects for check in all parent drawings associated with the selected object.

- **Include Parts or Documents** -- Selects for check in any parts or CAD documents associated with the selected object.

- **Keep Checked Out** -- Toggles whether or not to check in the contents of the selected object to the server and immediately recheck out the object to your workspace.

- **Included/Exclude** -- Includes or excludes the selected object from being checked-in. Excluded items are struck-through with a red line.

3. On the **Check In** page, clicking the following icons in the **Object List** toolbar enables the following described options:
4. Selecting **Create Baseline** creates a baseline with a default number with your log on name, date, and time.

5. Selecting **Design Complete** allows you to undo check out for the unmodified dependents of the items selected for check in. This removes your lock on the set of the objects when your work is complete.

6. If the items selected for check in or items added to the list based on dependencies include incomplete objects, an **Auto resolve incomplete objects** check box is available. When selected, the autoresolve functionality handles incomplete objects in two ways, based on settings on the **Check In Options** page:

   - In the default method, the system searches for an object on the server with the same file name. If one is found, the incomplete object is updated by the found file, which means that it is no longer incomplete, and, therefore, available for check in.

   If no object is found to update the incomplete object, the system ignores the incomplete object (which is removed from the check in list).

   - The system can be set to always ignore an incomplete object

   **Note:** On the **Check In Options** page you can set the autoresolve functionality either to attempt to update the incomplete object and ignore the object if updating is not successful, or to always ignore an incomplete object.

   **Note:** Site administrative settings may not allow the ignore option. Required dependents cannot be ignored.

7. **Click Ok.**

Upon check in, the relationships of CAD files that represent the various components of an assembly are propagated to the CAD documents that reference them. For example, this means that the CAD document for, say, a parent axle assembly, has a Uses relationship with the CAD document for a child wheel assembly. In other words, the physical relationship of parent and child parts is captured in the resulting CAD document structure.

### Creating Part Structures for CAD Data

Once a CAD document structure has been created, a product structure can be created in Windchill PDMLink by creating and associating an enterprise part to each CAD document in the CAD document structure, and then checking all the objects into Windchill PDMLink. Upon check in, the Windchill build rule uses the
relationships among the CAD documents to build a product structure relating all the enterprise parts.

**Associating CAD Documents to Enterprise Parts**

It was mentioned in the section on creating CAD documents that a recommended practice is to create and associate enterprise parts with CAD documents at the time of creation. However, there are at least two reasons why that practice might not be followed:

- The CAD documents were created in the workspace by the **Save and Upload** command in Pro/ENGINEER Wildfire, not using the **Create CAD Document** window in the HTML UI.

In this case, the workspace provides the **Auto Associate Parts** command that allows you to select multiple CAD documents, and then create and associate enterprise parts for those documents with a single click. You can also associate documents to existing parts.

- Enterprise parts intended to correspond to the CAD documents have already been created in Windchill PDMLink.

In this case, the **Associate** command allows you to select a CAD document and then search or browse for the appropriate enterprise part to which to associate it. The **Associate** command also allows you to start with a part and find an appropriate CAD document. The use of both commands is detailed in the following sections.

**Automatically Associating Parts**

The **Auto Associate Parts** command allows you to automatically find and associate an existing part to a CAD document or, if no matching part currently exists, create a new part and associate it to the CAD document. This functionality operates according to several conditions, and is accomplished using the **Auto Associate Parts** page.

**Note:** The exact manner in which the part is searched for, created, named, and numbered depends on preferences set by a site administrator. For more information, see the *Windchill System Administrator's Guide*.

**Auto Associate Conditions**

The autoassociate parts functionality works in accordance with the following conditions:

- For a successful association, the document must be checked out and have no existing associations, and the part must be checked out (autoassociate automatically checks out the found or created part to the workspace). Documents and associated parts remain checked out to the workspace after association.
• While searching parts, if more than one part per document is returned, then the Auto Associate Parts command ignores the document and an error message is shown in the event console.

• In multi-selection, if you select parts and checked in documents along with qualified CAD documents, the parts and checked in CAD documents are ignored by the Auto Associate Parts command. If none of the selected objects are valid candidates for the command, then a status message is shown:

None of the selected objects is eligible for the 'Auto Associate Parts' action.

• If you select a newly created drawing document, the system searches for a model for the drawing in the database. If the model is found, the system creates a Described By link between the part and the drawing, and an active association between the part and the model. If the model is not found, a message stating this is reported in the event console.

Auto Associate Page

When you select a CAD document from the workspace and click Auto Associate Parts, the Auto Associate Parts page appears with two object list tables.

The first table, preceded by the message Following associations will be created to existing parts, lists documents and existing parts proposed to be associated. If no existing parts are found the table message instead reads Search found no existing parts. When parts are found, the information and possible actions are presented in the columns described in the following table:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Untitled column</td>
<td>Contains a check box which lets you select the object represented by that row.</td>
</tr>
<tr>
<td>Type</td>
<td>Contains the object icon specific to the document type and its state.</td>
</tr>
<tr>
<td>Doc Number</td>
<td>Displays the number of the selected document, formatted as a hyperlink to document details page.</td>
</tr>
<tr>
<td>Doc Version</td>
<td>Displays the version and iteration of the selected document.</td>
</tr>
<tr>
<td>Part Number</td>
<td>Displays the number of the part found during the search based on the search criteria, formatted as a hyperlink to the part details page.</td>
</tr>
<tr>
<td>Part Name</td>
<td>Displays the name of the part found during search based on the search criteria.</td>
</tr>
<tr>
<td>Existing Association</td>
<td>Displays the current association (active or passive) between the selected document.</td>
</tr>
<tr>
<td>Modify Association</td>
<td>Contains a drop-down list that allows you to modify the current association between the selected document and part.</td>
</tr>
</tbody>
</table>
The second table, titled **Following associations will be created to new parts**, lists documents and proposed new associations. The information and possible actions are presented in the columns described in the following table:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Untitled Column</td>
<td>Contains a check box which lets you select the object represented by that row.</td>
</tr>
<tr>
<td>Type</td>
<td>Contains the object icon specific to the document type and its state.</td>
</tr>
<tr>
<td>Doc Number</td>
<td>Displays the number of the selected document, formatted as a hyperlink to document details page.</td>
</tr>
<tr>
<td>Doc Version</td>
<td>Displays the version and iteration of the selected document.</td>
</tr>
<tr>
<td>Part Number</td>
<td>Contains a field specifying the number of the part associated to the selected document. The field may be editable, depending on the site preference set.</td>
</tr>
<tr>
<td>Name</td>
<td>Contains a field specifying the name of the part associated to the selected document. The field may be editable, depending on the site preference set.</td>
</tr>
<tr>
<td>Location</td>
<td>Contains a text field and folder browse button so that you can browse to and set a folder location for selected parts.</td>
</tr>
<tr>
<td>Source</td>
<td>Contains a drop-down list to specify how the part should be sourced.</td>
</tr>
<tr>
<td>Default Units</td>
<td>Contains a drop-down list for setting the default units for the selected part.</td>
</tr>
<tr>
<td>Association</td>
<td>Contains a drop-down list which allows you to modify the current association between the selected document and part.</td>
</tr>
</tbody>
</table>

To auto associate parts, use the following procedure:
1. In the workspace, select the documents to which you want to auto-associate parts and select Edit > Auto Associate Parts. The Auto Associate Parts page appears.

2. Examine the associations listed in the table of existing associations, using the Modify Association column to change the association type, if desired.

3. Examine the table of proposed associations. If necessary, modify the part number, name, type, or type of association (as allowed by the preference settings of your site).

4. If the auto-numbering preference is set to on and the auto associate policy is custom, you can move rows from the existing parts table to the proposed association table, using the Move Rows command in the menu bar of the existing parts table. Only rows having none as the existing association can be moved.

5. Use the button in the Location column, along with the drop-down lists in the Source and Default Units columns, and the check boxes in the leftmost column, to set values for one or more rows.

6. Click OK.

Note: The view assigned is the one specified in the General tab of the Edit Workspace Options window.

Associating CAD Documents to Parts.

Windchill creates structural relationships between WTParts and related CAD documents and maintains the association until it is no longer linked.

The Associate command allows implicit checkout of CAD document and WTPart objects, if they are not already checked out. In the case of a CAD document, checkout is for meta data checkout only; no content is downloaded during this checkout action. The Describes or Described By information in the property
sheets of the CAD document and WTPart displays the current relationship between a WTPart and a CAD document, even if the CAD document is not checked in. Before a CAD document is associated, the system performs an implicit (automatic) checkout.

**Note:** Any object checked out implicitly remains checked out even if the association fails to check out the other object.

**Note:** After you associate WTparts with all CAD documents in an assembly, you can see the association; however, Uses links between the WTparts are not visible until after check in, when the Windchill build rule constructs the Uses links.

It is recommended that you associate a WTPart with a CAD document at the time of object creation, not when you create a structure. A CAD document is said to Describe an enterprise part to be included in the bill of materials, and an enterprise part is Described By a CAD document.

To associate a CAD document with a part:

1. Select the CAD document you want to associate with a part in the workspace.

   **Note:** You may select more than one CAD document to associate with a part. In this case, all the documents describe the part; however, only one document can have an active link to the part.

2. Select **Edit > Associate**. The **Associate to** page appears.
3. Search for or browse to the part you want to associate to your CAD document. Your results appear on the Select the Parts to Associate page.

4. Select the part you want to associate with the document and click OK. The selected part is shown in a row on the Associate to page.

5. By default, the system creates an active link between the CAD document and the selected part. If you do not want the CAD document to drive the structure and attributes of the part, select None from the drop-down list in the Active Link field.

6. Click OK.

7. Perform a check in on the objects.

Note: Checking in the newly associated objects completes the association by allowing the Windchill build rule process to create Uses links between the parts of a part structure.

To verify the association, view the details page for either object. Clicking Described By on the details page for a part shows the associated CAD document. Clicking Related Parts on the details page for a CAD document shows the associated part in the Describes table.

Once checked in, the parts you associated to CAD documents have a product structure, which is visible on the Product Structure page for the top-level part.
Setting the Preference to Display the Workspaces Sub-navigation

By default, the Workspaces sub-navigation in Windchill PDMLink is unavailable prior to creating a workspace via Pro/ENGINEER Wildfire, or setting a user preference to display the link. You can set the display preference using the following procedure:

1. From the Home tab, select the Utilities subnavigation, then the Preferences link. The Edit User Preferences page appears.

2. Click Display, then select the CAD Workspace link. The CAD Workspace area appears.

3. Select the check box to enable the use of the CAD workspace and click OK. The Workspace link now appears as an available context sub-navigation link.
Managing Products and Product Structures

Understanding Products and Product Structures ................................................. 6-2
Navigating To and Through Product Structures .................................................. 6-4
Editing Product Structures in the Product Information Manager ...................... 6-22
Creating a New Product Structure View ........................................................... 6-35
Understanding Products and Product Structures

The database of Windchill PDMLink is structured such that all information uniquely defining a product is collected in one logical location. A person with administrative privileges creates this common location called a product. One of the implications of creating products is the capability to specify which users will be able to access and/or modify product information. For example, if you create a part or document within the location of a product (which is also referred to as the product "context") only users who have access privileges to that product can view or modify the part or document.

Windchill PDMLink assumes that each product will have at least one top-level assembly that represents a unit of product functionality that is sold, assembled, and delivered to the customer. Windchill PDMLink refers this top-level assembly as an end item. Additional end items may be created within a product in order to support the concept of product lines and modular products.

A product structure is a hierarchical representation of all assemblies and component parts necessary to assemble an end item. You can expand a product structure (that is, expand each sub assembly to see its child parts) until the lowest-level, component parts are shown. When you expand the product structure, you can specify the criteria by which the system will select and display versions of the child parts. The expansion criteria are called the configuration specification. For example, you can set a configuration specification to select only those parts in the "Released" state, or parts that are unique to a specific product structure view, such as "Manufacturing," which would show sub-assemblies created to facilitate product assembly. A bill of materials report an be generated from the expanded product structure.

All part versions shown in the expanded product structure of an end item may also be saved in the system as an end item configuration. The end item configuration may then be used to create end item instances. End item instances represent one unique copy of an end item configuration identified by a serial number and delivered to a specific customer. This permanent record of the configuration of a shipped product may be modified to reflect maintenance upgrades.

For many companies, the initial product structure is created from the data relationships captured in an associative CAD application such as Pro/ENGINEER. Relationships between components and assemblies are read from the CAD data files and used to generate an equivalent product structure in Windchill PDMLink. The CAD documents captured in the Windchill PDMLink database as a result of this integration are automatically associated to the parts in the product structure. This scenario is best described as "bottom-up" design. For more information, see Working with CAD Data. The converse of bottom-up design is "top-down" design. In this approach, a user will start building the product structure in Windchill PDMLink and then attach the appropriate CAD documents to the skeleton part structure.

Tip: If you copy an assembly using the Selected > Save As menu in Product Information Manager, saving the part with a new name does not create the
associated CAD data. Even though you may be able to see a visualization result, you still need to modify the CAD data in the CAD authoring tool.

Other forms of product definition data may be associated to the parts within the product structure. Such data might include process plans, inspection reports, material specifications, tooling designs, service documents and many more. A product structure fully adorned with product definition data provides users an intuitive means to determine the impact of a proposed design or manufacturing change. To determine the impact of a change the user would locate the desired end item, expand the product structure to the assembly or component of interest and navigate to all of the related information about that part version.
Navigating To and Through Product Structures

You can navigate to products and, thus, product structures from the Product tab. When you click on the Product tab, the system will navigate to the page that was displayed the last time that you clicked this tab.

Simply log into Windchill PDMLink and click the Products List below the Products tab to see the list of products in which you are defined as a team member.

In the Products table, click the icon or the name of the product (in this example, GOLF_CART) for which you want to see more information. The Details page appears.
Tip: You can also select a product from the **Recent Products** drop-down list on the top of pages under the **Product** tab.

The **Details** page displays the attributes of the product and the end items contained in the product. The online help available on this page gives complete descriptions of the attributes.

Actions available on the main product **Details** page are as follows:

**Tip:** After you select an action from the list, be sure to click **Go** to cause the action to be performed.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Create Document</strong></td>
<td>Creates a document in the context of the product that is displayed.</td>
</tr>
<tr>
<td><strong>Create Multiple Documents</strong></td>
<td>Creates one or more documents in the context of the product that is displayed.</td>
</tr>
<tr>
<td><strong>Create Document from Template</strong></td>
<td>Creates a document from a template in the context of the product. The template provides a standard format for file content. If no templates have been defined for the product, this option does not appear.</td>
</tr>
<tr>
<td><strong>Create Part</strong></td>
<td>Creates a part in the context of the product that is displayed.</td>
</tr>
</tbody>
</table>
Viewing a Product Structure

To view the product structure of an end item, select the **Product Structure** link under the **Product** tab. The page that appears displays the hierarchical tree of the top level end item, in this example GOLF_CART, within this product.
By default, the product structure is displayed, showing the first level children of the product. You can expand any subassembly preceded by the ▼ icon to the next level by clicking on the icon.

To expand a product to all of its levels with one operation, select the All check box in the top left corner of the table, then click either the ▼ icon or the Expand All link at the top of the table.

**Tip:** If the product structure will not expand, and the system displays are error message, select a new option in the **Configuration** drop-down list. For more information on these options, see **Product Structure Actions**.

The icons and hyperlinks at the top of the table are described below:

- **Show Documents** and **Hide Documents** determine whether or not you display any documents that are associated with parts in the product structure.
- **Show Occurrences** displays each occurrence individually, if there is more than one occurrence of a part within the product (meaning, the quantity of the part in the assembly is great than one)
- If the ESI module is installed, **Show Distribution Targets** and **Hide Distribution Targets** determine whether or not you display the distribution targets related to the product. A **distribution target** is a destination (typically and ERP system) to which you, the PDM system user, can publish various business objects using Windchill Enterprise Systems Integration.
- **Refresh** updates the product structure to show any changes that have been checked in since you accessed it initially.

**Product Structure Actions**

Above the product structure table are two drop-down lists: one to set a new configuration specification with which to display the product structure, and one to choose a report to be generated.

From the **Configuration** drop-down list, you can select any of the following specifications as the criteria to use when displaying the product structure:

- **The latest configuration specification**
Allows you to filter the product structure by specific BOM view and life cycle state. For example, view the parts that have not yet been released in the product structure you select.

- **A baseline configuration specification**
  Displays the versions of parts and documents within a product structure that are defined within the baseline you select.

- **An effectivity configuration specification**
  Displays the versions of parts within a product structure that will be effective in the context of the top end item or date you select.

- **An end item configuration**
  Displays the versions of parts and documents used in the end item you select.

- **An end item instance**
  Displays the versions and serial numbers of the parts and end item instances within a product structure that are included in the end item instance you select.

From the **Related Reports** drop-down list, you can select one of the following reports, then click **Generate Report** to produce it:

<table>
<thead>
<tr>
<th>Report Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Single Level BOM</strong></td>
<td>Displays a summarized list of the end items/parts in a bill of materials.</td>
</tr>
<tr>
<td><strong>Indented BOM</strong></td>
<td>Displays a hierarchical list of the end items/parts in a bill of materials.</td>
</tr>
<tr>
<td><strong>Multilevel Where Used</strong></td>
<td>Recursively follows the where-used relationships of the product structure to find the top level end items/parts (the end item/part that is not used by any other end item/part) that directly or indirectly use the particular end item/part. Note that the configuration specification is used to select only the configured versions of the end items/parts.</td>
</tr>
</tbody>
</table>
Multilevel BOM Compare

<table>
<thead>
<tr>
<th>Report Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multilevel BOM Compare</td>
<td>Recursively compares the product structures of two end items/parts (using two configuration specifications) and shows any differences in end items/parts and/or end item/part versions or iterations that might occur several levels deep in their respective product structures.</td>
</tr>
<tr>
<td>Note:</td>
<td>The system starts at the top of the hierarchies and compares until it finds an inconsistency, which it then reports.</td>
</tr>
</tbody>
</table>
Viewing Thumbnails in a Product Structure

If a representation (that is, a viewable derived from the CAD model) is available for a part, you can view an image of that part within a product structure. This capability gives you a visual clue that makes it much easier to recognize a part that is otherwise identified only with a name and number.

To view, and rotate, a thumbnail image, simply click the thumbnail icon in the Actions column of the product structure.

Tip: If you click the thumbnail icon for another part, its image replaces the current image. Only one thumbnail image is displayed at a time.
To view a part in full, three-dimensional mode, click the name hyperlink in the **Name** column of the product structure. This causes ProductView Standard Edition or ProductView Lite to be launched with the selected part displayed. You can now manipulate the view of the part by right-clicking on it and moving the cursor, you can perform other ProductView operations as well. For more information, see [Visualizing Data in Windchill](#).

You can view the thumbnail image displayed on the details page of an end item or part in the same way. Simply click the image, and it is opened in ProductView.
Viewing Additional Details of End Items and Parts

Having expanded a product structure and identified specific parts using the thumbnails or other information available in the table, you may want to see more specific information about a particular version of an end item, a subassembly, or a part. To do so, simply click ![Actions](from the Actions column of the desired item. The information page for that version of the end item, subassembly, or part is then displayed.

In addition to providing more information about the end item or part’s attributes (such as its status and date last updated), the information pages allow you to interact with the displayed end item or part in several ways:

- The navigation links, located on the left side of the page, display tables of additional information about the end item or part. The entries in many of these tables are links to additional data, allowing you to continue navigating to additional information.

- When the product structure is displayed (that is, the Product Structure navigation link is selected), drop-down lists above the table allow you to change the configuration specification used to display the structure, and to generate reports on the structure.

- The Actions list, located beside the end item or part name, provides many additional operations related to the specific end item or part.

Navigation Links

Clicking one of the navigation links on an end item or part information page causes a table of additional information about the end item or part to be displayed.
Some of these tables contain an **Actions** column, from which you can perform other actions, such as associating a document or navigating to another type of information page. For further information on the individual tables displayed through navigation links, see the online help, accessible by clicking on the help icon in the right corner of each table.

The following table summarizes the navigation links found on information pages of end items and parts.

<table>
<thead>
<tr>
<th>Link</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Product Structure</strong></td>
<td>Displays the hierarchical product structure of this end item or part, based on a configuration you specify. (This chapter assumes that you begin your navigation with a product structure, but it is also possible to move from an individual part/end item to display the product structure of which it is a part.) You can expand and collapse this structure, link to the details of any of the end items/parts displayed in it, perform selected actions on any end item/part, and view occurrences of each end item/part. You can also change the configuration on which the display is based, and generate related reports.</td>
</tr>
<tr>
<td><strong>Related Documents</strong></td>
<td>Displays documents, CAD models, and drawings that are related to this end item/part. You can link to any of these documents.</td>
</tr>
<tr>
<td><strong>Additional Properties</strong></td>
<td>Displays properties or attributes defined by your site and their current values. If all site-defined properties can be displayed in the top part of this page, this link does not appear.</td>
</tr>
</tbody>
</table>
### Link

<table>
<thead>
<tr>
<th>Link</th>
<th>Description</th>
</tr>
</thead>
</table>
| Associated Changes | Displays problem reports open against the end item/part, Enterprise Change Requests (ECRs) pending against the end item/part, and Enterprise Change Notices (ECNs) pending against the end item/part.  
In addition, displays the ECN that caused the creation of this version of the end item/part.  
For more information, see Managing Change. |
| Used By            | Displays the end items/parts that use this end item/part (that is, the immediate parent end item/part). You can link to any of these end items/parts. |
| Replacements       | Displays the alternates and substitutes for this part and the parts for which this part is an alternate or substitute.  
**Tip:** An end item/part alternate applies across products, while a substitute applies only in the context of the top-level end item. |
<p>| Effectivity        | Displays the effectivity of the end item/part. For more information, Managing Change.                                                         |
| Configurations     | Displays the end item configurations that use this end item/part.                                                                           |
| End Item Instances | Displays the end item instances that use this end item/part.                                                                                 |</p>
<table>
<thead>
<tr>
<th>Link</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Versions</td>
<td>Displays all versions of this end item/part. From this table, you can compare versions to identify differences in the properties of each, and link to the details for each version. <strong>Tip:</strong> To create a new version of an end item/part, select Revise from the Actions list on the end item/part information page.</td>
</tr>
<tr>
<td>Iteration History</td>
<td>Displays the current end item/part iteration and the iteration history of this end item/part (along with links to each iteration). From this table, you can compare iterations to identify differences in the properties of each, and link to the details for each iteration. A new iteration is created each time you check in an end item/part.</td>
</tr>
<tr>
<td>Life Cycle History</td>
<td>Displays the life cycle history of this end item/part.</td>
</tr>
<tr>
<td>Saved As History</td>
<td>Displays the saved as history of this end item/part, showing the original end item/part from which it was created, and the end items/parts created from this end item/part using the Save As action. You can link to any of these end items/parts</td>
</tr>
<tr>
<td>Subscriptions</td>
<td>Displays your subscriptions for this end item/part. From this table, you can subscribe to additional end item/part events. For more information, see Communication Tools In Windchill PDMLink.</td>
</tr>
<tr>
<td>Signatures</td>
<td>Displays information about signatures that indicate a workflow task for this end item/part is complete.</td>
</tr>
<tr>
<td>Link</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Related Processes</td>
<td>Displays any workflow processes that are currently running or have ever ran against this version of the end item/part.</td>
</tr>
<tr>
<td>Baselines</td>
<td>Displays the baselines to which the part belongs. A baseline lists the specific versions of parts and documents, respectively, in a structure at a given point in time.</td>
</tr>
</tbody>
</table>

End Item and Part Actions

In addition to viewing information, you can also perform actions on the end item or part from the details page.
The following table summarizes the actions available.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discuss</td>
<td>Displays the discussion forum associated with the end item or part. For more information, see Discussion Forums in the Communication Tools chapter.</td>
</tr>
<tr>
<td>Check Out</td>
<td>Checks out the end item or part. This action is available only if you have permission to update it and it is currently checked in. When an end item or part is checked out, this action disappears from the list, and the Check In and Undo Check Out actions appear.</td>
</tr>
<tr>
<td>Check In</td>
<td>Checks in the end item or part. This action appears only when it is checked out by you.</td>
</tr>
<tr>
<td>Undo Check Out</td>
<td>Cancels the checkout of the end item or part. This action appears only when it is checked out by you. When you undo a checkout, any changes made during an update operation will be lost and the system will revert to the values they had before the checkout.</td>
</tr>
<tr>
<td>Associate Document</td>
<td>Associates an existing document with the end item or part.</td>
</tr>
<tr>
<td>Export</td>
<td>Compresses the content and metadata of a part into a JAR file in order to move the information to another site or portal. The JAR file resides on your local file system before being moved.</td>
</tr>
<tr>
<td>Product Information Manager</td>
<td>Opens the part in Product Information Manager. For more information, see Editing Product Structures in the Product Information Manager.</td>
</tr>
<tr>
<td>Create Problem Report</td>
<td>Creates a problem report against the end item or part.</td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>------------------------------------------------------</td>
</tr>
<tr>
<td>Create ECR</td>
<td>Creates an enterprise change request (ECR) for the end item or part.</td>
</tr>
</tbody>
</table>
| Update                 | Opens the Update window, allowing you to change values of the product or part properties.  
When you click OK in the Update window, any changes are shown immediately on the information page.  
If you undo the checkout, the changes revert to the values they had before the checkout. |
| Delete                 | Removes the most recent version of the end item or part from Windchill PDMLink. |
| Create Representation  | Opens the Create Representation window. A representation stores the ProductView files created for the end item or part.  
Tip: The configuration specification used by the details page to display the product structure will be used to create the representation. |

**Viewing Data in the Product**

You can also explore the product data by clicking the Folders link under the Product tab. By selecting an option from the Current View drop-down list, you can have the system organize the data in the most appropriate format to accomplish your tasks. For example, you could view all parts, as in the screen below. In addition, from the Actions list in the Actions column of the table, you
can perform the same actions that are available from the information page of the object.

### Attaching Documents to End Items or Parts

Among the actions available from the pages under the **Product** tab, many allow you to attach data to the end item or a specific part within the part structure of a product. For example, a test engineer may want to include a test plan as documentation available with a given end item or part. Once the document is associated with the end item or part, anyone responsible for doing testing need only access the product in Windchill PDMLink to locate the test plan.

The following procedure shows how to create a document using a predefined template and then associate that document to a part. Note that you do not have to create the document from a template in order to associate it with a part. In fact, if your site has not defined any templates, the action will not even appear.

1. First create the document using a predefined template. This can be done from several locations:
   - From the **Products** tab or the **Library** tab, click the ![Create Document from Template](image) icon.
   - On an information page, open the **Actions** list and select **Create Document from Template**, then click **Go**.

   The **Create Document from Template** window appears.

2. Select the desired template from the drop-down list, and click **Next**.

3. In the subsequent window, enter values in the required fields (indicated by an asterisk) and any desired optional fields, then click **Finish**.
The **Choose File Operation** window appears.

![Choose File Operation](Image)

4. Select either **Open File**, which causes the template file to be opened immediately, or **Save File to Disk**, which displays the **Open** window, from which you can specify the location to download the template and the file name to be used.

![Open](Image)

In this example, the Desktop is selected as the location and the template will be downloaded to your machine. By default, the file name displayed is the name of the template file; you will probably want to rename the file here. Then click **Open**.
5. Edit the document on your machine.

6. When you are ready to upload the content of the document to Windchill PDMLink, navigate to the document on your Checked-Out Work table under the Home tab.

7. Click the information icon for the document. The information page for the document is displayed.

8. From the drop-down list of actions beside the document name, select Check In and click Go. The Check In Document window appears.

9. Drag and drop the file from your desktop to the area indicated in the window, or click Browse to navigate to the file in the file system, and then click OK. This action uploads the content of the file from your desktop and checks it into Windchill PDMLink.

10. You can then associate the document with the desired part in either of two ways:

   – Search for the part and, from the information page of the part, select **Associate Document** from the **Actions** list.

   – Locate the part in the product structure and click the **Associate Document** icon in the **Actions** column.

   The Find Document window appears.

11. Enter search values, and click Search. A list of documents is displayed.

12. Select the check box preceding the document you want to associate with the part and click **Add Selected Items**.

   The document is now associated with the part and can be viewed either in the product structure (if the icon or Show Documents hyperlink at the top of the table has been selected) or from the part’s information page when you click the Related Documents navigation link on the left side of the page.
Editing Product Structures in the Product Information Manager

The preceding chapter described how to move CAD data into Windchill PDMLink, and then the previous sections of this chapter described how to explore the resulting products and product structures for additional information. At this point, you may want to actually edit a product structure.

Most editing and other advanced product structure capabilities are performed in Product Information Manager.

Opening a Product Structure in Product Information Manager

You can access this functionality in either of two ways:

- Click in the title bar of any page under the Product or Library tab.

  Product Information Manager opens with no product structure displayed. Open a product by selecting File > Open and searching for the desired end item or part.

- On the information page of an end item or part, select Product Information Manager from the Actions list near the product name and click Go.

  Product Information Manager opens with the selected part or end item and its children displayed in the left pane.
Initially, Product Information Manager displays objects in the left pane only, and the right pane is blank. Selecting an end item or subassembly in the left pane causes its children and their properties to be displayed in the right pane.

Notice in this example that each of the child parts has a quantity of two. This means there are two occurrences of each part in the wheel assembly. The importance of this concept is illustrated later in the next section.
Visualizing a Product Structure in Product Information Manager

If ProductView Standard Edition or ProductView Lite has been installed, and if available, you can view 3-D images of parts in the Visualization tab by first selecting View > Show Occurrences. Because Product Information Manager is still in table mode, you will see that each of the multiple occurrences of a part now appears on an individual line item.

Each individual occurrence has an image and a stored location with respect to the rest of the assembly. This information, specific to each occurrence, is necessary to display the assembly accurately in the Visualization tab.
To view images, simply click the **Visualization** tab and **Visualization > Show All**. In this example, the wheel assembly is displayed and can now be manipulated.
Notice that when you select an individual part in the image, the corresponding entry in the left pane product structure is also highlighted. Likewise, when you select a part in the product structure, it is also highlighted in the image.

This functionality allows you to see clearly which part you have selected and, particularly in the case of multiple part occurrences, to ensure that you have selected the part you intended for viewing or editing. For more information, see Visualizing Data in Windchill.

**Tip:** You can move parts around in this visualization window in order to see hidden components; however, any rearranging is specific to your session and will not be stored in Windchill PDMLink.
Adding a Non-Modeled Part

All of the parts currently shown in the preceding example, the wheel assembly, have been modeled in a CAD tool. However, products often need non-modeled parts, such as paint or lubricant, as well. It is particularly important that these non-modeled parts be included in the product structure because they must be included in the bill of materials (BOM), which is created from the product structure. The Windchill PDMLink BOM is passed to manufacturing systems, such as ERP, where a complete BOM, including non-modeled parts, is required. (For further information about creating a BOM and other product structure reports, see Product Structure Actions earlier in this chapter, and the online help available for the product structures table.)

The following example describes how to add lubricant to the wheel assembly product structure.

1. Create a new part for the lubricant, using the following procedure:
   a. In Product Information Manager, select File > New > Part or click the New toolbar icon.
      The New Part window appears.
   b. On the Details tab, enter values in all the required fields (indicated by an asterisk) and any other desired optional fields. In this example, the following values are used:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>WHEEL_LUBRICANT</td>
</tr>
<tr>
<td>Number</td>
<td>If your site does not have auto numbering, enter a number.</td>
</tr>
<tr>
<td>View</td>
<td>Design</td>
</tr>
<tr>
<td>Type</td>
<td>Component</td>
</tr>
<tr>
<td>Source</td>
<td>Buy</td>
</tr>
<tr>
<td>Default Units</td>
<td>as needed</td>
</tr>
</tbody>
</table>
c. By default, the part is assumed to be associated with a product. To select the product, click **Search**.

The **Find Context** window appears.

\[\text{\includegraphics[width=\textwidth]{find-context-window.png}}\]

d. Select a context from the **Search On** drop-down list.

e. Enter search criteria in the **Name** field, and click **Find**.
f. Select the desired product, which then appears in the **Context** field, and click **OK**.

You are returned to the **Details** tab.
g. Click OK.

The new part is saved and the window closes. The newly created part appears in the left pane, but not within the product structure of the wheel assembly.

![Product Information Manager](image)

2. Update the wheel assembly to use the new part, using the following procedure:
   a. Select the desired part, in this case, WHEELS_ASSEM.ASM.
   b. Select **Selected > Update** or click the **Update** toolbar icon.

   A part must be checked out before it can be updated. Product Information Manager displays a message if the part is not checked out, however, and prompts you to let it be done automatically. (To check out the part yourself, select **Selected > Check Out** before updating.)
   c. Click **OK** in response to the prompt.

   When the part is checked out, a small pencil appears next to the part icon. The **Update** window for the part appears.
d. Click the **Uses** tab.

This tab displays the component parts that are used to create the wheel assembly.

![Part WHEELS_ASSEMBLASY (wheels_assem.asm) A - Update](image)

<table>
<thead>
<tr>
<th>Name</th>
<th>Number</th>
<th>Qty</th>
<th>Units</th>
<th>Generated in CAD</th>
</tr>
</thead>
<tbody>
<tr>
<td>wheel_shaft</td>
<td>WHEEL_SHAFT</td>
<td>2</td>
<td>each</td>
<td></td>
</tr>
<tr>
<td>bearing_shaft</td>
<td>BEARING_SHAFT</td>
<td>2</td>
<td>each</td>
<td></td>
</tr>
<tr>
<td>hub_cap</td>
<td>HUB_CAP</td>
<td>2</td>
<td>each</td>
<td></td>
</tr>
<tr>
<td>wheel_hub</td>
<td>WHEEL_HUB</td>
<td>2</td>
<td>each</td>
<td></td>
</tr>
<tr>
<td>axle_sleeve</td>
<td>AXLE_SLEEVE</td>
<td>2</td>
<td>each</td>
<td></td>
</tr>
<tr>
<td>tire</td>
<td>TIRE</td>
<td>2</td>
<td>each</td>
<td></td>
</tr>
</tbody>
</table>

e. Click **Add**.

The **Find Part** window appears.
f. Enter the search criteria of your choice and click **Find**.

Matching parts are displayed.
g. Select the part to be added and click **OK**.

The new part, **WHEEL_LUBRICANT**, now appears in the list of child parts in the **Uses** tab.

```
<table>
<thead>
<tr>
<th>Name</th>
<th>Number</th>
<th>Qty</th>
<th>Units</th>
<th>Generated in CAD</th>
</tr>
</thead>
<tbody>
<tr>
<td>WHEEL_LUBRICANT</td>
<td>001100001</td>
<td>1</td>
<td>as needed</td>
<td></td>
</tr>
<tr>
<td>wheel_axle_prt</td>
<td>WHEEL_AXLE_PRT</td>
<td>2</td>
<td>each</td>
<td></td>
</tr>
<tr>
<td>bearing_axle_prt</td>
<td>BEARINGS_AXLE_PRT</td>
<td>2</td>
<td>each</td>
<td></td>
</tr>
<tr>
<td>hub_cap_prt</td>
<td>HUB_CAP_PRT</td>
<td>2</td>
<td>each</td>
<td></td>
</tr>
<tr>
<td>wheel_hub_prt</td>
<td>WHEEL_HUB_PRT</td>
<td>2</td>
<td>each</td>
<td></td>
</tr>
<tr>
<td>axle_sleeve_prt</td>
<td>AXLE_SLEEVE_PRT</td>
<td>2</td>
<td>each</td>
<td></td>
</tr>
<tr>
<td>tire_prt</td>
<td>TIRE_PRT</td>
<td>2</td>
<td>each</td>
<td></td>
</tr>
</tbody>
</table>
```

**Tip:** You can also enter a different quantity or change the units of measure for each part.
h. Click **OK** to complete the update and close the **Update** window.  

WHEEL_LUBRICANT now also appears within the product structure of the wheel assembly.

---

i. To check in the wheel assembly, highlight the assembly and select **Selected > Check In**.

On the **Check In** window that appears, enter comments, if desired, and click **OK**.
Creating a New Product Structure View

Having explored the product structure for the golf cart as it was designed, you may decide that you would like to modify the structure to facilitate the assembly process.

For example, the wheel assembly used in the preceding section contains two occurrences of every child part. This was done to facilitate geometric modeling. However, this design produces a structure that is illogical for manufacturing. Manufacturing requires, instead, two wheel assemblies (with one each of the component parts) in order to build the top-level assembly, the golf cart product.

The following procedure shows how to create a new view of the product structure to be used for manufacturing. In this manufacturing view, the preceding wheel assembly will be replaced with a new part, Manuf Wheel Assembly. Manuf Wheel Assembly contains only one occurrence of each part and represents a single, complete wheel assembly.

Whereas the As Design product structure view for the golf cart showed one wheel assembly with two occurrences of each component part, the manufacturing product structure view will show two wheel assemblies, each with one of the component parts. Within the manufacturing view, the wheel assembly product structure will show all of the components that are necessary for the whole wheel as it arrives at the shop floor for final assembly of the golf cart.

1. Create a new wheel assembly part, named Manuf Wheel Assembly and intended specifically for the manufacturing product structure view, using the following procedure:¹

   a. Click **File > New > Part** and, on the **Details** tab, enter the required values. In this example, the following values are used:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Manuf Wheel Assembly</td>
</tr>
<tr>
<td>Number</td>
<td>If you site does not have auto numbering, enter a number.</td>
</tr>
<tr>
<td>View</td>
<td>Manufacturing</td>
</tr>
<tr>
<td>Type</td>
<td>Separable</td>
</tr>
<tr>
<td>Source</td>
<td>Make</td>
</tr>
<tr>
<td>Default Units</td>
<td>each</td>
</tr>
</tbody>
</table>

   **Note:** The **View** is set to Manufacturing.

¹ For a more complete description of how to create a part, refer to Adding a Non-Modeled Part, earlier in this chapter. The procedure given here summarizes many of the steps.
Also on the **Details** tab, associate the Golf Cart product with the new part.

b. Next click the **Uses** tab and, on that tab, click **Add**.

c. In the resulting **Find Part** window, search for the parts in the existing **WHEELS_ASSEM** part. Selecting the part and clicking **OK** in this window adds the part to the **Uses** tab.
Note: When you add WHEEL_LUBRICANT, change the units to "as needed," using the Units drop-down list on the right of the window.

d. Click OK and the new part is created.

2. Create a new view version of the golf cart for manufacturing, using the following procedure:

   a. For ease of readability, clear the current instance of Product Information Manager (by selecting View > Clear All), or open a new instance of Product Information Manager (by selecting View > New Product Information Manager Window or clicking the Open a new Product Information Manager window toolbar icon).

   b. Open the golf cart product, Golf Cart, by selecting File > Open and searching for the product.

   a. With the Golf Cart product open, select Selected > New View Version.

The New View Version window appears.

b. From the View drop-down list, select the desired view, in this case, Manufacturing, and click OK.
The new manufacturing view version of Golf Cart now appears.

3. Update the manufacturing view version of the golf cart to remove the original, design view wheel assembly, but add two occurrences of the new, manufacturing view wheel assembly, using the following procedure.

   a. Update the Golf Cart product by selecting Selected > Update.²
   b. Click the Uses tab.
   c. Select WHEELS_ASSEM and click Remove.

      The wheel assembly part is deleted from the golf cart product structure.
   d. Click Add.
   e. On the Find Part window, search for the replacement part that was just created, Manuf Wheel Assembly, and click OK.

      The replacement part now appears on the Uses tab.

² For a more complete description of how to update a part, refer to Adding a Non-Modeled Part, earlier in this chapter. The procedure given here summarizes many of the steps.
f. Change the quantity of the wheel assembly to 2 by incrementing the Qty field on the right of the tab.

g. Click OK to save the updated Golf Cart product.

h. Because the Golf Cart is still checked out, you can check it in at this time by selecting Selected > Check In.

4. Verify that both view versions contain the correct wheel assemblies, using the following procedure:

a. Open a new instance of Product Information Manager.

   If Golf Cart was selected in the earlier instance, the manufacturing view of Golf Cart appears in the new instance. (Otherwise, open Golf Cart in the new instance by selecting File > Open.)

b. Change the configuration specification to display the design view by selecting View > Set Configuration Specification.
The **Set Configuration Specification** window appears.

c. In the **Latest** section of this window (which is currently set), select Design from the View drop-down list, and click **OK**.
The Golf Cart product is now displayed in the design product structure view.

d. Comparing the two views, you can now verify that the original design view shows a single occurrence of the wheel assembly (WHEELS_ASSEM), which itself contains two occurrences of every child part.

The manufacturing view, however, now contains two occurrences of the wheel assembly (Manuf Wheel Assembly). Each wheel assembly uses one of each component part.
An alternate way to see the differences between the two views is to create a Multilevel BOM Compare report, using the following procedure:

a. On the Golf Cart product information page, with the product structure displayed, select **Multilevel BOM Compare** from the **Related Reports** drop-down list, and click **Generate Report**.

The **Multilevel BOM Compare Query** window appears.

b. The source BOM being used is the manufacturing product structure view. To compare it to the design product structure view, click **Set Config Spec**.

The **Set Latest Configuration Specification** window appears.
c. From the **View** drop-down list, select Design and click **OK**.

The target BOM against which the source BOM is compared is now the design product structure view.
d. Click **Generate Report** and the differences between the two product structure views are verified.
Managing Context Teams

This chapter describes the team functionality available within Windchill PDMLink.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About Context Teams</td>
<td>7-2</td>
</tr>
<tr>
<td>Creating and Modifying Teams</td>
<td>7-2</td>
</tr>
<tr>
<td>Team Member and Group Information Pages</td>
<td>7-3</td>
</tr>
<tr>
<td>Roles and Groups</td>
<td>7-4</td>
</tr>
</tbody>
</table>
About Context Teams

A context team is a list of the members of a product or library context. All members of the context can view the context team.

Team members are assigned roles within the context. A context manager role is automatically assigned to the creator of the context; however, the creator can assign the role to other team members. The context manager roles available are as follows:

- Product context -- Product Manager
- Library context -- Library Manager

If you are the context manager or the administrator of the organization where the context resides, you can modify the team from the Team page by adding and removing roles, users, and groups. You can define a team using any of the roles that are predefined for your organization or for your context, or you can define new roles that are specific to a context. Then you can add members to one or more roles in the team. Users may have different roles in each context in which they are a participant. In one context, a user can be the context manager while in another context, the user can be a member.

Tip: There is no explicit means of associating responsibilities with roles, but you can create a document in the product or library that identifies the responsibilities of each of the team roles or members. For more information about roles and groups, see the online help available from the Team page.

The team table information can be displayed differently using the available views from the Current View drop-down list.

- Members -- Displays the users and groups invited as team members to participate in a team.
- Members By Role -- Displays the team information organized by role with assigned team members listed under the roles. You can expand and collapse the different roles to view certain information and hide other details.
- All People -- Displays the users in the team with the groups expanded to reveal the names of any group participants. If no groups are a part of the team, this view displays the same information as the Members view.

Creating and Modifying Teams

The following table lists and describes the way in which a context manager can modify a context team:
<table>
<thead>
<tr>
<th>Action</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adding Members</td>
<td><img src="image" alt="Plus" /></td>
<td>Adds users and groups from the system to a particular team and assigns them roles within the team.</td>
</tr>
<tr>
<td>Adding Roles</td>
<td><img src="image" alt="Role" /></td>
<td>Adds organization defined roles or creates new roles that are available only for the specific team.</td>
</tr>
<tr>
<td>Replacing Members</td>
<td></td>
<td>Replaces an existing user with a new user from the system. When you replace a team member in a context, all of the objects in the context currently assigned to or owned by that user are transferred to the new user. See the online help for more information about the implications of replacing a member.</td>
</tr>
<tr>
<td>Removing Members</td>
<td></td>
<td>Removes a user from a role and, potentially, from the team. At least one user must be assigned to the role of the context manager. If you attempt to remove the last confirmed member in that role, you will receive an error message. If a user is completely removed from the team, all objects currently assigned or owned by that user are transferred to the context manager who removed the user. Exceptions include tasks that are instead reassigned to the responsible role.</td>
</tr>
<tr>
<td>Removing Roles</td>
<td></td>
<td>Removes a role from the specific team. You cannot remove the context manager or guest roles from a team.</td>
</tr>
</tbody>
</table>

### Team Member and Group Information Pages

Information pages contain specific details about the team member or group. To view a team member or group information page, click the team member or group name.
The team member information page displays some information that is set using the user preferences. These preferences can be changed from the Utilities page of the Home tab. If any of your information is incorrect but cannot be changed as a user preference, see your system administrator.

The following team member details are displayed:

- Name
- E-mail address
- Organization
- Phone Number
- Address
- Local Time Zone

The group information pages display the name and a description of the group. A list of the users assigned to the group is also displayed.

Roles and Groups

Roles

A role relates people in the product or library context with information and activities managed in that context. Roles help to group people who have similar duties in the context in a way that makes sense for the team. When people are added as members of a product or library context, the context manager must assign at least one role, such as member or reviewer, to each person. People in a product or library can be assigned to more than one role. The set of role assignments for each member is displayed on the Team page.

Although some roles and groups are provided when your organization and context are created, additional roles can also be defined for each product or library from the Team page.

A context manager role has special authority to create and organize the product or library, invite or remove team members, and manage the operations of the product or library.

The Guest role allows for a person to view data in a context without actually being invited as a participant. The following permissions apply to those assigned to the Guest role for a particular context:

- The product or library does not appear in the user’s list of products and libraries.
- Can access the context through a link or through search results.
- Can view product or library content.
Note: Users added to a database without specified e-mail addresses will not appear in the search results returned when adding users to a team.

For information on administrative roles, see the *Windchill Business Administrator’s Guide*.

**Groups**

Groups are used to manage access control to information, provide access to e-mail communication, and invite participation in meetings. There are special groups that are used with teams as well as public groups that are created and maintained at the organization context. Meeting attendees can be invited to meetings by group. The following paragraphs describe some of the special groups used with teams.

Each role that is defined has a corresponding group automatically created with the same name. Users added to a role are automatically added to the corresponding group. The context manager can then create access policies for role groups using the Policy Administrator. The policies are enforced whenever the roles are used. One special group that is created is the set of people from an organization that have joined a context. An organization is an entity, such as a company or university. When a user joins a product or library context, they are automatically added to a group for their organization.

Note: Users not affiliated with an organization will not be added to organization groups.

Note: In Windchill PDMLink, users are automatically confirmed as team members in a context.

The All Members group is the set of all team members in the context. You can view groups and their users on the **Team** page.

For example, a context is created, and people from Company A are invited. This context contains the two following groups:

- The All Members group, which contains every invited team member including those from Company A.
- The Company A group, which includes only those team members from Company A.

Later, people from Company B are invited to and join the context. All team members in Company B are added to the All Members group, and the context now contains an additional group called the Company B group which includes only those team members from Company B.
This chapter describes the closed-loop change management process functionality in Windchill PDMLink.

**Topic** | **Page**
--- | ---
Understanding Change Management | 8-2
Change Management Terminology | 8-2
Change Management Actions and Icons | 8-4
Accessing and Viewing Change Objects | 8-9
Change Management Process | 8-10
Change Monitor | 8-18
Understanding Change Management

The Windchill PDMLink change management system is based upon current industry standard change processes. The purpose of this chapter is to describe the change management process as well as actions available within Windchill PDMLink Change Management. For more information about managing the data that may be associated with change objects, see Managing Products and Product Structures or Managing Documents.

Change Management Terminology

This section describes the most common terminology used within the change management system.

Change Objects

Problem Report (PR)

A problem report is created to document a problem or request a product enhancement. A problem report is created by a registered user of Windchill PDMLink or on behalf of someone outside the system, such as a customer or supplier. The use of a problem report is an optional means to initiate the change process.

Enterprise Change Notice (ECR)

A enterprise change request can be created in response to one or more problem reports or without any reference to a problem report. It details the changes necessary to correct the problem or provide the enhancement so that the appropriate people can make the business decision to proceed with or cancel the proposed change.

Enterprise Change Notice (ECN)

A enterprise change notice represents a work authorization to resolve a problem identified by an approved enterprise change request. It can be created in reference to one or more enterprise change requests. It details the tasks that need to be completed in order for the change to be implemented. It also enables you to assign the tasks to individuals.

Affected Data

The data (such as parts or documents) associated with a particular change object. Usually the part or document is the object that contains the problem or issue being addressed. You add affected data while creating or updating a problem report or enterprise change request.
Tip: Since associations are not propagated from a problem report to the enterprise change request created in response to it, you will need to recreate the associations when you create the enterprise change request.

Affected data added to implementation plan tasks are parts or documents that will be affected by the change. These are added to a task in the implementation plan of an enterprise change notice. Usually these parts or documents are affected when a user completes the assigned task.

**Affected End Items**

Affected end items are the end items associated with a particular change object. Usually the end item is the object which contains the problem or issue being addressed. You add affected end items while creating or updating a problem report or enterprise change request.

Tip: Since associations are not propagated from a problem report to the enterprise change request created in response to it, you will need to recreate the associations when you create the enterprise change request.

**Resulting Items**

Resulting items are parts or documents that result from a change. These are added to a task in the implementation plan of an enterprise change notice. Usually these parts or documents are created as part of the completion of the assigned task.

**Change Process**

**Fast Track (Simple) ECR**

Fast track enterprise change requests have low impact, cost, and overhead and therefore, may be processed more efficiently through the change system. The cost threshold for changes that can be processed using the fast track changes is typically set by company policy. Fast track changes may be implemented without Change Review Board approval or a detailed implementation plan. See Change Management Process for an example of the change process.

Tip: As a general guideline, it is advisable that fast track enterprise change requests make up approximately 80% of the average change requests within an organization.

**Full Track (Complex) ECR**

Full track enterprise change requests are those with a high impact and cost and that require close analysis and review. Full track changes must pass through the Change Review Board prior to implementation. See Change Management Process for an example of the change process.
Change Review Board (CRB)
A Change Review Board reviews and approve, denies, or requests further investigation of an enterprise change request. It is typically composed of representatives from company departments, such as Design Engineering, Manufacturing Engineering, and Quality Assurance.

Change Implementation Board (CIB)
A Change Implementation Board reviews and either approves or denies the implementation plan included in the enterprise change notice.

Pending Change
A pending change is either an unresolved enterprise change request or an incomplete enterprise change notice that will affect the object. This icon appears in the title bar of the information page of any object that has a pending change against it. Click the Associated Changes navigation link on the object information page to view the enterprise change request or enterprise change notice.

Change Process Roles
There are three important process roles with the title of Change Administrator.

Change Administrator I
The first change administrator (Change Admin I), screens the problem reports, reviews the enterprise change request, collects impact information, and communicates the decision to reject the change or implement it in either the fast or full track branches of the change management process. Change Admin I also creates the enterprise change requests from unresolved problem reports. You can search for unresolved problem reports using the reports on the Change Monitor page or from the Problem Reports page of the Change tab.

Change Administrator II
The second change administrator (Change Admin II) is responsible for creating the implementation plan captured in the enterprise change notice. Change Admin II is also responsible for recording the Change Implementation Board’s decision to proceed with the implementation plan.

Change Administrator III
The third change administrator (Change Admin III) acts as an auditor of all of the material related to a change, ensuring that all resulting documentation is clear, concise, and valid.

Change Management Actions and Icons
Throughout Windchill PDMLink, there are several actions associated with change management. The following table lists and describes these actions and any
corresponding buttons, and identifies the location from which each action or icon can be accessed. On pages where there is no button, the actions are available from the actions list. The availability of actions depends on the access control permissions of individual users and the state of the change object.

<table>
<thead>
<tr>
<th>Action</th>
<th>Icon</th>
<th>Description</th>
<th>Location</th>
</tr>
</thead>
</table>
| N/A | ![Icon](image) | Indicates that the change object is a problem report. |  • Overview page / Assignments  
  • Assignments page  
  • Overview page / Updates  
  • Updates page  
  • Search results pages  
  • problem report information page |
| N/A | ![Icon](image) | Indicates that the change object is an enterprise change request. |  • Overview page / Assignments  
  • Assignments page  
  • Overview page / Updates  
  • Updates page  
  • Search results pages  
  • enterprise change request information page |
| N/A | ![Icon](image) | Indicates that the change object is an enterprise change notice. |  • Overview page / Assignments  
  • Assignments page  
  • Overview page / Updates  
  • Updates page  
  • Search results pages  
  • enterprise change notice information page |
<table>
<thead>
<tr>
<th>Action</th>
<th>Icon</th>
<th>Description</th>
<th>Location</th>
</tr>
</thead>
</table>
| Create Problem Report | 🇺🇸  | Opens the Create Problem Report window. The following four tabs are available and each contains a different kind of information for the problem report: Description, Affected Data, Affected End Items, and Attachments. | • Products List page  
• Libraries List page  
• Library information page  
• Product information page  
• End item information page  
• End item instance information page  
• Part information page  
• Document details page |
| Create ECR          | N/A  | Opens the Create ECR window. The following five tabs are available and each contains a different kind of information for the enterprise change request: Description, Affected Data, Affected End Items, Attachments, and Associated Problem Reports. | • Problem report information page  
• Product information page  
• Library information page  
• Document information page  
• Part information page  
• End item information page  
• End item instance information page |
<table>
<thead>
<tr>
<th>Action</th>
<th>Icon</th>
<th>Description</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create ECN</td>
<td>N/A</td>
<td>Opens the Create ECN window. The following four tabs are available and each contains a different kind of information for the enterprise change notice: <strong>Description</strong>, <strong>Attachments</strong>, <strong>Associated ECRs</strong>, and <strong>Implementation Plan</strong>.</td>
<td>• Enterprise change request information page</td>
</tr>
<tr>
<td>Update Problem Report</td>
<td>N/A</td>
<td>Opens the Update Problem Report window which contains the same tabs as those on the create window.</td>
<td>• Problem report information page</td>
</tr>
<tr>
<td>Update ECR</td>
<td>N/A</td>
<td>Opens the Update ECR window which contains the same tabs as those on the create window.</td>
<td>• Enterprise change request information page</td>
</tr>
<tr>
<td>Update ECN</td>
<td>N/A</td>
<td>Opens the Update ECN window which contains the same tabs as those on the create window.</td>
<td>• Enterprise change notice information page</td>
</tr>
<tr>
<td>Action</td>
<td>Icon</td>
<td>Description</td>
<td>Location</td>
</tr>
<tr>
<td>--------------------------</td>
<td>------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Add Affected Data        |      | Allows you to search for data, such as parts, documents, or end items, to add to the problem report, enterprise change request, or enterprise change notice. | • **Affected Data** tab on the Create and Update windows of a problem report or enterprise change request  
  • **Implementation Plan** tab on the Create and Update windows of an enterprise change notice |
| Add Affected End Items   |      | Allows you to search for end items to add to the problem report, enterprise change request, or enterprise change notice. | • **Affected End Items** tab on the Create and Update windows of a problem report or enterprise change request |
| Add Resulting Items      |      | Allows you to search for data, such as parts, documents, or end items, to add to the task of an enterprise change notice. | • **Implementation Plan** tab on the Create and Update windows of an enterprise change notice |
| Add Problem Report       |      | Allows you to search for existing problem reports to add to the enterprise change request. | • **Associated Problem Reports** tab on the Create and Update windows of an enterprise change request |
| Add ECR                  |      | Allows you to search for existing enterprise change requests to add to the enterprise change notice. | • **Associated ECRs** tab on the Create and Update windows of an enterprise change notice |
Managing Change 8-9

Note: Detailed procedures and descriptions of the fields on the Create and Update windows are included in the online help. Click on any window or table to access the corresponding online help.

Accessing and Viewing Change Objects

You can view change objects from the following places within Windchill PDMLink:

- **Assignments** page - displays all of the tasks that have been assigned to you. The seven most recent tasks are displayed in the Assignments table on the Overview page of the Home tab. If a task related to a change object is assigned to you, the task along with a link to the information page of the change object will appear in your assignments list.

- **Updates** page - displays all of the change objects you recently created or modified. The seven objects most recently created or modified by you are displayed in the Updates table on the Overview page of the Home tab.

- The **Change** tab - includes the following three pages which list all of the open change objects to which you have access: Problem Reports, Change Requests, and Change Notices. You can choose to view in the information pages of change objects from these pages.
The Change Monitor page - displays reports concerning the change process and links to all open and resolved change objects. If you are not assigned any tasks but still want to know the status of a particular change object, you can view this information on the Change Monitor page of the Change, Library, or Product tabs. For more information, click the Help button in the upper right corner of the page or see the Change Monitor section later in this chapter.

Search and search results - You can search for change objects using the search functionality which is described in detail in Searching in Windchill PDMLink. You can choose to view the information pages of any returned change objects from the search results list.

Change Management Process

The following is an example of the change management process:

1. A user, who is a team member of a product, creates a problem report from an end item information page.

2. The user assigned to the role of Change Administrator I in this product reviews the problem report and either approves or rejects it.

3. After Change Administrator I confirms the problem report (using a task in their Assignments list), Change Administrator I then writes an enterprise change request, performs an impact analysis, and records the decision for full or fast track implementation.
   - If the enterprise change request follows the fast track, it is immediately sent to Change Administrator II for implementation.
   - If the enterprise change request follows the full track, Change Administrator I convenes the Change Review Board.

4. Change Administrator I records the Change Review Board's decision to either reject or proceed with the implementation of the enterprise change request. Upon approval, the appropriate Change Administrator II is assigned to create the enterprise change notice and the enterprise change notice tasks required to initiate the work of the implementation plan.
   - A full track enterprise change notice requires the approval of the Change Implementation Board prior to any actual work being performed. When approval is given, the work to implement the change may begin.
   - Users assigned to the enterprise change notice tasks are responsible for editing the product data. For each task, the Designated User acts as a reviewer who then checks and approves the work of the assigned users before the task is complete.

5. When all the tasks in the enterprise change notice have been completed, Change Administrator III audits the resulting documentation to be sure it is
clear, concise, and valid, and then approves or requests a rework of the enterprise change notice.
Process Examples

The following figures illustrate the fast and full track processes of an enterprise change request:
ECR Fast Track Process

1. Create the ECR
2. Set State: Under Review
3. Analyze the ECR
   - CA I
   - Decision: Fast Track
4. Set State: Implementation
5. Create ECN
   - CAII
6. Wait on ECN Completion
   - ECN Canceled
   - ECN Resolved
7. Set State of ECR: Resolved
8. Set State of ECR: Canceled
9. End
ECR Full Track Process

1. **Create ECR**
2. **Set State: Under Review**
   - **Analyze ECR**
     - **Decision: Full Track**
     - **Schedule CRB Review**
       - **Record Decision**
       - **Set State: Resolved**
         - **ECN Approved**
         - **ECN Canceled**
         - **Set State: Canceled**

3. **Set State: Implementation**

4. **Create ECN**

5. **Wait on ECN Completion**
   - **ECN Approved**
   - **ECN Canceled**

6. **Set State: Under Review**

7. **Set State: Resolved**

8. **Set State: Canceled**

End
The following figures illustrate the fast and full track processes of an enterprise change notice:
ECN Fast Track Process

Create the ECN

Create appropriate change tasks

Set State: Under Review

Set State: Implementation

Wait on Task Completion

Audit ECN

Rework ECN Tasks

Accepted/Completed

Set all Resulting Items to Released

Set State: Released

Set State: Resolved

End
**ECN Full Track Process**

1. Create the ECN
2. Create appropriate change tasks
3. Set State: Under Review
4. Set State: Implementation
5. Wait on Task Completion
6. Audit ECN
7. Set all Resulting Items to Released
8. Set State: Released
9. Set State: Resolved
10. End

**Flowchart Steps**
- From Create the ECN, to Create appropriate change tasks, then Set State: Under Review.
- From Set State: Under Review, to Schedule CIB Review, with options to Amend, Approved, or Rejected.
- From Schedule CIB Review, to Record Decision, then to Amend ECN Plan (Tasks).
- From Amend ECN Plan (Tasks), to Schedule CIB Review.
- From Schedule CIB Review, to Rework ECN Tasks.
- From Rework ECN Tasks, to Set State: Resolved.
- From Set State: Resolved, to Set State: Released.
- From Set State: Released, to Set State: Canceled.
Change Monitor

The Change Monitor page allows you to gauge and monitor the status of the change objects (problem reports, enterprise change requests, and enterprise change notices) within your system. You can also view special reports as well as access all open and resolved problem reports, enterprise change requests, and enterprise change notices.

The Change Monitor page is available from the Product, Library, and Change tabs. When accessed from the Product or Library tabs, the scope is automatically restricted to the product or library being viewed and, therefore, only the relevant data is returned. When accessed from the Change tab, you can set the scope of the reports using the list of available scope options.

For more detailed information about the Change Monitor, see the online help. You can access the online help by clicking Help at the top of the Windchill PDMLink window.

The following information summarizes the charts and reports available from this page.

Note: The Change Monitor only displays those change objects which belong to products and libraries of which you are a team member.

Charts

For each of the change objects, charts display information comparing the number of opened change objects to the number closed for each month during the last three months.

Below each chart is a link to all of the open change objects. For example, under the Problem Reports chart, the link is Open Problem Reports. The link displays a page listing all of the change objects which have not yet been resolved during the specific time period. The objects are organized by their creation date.

Also under each chart, the Average Days Open states the average number of days between the opening of a change object and its resolution. This information allows you to estimate how long it will be before a newly created change object is resolved.

Full Track vs. Fast Track Changes

This chart displays the percentages of enterprise change requests that are assigned as full track or fast track and those that have not yet been assigned a track.

All Special Reports

Under this heading, links appear for the different reports available concerning the change management system. This list may differ depending on the access control permissions set by your system administrator. The following list includes some of the out-of-the-box reports Windchill PDMLink provides:
• Average Problem Report Completion Time (Current Context)
• Average ECR Completion Time (Current Context)
• Average ECN Completion Time (Current Context)
• Average Problem Report Completion Time (Entire System)
• Average ECR Completion Time (Entire System)
• Average ECN Completion Time (Entire System)

**Note:** Customized reports can be generated using the Report Manager. For administrators, see the *Windchill Application Developer’s Guide* or the *Windchill Customizer’s Guide* for information on generating and storing these reports so that they can be viewed on the **Change Monitor** page.
This chapter discusses the visualization features available in Windchill PDMLink.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview .............................................</td>
<td>9-2</td>
</tr>
<tr>
<td>Accessing Visualization ................................</td>
<td>9-2</td>
</tr>
<tr>
<td>ProductView Features ..................................</td>
<td>9-5</td>
</tr>
<tr>
<td>Publishing Visualization Data to Windchill ........</td>
<td>9-8</td>
</tr>
<tr>
<td>Setting Preferences ...................................</td>
<td>9-9</td>
</tr>
</tbody>
</table>
Overview

ProductView, the Windchill visualization tool, allows users to view data from a variety of sources without requiring access to the application that created the data. Users can analyze the product design, annotate files to indicate review comments, obtain information about parts of a product structure, and collaborate dynamically with others regarding design or document content.

ProductView allows you to view and annotate 3D models, 2D drawings, documents, images, and ECAD files. In addition, you can measure and analyze 3D data, which can come from a variety of different CAD systems. The viewable data is stored in Windchill as a compact representation. Each representation can have markups associated, and ProductView allows users to view, edit, and save this information back to Windchill.

The default viewer for Windchill solutions is a lightweight visualization tool called ProductView Lite Edition, which is described in this chapter. ProductView Standard Edition, an additional option available for purchase, provides expanded visualization functionality beyond the capabilities of ProductView Lite Edition.

When you first choose to visualize data from Windchill, the ProductView Lite Edition viewer is installed automatically.

Accessing Visualization

Windchill provides compressed, viewable representations of product data, which are displayed as thumbnails. Thumbnails provide a high-level glance at the data. You can view the thumbnail image and, for 3D data, you can spin it to change the viewpoint. To visualize the data in more detail, click the thumbnail to launch ProductView.

There are several ways to access ProductView from Windchill:

- Part details page (also called properties page).

To access this page, from the Folders tab, click beside a file name. The Details page displays a 3D thumbnail of the part. You can click the thumbnail to display the part in ProductView.
• **Search Results** table: In the upper right corner of the main page in Windchill, you see the search tools. You can use these tools to search and display a **Search Results** table, shown below. The **Actions** column of this table contains various icons for performing tasks. You can click the **View in ProductView** icon to launch ProductView, where you can visualize the part. For more information on searching, see **Searching in Windchill PDMLink**.

![Search Results Table](image)

• **Folders view** (Windchill PDMLink and Windchill ProjectLink only): In the **Folders** table, the part name is hyperlinked. Click this link to open the part in ProductView.
Visualization Collection: The Visualization Collection allows you to combine different data sets into one viewable representation for the current browser session. You can create a representation of a part or document based on the current contents of the Visualization Collection. You can combine different data types, such as a drawing and a model, or you can combine the same data types to view the result.

To display the Visualization Collection, click the icon directly beneath the thumbnail area on the details/properties page.

In the Visualization Collection, you can click View All to combine all of the listed data sets and view them as one representation in ProductView. You can also click individual thumbnails in the Visualization Collection to open ProductView.
• **Representations** table: On the part details/properties page, directly below the thumbnail area, you can click the third icon to display the **Representations** table. In this table, you can click a thumbnail image to launch ProductView and visualize that part.

Or, if you want to upload data from your local machine to Windchill to create a representation, you can click **Create Representation** at the top of the **Representations** table. This creates a thumbnail and adds the data to the **Representations** table, as shown in the graphic below:

In addition to 3D parts, you can also visualize documents, drawings, images, and ECAD data.

**Note:** To view documents in ProductView, you must purchase and install the Document Collaboration option. To view ECAD printed circuit boards and schematics in ProductView, you must purchase and install the ECAD Viewing option.

**ProductView Features**

ProductView provides the following basic features:

- Viewing
- Navigation
- Annotation
- Measurement

These features are described next. For detailed descriptions of a feature, refer to the ProductView online help.

**Viewing Data**

ProductView lets you visualize product data. You can open a 3D assembly in the viewer. You can also view documents, images, drawings, and ECAD files associated with a product structure. All of these files open in a view window that provides various visualization features.
When viewing 3D data, you can click to select and move components in the view. This is called translating the component. You might do this to examine individual components, or to temporarily move them out of the way if they are obscuring the view of other components. You can also spin or rotate components to view them from different perspectives. To do this, you toggle between translation and rotation modes using buttons on the toolbar.

You can show or hide components in the viewer. In addition, you can specify the rendering of 3D components as shaded, wireframe, or hidden lines removed.

All of these visualization features allow you to control your view of the data, and are explained in detail in the ProductView online help.

**Navigating ProductView**

You can use the mouse and keyboard to easily navigate in ProductView. There are two navigation modes: fly-through and inspection.

- *Fly-through* allows you to interactively fly around a 3D component to view that object from different depths and angles. You can think of this like moving your head, where a slide to the left moves the head to the left, with the object in the view moving to the right. You use the middle mouse button (or ALT + right mouse button for a two-button mouse) to fly.

- *Inspection* is like holding an object in your hand and viewing it from different angles. You use the right mouse button to spin the viewed object.

You can use switch navigation modes during fly-through or inspection by using the following mouse and keyboard combinations. Note that the ALT key is used to access certain navigation features when you have a two-button mouse.

<table>
<thead>
<tr>
<th>Mouse Button</th>
<th>Default Mode</th>
<th>+ Shift</th>
<th>+Ctrl</th>
<th>+ ALT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left</td>
<td>Select</td>
<td>Let's you select components or specify a translation or rotation grab handle.</td>
<td>Multi-select</td>
<td>N/A</td>
</tr>
<tr>
<td>Right</td>
<td>Spin</td>
<td>Zoom</td>
<td>Pan</td>
<td>Fly (two-button mouse)</td>
</tr>
<tr>
<td>Middle</td>
<td>Fly</td>
<td>Pitch</td>
<td>Slide</td>
<td>Spin (two-button mouse)</td>
</tr>
</tbody>
</table>
• In pan mode, the object moves in the same direction as the mouse.
• In zoom mode, move the mouse down to zoom in and mouse up to zoom out.
• In fly mode, you move the mouse to change the view direction, moving the mouse up to fly forward, and down to zoom out or fly away in the view.
• In slide mode, the mouse movement implies a change in position to the view, not the object.
• Fly and slide are differential, meaning that the further you move the mouse, the faster the change in viewpoint. The camera continues to move until the mouse button is released or returned to the original position where the button was pressed.
• For translation, you can use the SHIFT key to set a grab point, which lets you zoom in for precise movement. When you set the grab point, translation moves to that point and you see the arrows used to move the component when you zoom in.
• Holding the SHIFT key while moving the mouse (without pressing any mouse buttons) displays information on the part under the cursor. In select mode, this highlights the object bounding box. In measurement mode, it highlights features available to measure.

**Annotating Files**

ProductView provides the ability to view and create annotations for all file types. You can use annotation to insert text comments and draw shapes in the view to highlight specific items, as needed.

Annotation sets appear as thumbnails along the left side of the ProductView Lite Edition window. Click a thumbnail in the annotation list to load that annotation set into the viewer.

Use the various annotation toolbar buttons to create annotations, such as note, line, or circle. Annotation toolbar commands vary based on the type of file you are viewing. When you have created an annotation, you can select that item and choose **Annotation Properties** to change the appearance of the annotation. When you are finished, you can upload the annotation set or markup to the server.

ProductView also provides expanded document annotation tools for PDF files, if you have the Document Collaboration Option installed. For example, you can highlight text, or track and reply to comments. These features allow you to manage collaborative, interactive reviews of PDF files.

**Measuring Dimensions and Distance**

ProductView provides powerful tools for measuring dimensions or distance between 3D parts. When measurement mode is active, you can hover the mouse over items in the view to highlight faces and curves that are available for measurement, then click to select the item or items you want to measure.
To take a measurement, you first activate measurement mode by selecting **Distance** or **Dimension**, depending on the type of measurement you want to take. Double-click to select components for measurement, and single-click to select surfaces.

When measurement mode is active, items available for measurement are highlighted as you move the mouse pointer over the view. For curves or lines, the end, middle, and center points are highlighted for selection. Faces are also highlighted when measuring 3D models. You can also measure angles using this feature (see distance measurement).

- **Dimension measurement**: Click any highlighted item in the view to display the dimensions for that object. Double-click to measure the dimensions of component, and single-click to measure a surface. Dimensions appear in a label callout. For example, you can click on a cylinder to display the height, radius, and area. Or, you can click on an arc to display the length and radius.

- **Distance measurement**: You can measure the distance between two components or surfaces. Double-click to select components, and single-click to select surfaces. If you want to measure a third item, such as a three point angle, press CTRL before the second mouse pick, and pick the second and third points to include in the measurement. By default, distance measurement is based on two mouse clicks.

**Note:** Any distance measurement that is not a specific point-to-point measurement will be minimum distance.

**Publishing Visualization Data to Windchill**

Most viewable data comes from managed CAD data; however, you can add visualization data, such as prepublished viewables, drawings, or EDZ files, directly into Windchill from your hard disk using the **Representations** table.

To do this, go to the details/properties page for a part and click the **View Representations** icon which appears directly under the 3D thumbnail area. This displays the **Representations** table. In this table, you can click **Create Representation** to upload the data to Windchill and create a thumbnail of the data.

When you submit a representation to be created in Windchill, the **Publish Monitor** dialog box displays the status of your published data in Windchill.

In order to publish documents, you must have the Document Collaboration Services option installed on the server. If you have this option installed, you can upload a Microsoft Word document or Microsoft Excel spreadsheet and automatically publish this file to PDF. In order to view or annotate the published PDF document, you must have the Document Collaboration Option installed.
Setting Preferences

You can set preferences for visualizing data in Windchill. To do this, click the Utilities link on the Home tab. From the Utilities page, you can click the Preferences link to view and set preferences. The preference tab, called Visualization, is shown next, followed by descriptions of the options:

- **Thumbnail Display in Search Results**: You can choose to display thumbnail images in the search results for viewable files. Search results load more quickly if thumbnail images are not displayed. The default is to not display thumbnails in search results.

- **Thumbnail Display on Properties Pages** (also called Details pages): You can choose to display thumbnail images on details pages for viewable files. Details pages load more quickly if thumbnail images are not displayed. The default is to not display thumbnails on details pages.

- **Loading ProductView Data**: Choose how to load files from Windchill into ProductView. You can load all related files as a single EDZ file, which is best for viewing a large assembly. Or, you can choose to load files on an as-needed basis, which is best for viewing a small assembly or pieces of a large assembly. The default is to load files as needed.

- **Tool Tips Display**: Choose whether or not to display tool tips on the visualization pages when the mouse cursor is over an icon. Tool tips are not available for the Publish Monitor page. The default is to display tool tips on visualization pages.

- **Select Viewing Tool**: Choose to use either ProductView Standard Edition or ProductView Lite Edition as the visualization client. ProductView Lite Edition is the default.
- **Visualization Collection**: Choose whether to make the Visualization Collection available for use. The Visualization Collection allows Windchill items to be copied to ProductView.

**Tip**: You can use the **Related Preferences** box, which is highlighted in the graphic shown below, to quickly open a different visualization preferences page.

You can also set preferences within ProductView Lite Edition. For more information, refer to the ProductView Lite Edition online help.
If your site has installed Windchill Foundation & PDM or Windchill PDMLink and Windchill ProjectLink on a single server, you are able to share and exchange information between your PDM system and a project. As a result, you can more easily collaborate with others, both within and outside of your department or your company.

**Topic** | **Page**
--- | ---
Overview | 10-2
Making PDM Data Available to Your Project Team | 10-3
Examining a Usage Scenario | 10-11
Overview

When you are working with integrated Windchill solutions, you can take advantage of common project and program management activities, such as the following:

• You can share data from your PDM system to a project within Windchill ProjectLink. As a result, you can collaborate on the information within the context of a project, where your team’s work can be managed through the use of milestones, deliverables, and resource tracking.

• You can copy or check out design information from the PDM system to a project so that you and others can investigate design possibilities without committing your changes to formal PDM control. If you decide to make your new design or design changes part of your formal change process, you can check parts, documents, and CAD documents back into the PDM system and, if desired, use Windchill ESI to publish them to your ERP system.

• You can invite external participants to join your project, as project team members, without giving them access to your company’s PDM system. For example, if you are collaborating on a new product design, you could invite an engineer from a supplier’s company to participate in collaborative design work to be applied to PDM objects checked out to a project, without giving that engineer access to other PDM data or to your PDM system.

This chapter consists of an extended scenario that illustrates the way in which you and others on your team can use multiple Windchill solutions to make modifications to an existing product. The scenario includes a number of common product development tasks performed by users in a variety of roles. For purposes of demonstration, this extended example assumes that you are the team member assigned to each role and task that is part of the scenario.

Of course, your product data and teams may be significantly more complex than those used in this example, but the principles demonstrated can also be applied to products and projects of greater scope and complexity.

In this scenario, your product team has been asked to create a new product (AL-Bulldozer) from an existing Bulldozer design. The scenario is organized around six tasks:

• **Task 1** - The Engineering Manager creates the new Bulldozer product from the existing Bulldozer design. At the same time, the manager creates the Enterprise Change Request (ECR) and the Enterprise Change Notice (ECN) for the necessary design changes, and assigns the specific activities that must be performed in order to complete the design modifications.

  This task highlights the Save As capabilities and CMII change process available in Windchill.

• **Task 2** - Engineer1 creates a project to coordinate the activities associated with the removal of the bulldozer blade.
This task illustrates how you or another member of your team can use Windchill ProjectLink to create a collaborative environment for design changes that involve multiple users or organizations.

- **Task 3** – A Supplier is given access to information contained within the project in order to make design modifications to the bulldozer bucket.

  As shown through this task, your suppliers and customers can be granted access to select information controlled by your PDM system, without being granted direct access to the PDM system itself.

- **Task 4** - Engineer2 modifies the Bulldozer design in Windchill PDMLink, based on the ECN assignment. In this scenario, the ECN calls for modification of the bulldozer toolbox and seat.

  This task demonstrates the CMII change process from an end-user prospective.

- **Task 5** - Engineer1 updates the Bulldozer design in the project and completes the removal of the bulldozer blade.

  This task shows how, as a member of a collaborative project, you are kept aware of relevant design activities occurring outside of your project. When desired, you can update the information you are referencing to include the latest design changes.

- **Task 6** - The Engineering Manager approves all of the design changes at the completion of the design process. As a result, the updated information is automatically published to an ERP system.

  This task demonstrates how design work that you and your team complete in an independent, collaborative environment can be incorporated into your company’s formal change process. It also highlights the way in which Windchill ESI allows Windchill solutions to interoperate seamlessly with ERP systems.

### Making PDM Data Available to Your Project Team

When your site has installed multiple Windchill solutions on a server, you can use Windchill’s clipboard mechanism to share or check out data from a product or library in your PDM system to a project (or from one project to another).

A simple way to move an object is to apply the **Cut**, **Copy**, and **Paste** actions. Both **Cut** and **Copy** move selected objects to the Windchill clipboard; the **Paste** operation determines whether the object will be duplicated, moved, shared, or checked out, based on the icon you select.

For example, within a product, library, or project, you can **Cut** one or more selected objects. The **Cut** operation moves an object from its current location to the clipboard. In order to complete the move, you can then **Paste** the object to a selected folder location.
Within a product, library, or project, you can also use the **Copy** and **Paste** icons to create a new copy of a selected object and either paste a copy of the original item to the selected location or, as described in the following section, paste the object as a shared item:

**Tip:** When you complete a *Copy/Paste* operation within the context of a product, you have essentially completed a *Save As* operation. This operation is not valid for CAD documents.

### Sharing PDM Objects to a Project

The **Copy/Paste** icons and the **Add to Project** action can also be used to share or check out an object from a product or library to a project, or to create a new copy.
of a document or part stored in your PDM system and locate that document or part within a project:

When you share a part, document, or CAD document to a project, all project members have implicit read access. The primary use for a share operation is to provide a project team with read access to selected PDM objects, for purposes of reference. You can also use the Windchill clipboard to initiate sharing of other information, including problem reports, change requests, change notices, product configurations, product instances, and baselines, but these shared objects are accessible only to project team members who have read access to the object in its source location.

**Tip:** Sharing a PDM object version to a project is essentially the same as creating a shortcut to the object within the project. The object continues to reside within the PDM system, but project members can easily view it without having access to your PDM system.

A PDM object can be shared to several projects at the same time. While an object is being shared, it is still subject to modification in the PDM system. As described in Refreshing a Project, you can choose at any time to update your project with the latest iterations of each shared object.

Sharing is especially useful when you do not want to add members of other projects or products to the team in which a document or part was created. For example, you may want to share a design specification document or part prototype design with a manufacturing line team, within the context of a collaborative project, without adding the manufacturing members to the product team. In effect,
sharing allows project members to access only the subset of PDM objects required to complete the work assigned to the project.

From among the list of operations you can perform within a project, the following can be applied to an object you have shared to the project:

- **Details** – View the information page for the selected object. For a PDM object shared to a project, the details page for the object will be displayed from within the PDM system.

- **View** – For documents, view the document content file.

- **Subscribe** – Request e-mail notification when certain events or actions are applied to the selected object.

- **Discuss** – Open the Discussion page to discuss topics related to the object.

- **Add to Notebook** – Add a link to this object in your Notebook.

- **Convert to PDM Checkout** – For one or more parts, documents, or CAD documents that have been shared to a project, check out the shared objects from the PDM database to the project. As shown in the following illustration, the details page for a shared object that has been converted to a checked-out object indicates that the item is checked out from the PDM system to the project:

  ![Illustration of a checked-out object](image)

  This action cannot be applied to objects that are shared from one project to another, or to problem reports, change requests, change notices, product configurations, product instances, and baselines that have been shared from your PDM system. Your role and your access permissions also determine whether or not this action is available to you; for example, you cannot use the **Convert to PDM Checkout** action on an object to which you do not have update access in the PDM system.
Tip: When you convert a shared object to a checked-out object, the latest iteration of the object is checked out to the project. In some cases, this may not be the iteration that was originally shared.

- **Remove Share** – Remove the shared object from the project.

### Refreshing a Project

Sometimes, a PDM object may be updated within the PDM system after you have shared it to your project. You can use the **Refresh Project** icon to display a list of the latest iterations for all shared objects within a project. You can then select the objects to be updated through a download of their most current iterations.

Tip: Only the project manager is allowed to refresh a project.

When you refresh a project, the new iteration for a given object may have children that were not part of the iteration originally shared. Therefore, the **Refresh Project** window includes filtering options that allow you to control the content of the table that displays the refresh candidates. When you are refreshing a project that includes a large number of PDM objects, you can either select all of the objects to be refreshed and click the **Set Refresh** icon, or select only the objects that are not to be refreshed and then click the **Set Exclude** icon:

Tip: When an object is shared, the share link always points to the latest iteration of the object version in the PDM system. Your project, however, tracks the iteration that was initially shared or was downloaded as the result of a **Refresh Project** operation. For example, even if a share link points to object A.2 (the second, and latest, iteration of version A of the object), the project will track
object A.1, if iteration 1 of version A was the object originally shared or most recently downloaded.

Checking Out PDM Objects to a Project

When you use the Copy/Paste icons or the Add to Project action to check out, copy, or share a PDM object to a project, you first select the new location for the object. The following illustration shows how project location is specified when you select the Add to Project action:

Next, you choose whether to share the object or check it out to the project; in this example, the Selected Action is Share:
As previously described, sharing an object provides project team members with read-only access to the original object. When you check out one or more parts, documents, or CAD documents from your PDM system to a project (or convert a shared object to a checked-out object), project-specific versions of those objects are created within your project. These project-specific versions can be modified by project team members, and the objects are locked in the PDM system to avoid concurrent modification and prevent synchronization problems.

You can also use the Copy/Paste or Add to Project functionality to create new parts and documents, with unique name and number attributes, within a project:
When the copy is later checked in, it does not affect the original part or document. However, when a checked-out part, document, or CAD document is checked in, the check-in operation creates a new iteration of the original object.

Your project team can work with PDM objects checked out to the project as follows:

- Modify existing parts, documents, and CAD documents
- Create new parts, documents, and CAD documents
- Edit and change structures during the project design collaboration
- Reconcile all or a subset of the changes with the source PDM system by using the **Send to PDM** action.

**Note:** CAD documents can be easily viewed and modified in a workspace you create within the context of a project. However, CAD documents that have been published by the Pro/INTRALINK Gateway cannot be checked out to a project.

Modifications to objects checked out from your PDM system are only visible to project team members, within the context of the project.
Using Actions and Icons

When you share or check out PDM objects to a project, the actions and icons available to you, as well as the results of the actions you apply, are based on the following object characteristics:

- The results of an action are determined by the type of the object you have selected. For example, when you create an object, the list of templates you can use for object creation is different for parts than for documents. Similarly, a change object can be shared to a project, but it cannot be checked out to a project, nor can a share relationship to a change object be converted to a PDM checkout.

- Actions differ based on whether an object is native to the current context, has been checked out to the current context, or has been shared. For example, if you are working in a project and you apply the **Delete** action to a part created within that project (a native object), the part is removed from the project. If you **Delete** a part shared to the project from your PDM system, the action simply removes the share. If you apply a **Delete** action to a part checked out to the project from your PDM system, the action un-does the checkout and removes the object from the project. When you are working in your PDM system and apply **Delete** to a selected object, that iteration is removed from the PDM database.

- The actions and icons available to you when you have selected a specific object are determined by your access permissions to that object. For example, you must have read access to a PDM object in its source location in order to view it from within a project. Similarly, you must have update access to a PDM object within the PDM system in order to check it out to a project or to convert it to a checked-out object when it has been shared.

  You can also configure product and project spaces so that objects cannot be shared outside of that space. In this way, you can determine how broadly to share information by removing share privileges on all or selected objects, as appropriate.

Examining a Usage Scenario

The following scenario demonstrates how you might accomplish a number of product development activities necessary to complete a new product design (AL-Bulldozer), using Windchill design collaboration capabilities. As noted above, for ease of demonstration, these examples assume that you are assigned each of the roles and are completing each of the tasks described.

Setting Up Your Environment for This Scenario

If desired, you can install the Pro/ENGINEER Wildfire assemblies and other product data described in this chapter and execute the described procedures on your system.
The data files and specific setup instructions are located in the Windchill\loadFiles\BullDozerDemoData directory. You should also consult the Read This First document for any additional installation instructions.

**Task 1. Creating a Product From an Existing Product**

For purposes of this scenario task, assume that you have been assigned the Engineering Manager role on your product team, and that your team will create a new Bulldozer product from an existing Bulldozer product, reusing existing data in order to reduce costs. After the new product has been created, you will assign the tasks necessary for modification of the Bulldozer design.

**Step 1. Creating a New Product and Making Work Assignments**

The following steps illustrate new product creation:

1. First, you must log on to Windchill, using the user ID and password associated with the Engineering Manager role. Whether or not this is your actual job title, it is the role to which you have been assigned on the product team. When you log on, Windchill recognizes your association with the Engineering Manager role, and grants you the access permissions associated with that role when you are working within the context of your team’s product.

   Whenever you log on, Windchill opens to the last location you visited before exiting the system. If your home page is not displayed when you log on, you can select the **Home** tab to navigate there. Your home page displays your current task assignments, the objects you have recently updated, and any objects that you have checked out.

2. Select the **Product** tab to display a list of products that you are authorized to access.

   **Tip:** Windchill has *stickiness* capabilities that allow you to navigate among tabs and menus, and then quickly return to the area in which you were previously working. In this case, if the **Product** tab did not open to a list of products because of a previous navigation, you could select the **Products List** menu to display the list.

3. Click the **Create Product** icon at the top of the **Products** table.

4. In the **Create Product** window, enter a product name (for example, AL-Bulldozer) and a product number (for example, AL-PDM-100-0001), and then click **OK**.
You have now created a new product container that will hold all of the information related to your new Bulldozer design, and a product object that will represent the end item of your product structure.

Step 2. Adding Members to the Product Team

The following steps demonstrate how you can identify the users who are authorized to access your product:

1. To see information for a specific product, select the Product tab, the Products List menu, and the desired product (in this case, AL-Bulldozer) from the list of products. This allows you to view product information on the AL-Bulldozer details page.

2. From the product details page, click the Team link (below the tabs) in order to add team members. Windchill displays the list of roles and associated team members predefined in the product template that was used to create the product.

3. Add Engineer1 and Engineer2 as members of the product team.
   a. If the Member role is not currently defined for the product, select the Add Roles action from the top of the table, select Member from the list of roles, and click OK to add the role.
   b. Select Add Members from the drop-down menu next to the Member role. Search for the users (in this case, Engineer1 and Engineer2) to add to the role.
   c. Click OK to add the users.

Engineer1 and Engineer2 have now been added as members of the product team.
4. Add the Engineering Manager as Change Administrator I, Change Administrator II, and Change Administrator III
   
a. If the Change Admin I, Change Admin II, and Change Admin III roles are not currently defined for the product, select the Add Roles action from the Actions list at the top of the table, select Change Admin I from the list of roles, and click OK to add the role. Repeat this operation for Change Admin II and Change Admin III.
   
b. Select Add Members from the drop-down menu next to the Change Admin I role. Search for the user or users (in this case, Engineering Manager) to add to the role. Repeat this operation for Change Admin II and Change Admin III.
   
c. Click OK to add the users.
   
The Engineering Manager has now been added to the Change Administrator I, II, and III roles within the product team.

**Step 3. Creating an Assembly From an Existing Assembly**

After the new AL-Bulldozer product has been created, you can copy the parts and associated CAD documents to be modified for the new design from the original Bulldozer product. As a result, the new AL-Bulldozer product will contain only the parts and assemblies that are actually being modified and will reference the remainder of the design from the original Bulldozer product.

In a number of cases, the easiest way to create a design from an existing one is to use the Save As capabilities in Windchill. The following steps demonstrate how this is done:

1. From the Product tab, click the Products List link.
2. Within the product list, select the Bulldozer product.
3. Click the Product Structure menu to display the original Bulldozer product (PDM-100-0001) and its components.
4. Select the Bulldozer product from the table, and use the Show Documents action to display the associated CAD documents.
5. Click the (information) icon for the associated CAD document (PDM-100-0001.asm) to navigate to the details page for the assembly.
6. On the details page for CAD document PDM-100-0001.asm, select the Save As action from the drop-down menu. You can then use the Save As window to identify the parts within the assembly structure that are to be copied to the new AL-Bulldozer product.

**Tip:** Selecting the Save-As action from the CAD document details page allows you to copy an entire or partial CAD document structure and its associated parts to a new structure with new names and numbers. With a
Copy/Paste operation, you can copy individual parts and documents, assigning them new names and numbers.

7. The first step in the Save As process itself is to identify the dependent information to be included in the Save As operation. In this way, you ensure that all existing part and document relationships are maintained. For purposes of this scenario, you would make the following selections from the Rules section of the Save As window:

- **Configuration Specification = Latest.** When you set the Configuration Specification field to Latest, you indicate that you want to use the latest available configuration of the assembly. You can use other Configuration Specification settings to select previously stored baselines or checked-in configurations.

- **Dependency Type Processing = CAD Document Centric.** This field indicates whether the CAD document or the part structure is to be used for determining the configuration. By selecting CAD Document Centric, you specify that the CAD document structure is to be used for this purpose.

- **Baseline For Docs, Baseline for Parts.** These fields identify the baseline name that should be used if the Configuration Specification field is set to Baseline.

- **Include Dependents = Required.** This field is used to identify the dependent objects that are to be included in the configuration. When you select Required, only the objects necessary to regenerate the assembly are included. The All option includes every object that has a relationship to the assembly. The None option includes only the assembly itself.

- **Include Parts = All.** When you set this field to All, you include all Windchill parts to which the CAD documents are associated. The Selected option includes only the parts for objects selected in the table. If you specify None, no Windchill parts are included.

- **Include Drawings = None.** This field allows you to indicate whether the CAD drawings associated with the assembly and its dependents should be included in the configuration. In this example, the None option indicates that no CAD drawings are to be included.

- **Include Instances = All.** This field allows you to specify whether or not Pro/ENGINEER family table instances should be included in the configuration.
After these fields have been set, click **Refresh Object List** to update the **Object List** table.

8. The second step of the Save As process is to identify the parts and CAD documents to be modified and reused in the new design.

   **Tip:** When your team needs to modify only a small portion of an existing configuration, as in this example, it is easiest to first mark all the parts and CAD documents as reused, and then rename only the objects to be modified and copied to the new design.

   To perform this task, select the **All** check box in the table (if all objects are not currently selected). After you select **All**, a checkmark appears in the check box for each object. Next, select the **Reuse** action at the top of the table.

   Now, you can select the items to be copied to the new design from the table:

   - The Bulldozer assembly (in this example, PDM-100-0001.asm); for purposes of this scenario, you would **not** copy the product associated to the Bulldozer assembly, because the AL-Bulldozer assembly will later be associated with the AL-Bulldozer product.
   - The Frame assembly to which the toolbox belongs (in this example, PDM-100-0003.asm) and the part associated to it.
Using Integrated Windchill Capabilities

10. In the Save As window, reselect the items you selected in Step 8 and then select the Location action. For this example, you would select the AL-Bulldozer product and a subfolder, if desired, as the location for the Save As operation. Click OK and verify that the new location of the items is the desired product (in this case, AL-Bulldozer).

Tip: Use the Current View drop-down menu to manage table content, restricting the list of objects displayed to those meeting the criterion you have chosen.

11. Click OK at the bottom of the Object List table. The objects involved in the Save As process are then copied to the new product, with their new names and numbers. Windchill displays a status message to let you know that the Save As operation was successful.

Step 4. Associating the Top-Level Assembly to the Product

After the parts and associated CAD documents to be modified for your new design have been copied to the new product, the following illustrates how the top-level CAD assembly is associated with that product:

1. In order to associate the top-level CAD assembly with the product, you must create a workspace in the context of the product.

   a. On the Product tab, select the product (AL-Bulldozer) from the Product List in order to navigate to the product details page.

   b. Select Create Workspace from the Workspaces menu.

2. Select the top-level assembly (e.g., PDM-010-0007.asm) from the list of components.

3. Click the arrow button next to the assembly to move it to the workspace list.

4. Click OK to complete the workspace creation and association.

Tip: You can also use the Current View drop-down menu to manage table content and restrict the list of objects displayed to those meeting the criterion you have chosen.

5. Verify that the top-level assembly is now associated with the product in the workspace list.

6. Save the changes to the workspace to finalize the association.
c. Enter a name for the workspace and ensure that the context is set to the desired product (AL-Bulldozer).

**Tip:** A workspace name cannot contain any special characters.

d. Click **OK** to create the workspace.

2. From the **Folders** menu, select the appropriate folder (if it was defined during the Save As operation) to navigate to the top-level CAD assembly to be associated with the product.

**Tip:** To improve navigation efficiency and performance, Windchill has implemented table views that allow the filtered display of object types. To view only the CAD documents contained within a folder, select **CAD Documents** from the **Current View** drop-down menu (located at the top of the table).

3. Click the 📝 (information) icon or select **Details** from the **Actions** list for the desired CAD document (in this case, AL-Bulldozer) in order to access the object’s details page.

This is the top-level assembly that will be associated with your new product.

4. Select **Associate** from the drop-down menu on the CAD document details page.

5. You must now search for the product that will be associated to the CAD document. Select **Product** as the object type in the **Search for** drop-down menu, and then click **Search**.

**Tip:** Selecting an object type from the **Search for** menu constrains the search results to that object type, improving search performance.

6. Enter the **Name** or **Number** of your new product (in this case, AL-Bulldozer) and click **Search**.

7. Select your product from the list of search results and click **OK**. Windchill then returns to the **Associate** page, with your product selected.

8. On the **Associate** page, ensure that the **Active Link** for the product (AL-Bulldozer) is set to the correct CAD document (AL-PDM-100-0001.asm) and then click **OK**. The top-level CAD assembly is now associated to your new product.
During the associate process, the CAD assembly was checked out to the workspace you created. In order to complete this task, you must check the assembly back into the product, as follows:

a. In the CAD document details page for the top-level assembly (in this case, AL-Bulldozer), select **Check In** from the drop-down menu.

b. In the check-in window, select the top-level assembly and select **Include Parts/Docs**. Both the product and the CAD document will be listed.

c. Click **OK**.

Your new product and its top-level assembly are now checked into the appropriate product context and are associated. To verify the association, go to the details page for the product and click the **Product Structure** link. Select the product (in this case, AL-Bulldozer) and the **Show Documents** menu at the top of the table. The top-level assembly (in this example, AL-Bulldozer) should be listed as an associated CAD document.

**Step 5. Creating Work Assignments for Product Modifications**

As the Engineering Manager for this task, you must next create an Enterprise Change Request (ECR) and an associated Enterprise Change Notice (ECN) for the modifications to be applied to the new design. For purposes of this example, you
will use the Windchill PDMLink CMII closed-looped process to manage the change process. The following illustrations show the workflow for this process.

To minimize the number of users necessary to complete the change process, assume that, as the user assigned the Engineering Manager role, you have also been assigned the Change Administrator I, Change Administrator II, and Change Administrator III roles. Consequently, the following example illustrates execution of the CMII fast track change process without including separate logins for multiple user IDs.

1. From the home page, search for the new AL-Bulldozer product and select it from the search results by clicking on the name link. This displays the details page for the product.
Tip: There are two levels of searching available in Windchill. In the lower right corner of the global page header, you can click the Search link to initiate a search of the entire Windchill system. In addition, various Windchill pages include a search capability that allows you to search within the specific context of the page. Either search mechanism may be used for this step.

2. From the drop-down Actions list, select Create an ECR.

3. Fill in the ECR form with the following information. Fields beginning with an asterisk (*) are required values:
   a. Assign an ECR name (in this example, Change to new bulldozer).
   b. Select an ECR classification (in this example, Cost Reduction).
   c. Provide an ECR description.
   d. Assign a Priority level.
   e. Go to the Affected Data tab to add the top-level bulldozer assembly.
      i. Select the Add Affected Data action.
      ii. Select CAD Documents from the drop-down menu on the search page.
      iii. For purposes of this example, search for items with the name AL-PDM*.
iv. Select the top-level assembly AL-PDM-100-0001.asm from the search results.

v. If the AL-Bulldozer product is contained in the list, select and remove it.

f. Return to the Description tab, select Now for the Submit value, and click OK.

For purposes of this scenario, assume that you have also been assigned the change administrator role for each phase of the CMII change process. To complete the first step of the change process, the ECR change administrator must analyze the request and determine what action should be taken.

1. To analyze and define the ECR activity, navigate to the Home tab and, from the Assignments table, select the Analyze ECR item with a Subject that matches the name you assigned to the ECR.

2. On the Analyze ECR page, review the ECR and select Fast Track as the action to be taken. Click Task Complete.

The ECR analysis task is now complete, and the ECR has been routed to Change Administrator II (CAII) for the creation of the ECN. For purposes of this scenario, assume that you have been assigned the CAII role as well, and that you will create the ECN, as follows.

1. To view the Create ECN task, navigate to the Home tab (you may need to refresh the page in your Web browser). From the Assignments table, select the Create ECN task with a Subject that has the same name as the ECR.

2. Follow the instructions on the Create ECN page to complete the task:
a. Select the URL to navigate to the ECR.
b. Select **Create ECN** from the drop-down menu on the ECR details page.
c. Enter a **Name**, **Description**, and **Due Date** on the ECN form.

3. Assign the three tasks that must be performed to complete the ECN.
   - Task 1: Removal of the Blade by Engineer 1
     i. Go to the **Implementation Plan** tab and select **Add New Task**.
     ii. Add the **Task Name** (Remove Blade).
     iii. Add a description, such as the following:
     "Create a project, and send the AL-Bulldozer to the project; only the AL-Bulldozer should be modifiable. Within the project, remove the Blade and send the AL-Bulldozer back to the PDM system. Do not forget to refresh your project before proceeding with the modification."
     iv. Assign Engineer1 (eng1) as the Author of the task.
     v. Assign the Engineering Manager (mgr) as the Designated User (Reviewer) of the task, and click **ADD** to complete the creation of the task.
     vi. Expand the Remove Blade task to display its details.
     vii. Select **Add Affected Data** to associate the bulldozer assembly. Search for CAD documents with the name AL-Bulldozer or the number AL-PDM-100-0001. Select the assembly from the search results and click **Add Select Items**.

   The first ECN task is now defined for Engineer1.

   - Task 2: Modification of the bucket by the Supplier
     For purposes of this scenario, the user assigned to the Engineering Manager role is to be assigned the task of coordinating activities with the supplier. To create this coordination task, you would begin by selecting **Add New Task** from the **Implementation Plan** tab.
     i. Specify the task name (Request Supplier Design Update of Bucket).
     ii. Add a description such as the following:
     "Create a project, invite the Supplier, and send the Lower Arm assembly to the project. Only the AL-Bucket should be modifiable. Within the project, create an action item for the supplier."
     iii. Assign the Engineering Manager (mgr) as the Author of the task.
     iv. Assign the Engineering Manager as the Designated User (Reviewer) of the task and click **ADD** to complete the task creation.
v. Expand the Request Supplier Design Update of Bucket task to display its details.

vi. Select **Add Affected Data** to associate the bucket assemblies (AL-PDM-100-0007.asm, AL-PDM-100-0006.asm, AL-PDM-100-0005.asm, and AL-PDM-010-0007.prt), and click the **Add Select Items** button.

The second ECN task is now defined for the Engineering Manager.

---

Task 3: Modification of the toolbox and seat cushion by Engineer2.

i. Select **Add New Task** from the **Implementation Plan** tab to create the task.

ii. Specify the task name (in this example, Modify Toolbox and Add Seat Cushion).

iii. Add a description such as the following:

"In bulldozer assembly AL-PDM-100-0003.asm, interchange the existing toolbox (PDM-030-0001.prt with PDM-030-0002.prt), add the seat cushion (PDM-010-0024.prt), and check it in to the product."

iv. Assign Engineer2 (eng2) as the Author of the task.

v. Assign the Engineering Manager (mgr) as the Designated User (Reviewer) of the task and click **ADD** to complete the task creation.

vi. Expand the Modify Toolbox and Add Seat Cushion task to display its details.

vii. Select **Add Affected Data** to associate AL-PDM-100-0003.asm and the text file, and click **Add Select Items**.
The third ECN task is now defined for Engineer2.

4. Return to the Description tab, select Now in the Submit field, and click OK to complete the definition of the ECN.

5. Navigate to the Home tab and select the Create ECN task. Click Task Complete. The ECN and associated tasks have now been created and distributed to the task Authors.

Task 2. Creating and Working in a Collaborative Project

This task demonstrates the use of a Windchill ProjectLink project to manage a large design change that involves participants from multiple organizations. In this example, assume that you have been assigned the role of Engineer1, who has the following tasks:

- Update the AL-Bulldozer design by removing the bulldozer blade.
- Invite other participants to the project in order to address aspects of the bulldozer design that will be affected by the blade removal.

The following are specific steps for completion of this scenario task:

1. Log on as Engineer1 and review your tasks in the Assignments table on the home page.
2. From your assignment list, select the Complete ECN task for the removal of the bulldozer blade.

3. Select the related link on the Complete ECN Task form to display the ECN form.

4. Expand the Remove Blade task in the Task list to review the details.

5. To create a collaborative project, navigate to the Project tab and select the Create Project action at the top of the table. Create a project named Bulldozer Blade Removal.
   a. Click Next to add members to the project.
   b. Click Next to add a description of the project that will be sent to the new members.
   c. Click Next to define the project details. Enter a number for the project and select Activities, then click OK to create the project.

You have now created the collaborative project to be used for removing the bulldozer blade and updating the associated bulldozer systems, including the hydraulics and controls. The following, specific steps demonstrate how you can add product data to the project. In this case, certain parts of the design are to be updated by the project members, while other objects are provided only for reference.

1. Search for the AL-Bulldozer assembly, and click the (information) icon next to the AL-Bulldozer CAD document listed in the search results in order to view the details page.

2. Select Add to Project from the Actions drop-down menu on the details page.

   Adding a product, project, or CAD document to a project is a two-step process. The first step requires choosing the project and project location to which the objects will be added. In the second step, you must identify which objects are to be added to the project, as well as the actions that can be applied to each of them.

3. As a first step, select the project and project location to which the objects from your PDM system will be added:
   a. Search for the project you created (Bulldozer Blade Removal) by clicking Select next to the Project Name field. Windchill displays the Select Project window, from which you can search for existing projects. For purposes of this example, you will search for and select the Bulldozer Blade Removal project and then click OK to complete the selection.
   b. You can select a target folder by clicking Select next to the Location field. In the Select Folder window, select Default and then click Open to display the available folders. Click OK to complete the operation.
   c. Click Next to proceed to the next step.
4. The second step in adding a product, part, or CAD document to a project requires that you identify the specific dependent objects to be added to the project, as well as the actions that can be applied to each. The Paste dependency definition form allows you to identify the necessary objects and dependencies:

- **Configuration Specification = Latest.** This setting indicates that you want to use the latest available configuration of the assembly. You can use other Configuration Specification settings to select previously stored baselines or checked-in configurations.

- **View = <blank>.** The setting you specify for this field identifies a configuration view, such as as-designed or as-planned, that should be used for the configuration specification.

- **Dependency Processing Type = CAD Document Centric.** This field indicates whether the CAD document or the part structure is to be used for determining the configuration. By selecting CAD Document Centric, you specify that the CAD document structure is to be used for this purpose.

- **Include Parts/CAD Docs = None.** The setting for this field indicates whether or not you want to include the Windchill parts to which the CAD documents are associated. The Selected option includes only the parts for objects selected in the table, while the All option includes every Windchill part associated with a CAD document. If you specify None, no Windchill parts are included.
– **Include Instances = None.** The setting for this field indicates whether or not Pro/ENGINEER family table instances should be included in the configuration. In this case, None specifies that the family table instances are not to be included.

– **Include Dependents = Required.** This field is used to identify the dependent objects to be included in the configuration. Required includes only the objects necessary to regenerate the assembly, while the All option includes every object that has a relationship to the assembly. The None option includes only the assembly.

– **Include Drawings = None.** The setting for this field indicates whether or not the CAD drawings associated with the assembly and its dependents should be included in the configuration.

– **Include Documents = None.** The setting for this field determines whether or not documents referenced by the assembly and its dependents should be included in the configuration.

After these options have been set, click **Refresh Item List** to update the table.

5. From the object list, select the AL-Bulldozer assembly (AL-PDM-100-0001.asm) and then select the **Set Check Out** action at the top of the table. The selected action for the AL-Bulldozer assembly is now set to Check Out, while the selected actions for all other objects are set to Share. As a result, only the AL-Bulldozer assembly will be checked out to the project and can be modified within that context. All other associated objects will have read-only status within the project.

6. Click **OK** to complete checkout and sharing of objects to the project.

After you have completed these steps, you are returned to the AL-Bulldozer details page. When you next navigate to the Bulldozer Blade Removal project on the **Project** tab, you will notice that the AL-Bulldozer assembly has been checked out to the project, while the remaining bulldozer parts have been shared to the project. These shared objects are provided for read-only reference, and act as links to the objects stored in your PDM environment. As noted above, only objects that have been checked out can be modified within the project. In this way, you can effectively manage access to your PDM data, while allowing for efficient collaboration.

Now that the information necessary to remove the blade from the bulldozer has been added to the project, you can optionally invite other project members and assign the project tasks required to complete the design work.

**Task 3. Collaborating with an External Supplier**

This scenario task demonstrates how you can use a Windchill ProjectLink project to invite external users, such as suppliers or customers, into the design process, without providing them direct access to your PDM environment. For purposes of this task, assume that, acting as Engineering Manager, you must set up a project
for your supplier to use in order to modify the bucket of the AL-Bulldozer design to your specifications. After the supplier makes the necessary design changes, you will check the design changes into the PDM system and mark the ECN task as complete.

Step 1. Creating a Project and Tasks for an External Supplier

The following steps provide a specific example of the activities required to create a new project for collaboration with an external vendor and assign that vendor specific tasks necessary to complete the design changes.

1. log on as the Engineering Manager.
2. From your assignment list, select the Complete ECN task for the supplier bucket update.
3. Select the appropriate link on the Complete ECN Task form to display the ECN form.
4. Expand the Supplier Design Update task in the list to review the details.
5. In order to create the new project, to be called Bucket Update, navigate to the Project tab and select the Create Project action. After entering the project name, complete the following to define the project for other members:
   a. Click Next to add members to the project. Add user Supplier as a project member.
   b. Click Next to add a description of the project that will be sent to the new members.
   c. Click Next to define the project details. Enter a number for the project and select Activities, then click OK to create the project.
6. Review the tasks in the Assignment table on the home page. Select the Complete ECN task for the modification of the bucket from the Assignment list.
7. Click the ECN task link on the Complete ECN Task form to display the ECN form.
8. Expand the Modification of Bucket item in the task list to review the details.
9. Click the (information) icon next to the AL-Bucket part listed in the task to navigate to the AL-Bucket details page.
10. Because the supplier will need the Lower Arm assembly for reference purposes, you can select the Used By link on the details page to display all of the assemblies in which AL-Bucket is used.
    Select the Lower Arm assembly in the Used By table to navigate to the details of the assembly.
11. Next, select **Copy** from the **Actions** drop-down menu on the details page for the Lower Arm assembly, in order to share this object to the project.

12. Complete the following steps to specify the project and project location to which the checked-out and shared objects will be added. Navigate to your project (Bucket Update) by selecting the **Project** tab. Within the project, select a folder (**Design**, for example), and select the **Paste** action icon located at the top of the folder table.

13. As previously described, adding a product to a project requires that you identify the specific objects to be added to the project, as well as the actions that can be applied to each. The **Paste** dependency definition form allows you to identify the necessary objects and dependencies. In this example, you make the following selections for the dependency criteria:

   - **Configuration Specification = Latest**. This setting indicates that you want to use the latest available configuration of the assembly. You can use other **Configuration Specification** settings to select previously stored baselines or checked-in configurations.

   - **View = <blank>**. The setting you specify for this field identifies a configuration view, such as as-designed or as-planned, that should be used for the configuration specification.

   - **Dependency Processing Type = CAD Document Centric**. This field indicates whether the CAD document or the part structure is to be used for determining the configuration. By selecting **CAD Document Centric**, you specify that the CAD document structure is to be used for this purpose.

   - **Include Parts/CAD Docs = None**. The setting for this field indicates whether or not you want to include the Windchill parts to which the CAD documents are associated. The **Selected** option includes only the parts for objects selected in the table, while the **All** option includes every Windchill part associated with a CAD document. If you specify **None**, no Windchill parts are included.

   - **Include Instances = None**. The setting for this field indicates whether or not Pro/ENGINEER family table instances should be included in the configuration. In this case, **None** specifies that the family table instances are not to be included.

   - **Include Dependents = Required**. This field is used to identify the dependent objects to be included in the configuration. **Required** includes only the objects necessary to regenerate the assembly, while the **All** option includes every object that has a relationship to the assembly. The **None** option includes only the assembly.

   - **Include Drawings = None**. The setting for this field indicates whether or not the CAD drawings associated with the assembly and its dependents should be included in the configuration.
– **Include Documents = None.** The setting for this field determines whether or not documents referenced by the assembly and its dependents should be included in the configuration.

After these options have been set, click **Refresh Table** to update the object list.

14. From the object list, select the AL-Bucket part, AL-PDM-010-0007.prt, and then click the **Set Check Out** icon at the top of the file list table. The selected action for the AL-Bucket part is now set to Check Out, while the selected actions for all other objects are set to Share. As a result, only the AL-Bucket part will be checked out to the project and can be modified within that context. All other associated objects will have read-only status within the project.

Click **OK** to complete the check-out and sharing of objects to the project.

When you next navigate to the Bucket Update project on the **Project** tab, you will notice that the AL-Bucket part has been checked out to the project, while the remaining objects have been shared to the project. These shared objects are provided for read-only reference, and act as links to the objects stored in your PDM environment.

15. Select **Assignments** from the project menu list and click the **Create Action Item** icon in the **Assignments** table.

16. Enter Update Bucket Design as the name, select Supplier as the owner, and enter a description of the assignment (for example, “Update bucket design per markup or specifications.”).

17. Click **OK** to complete the task assignment.

You have now created the project in which the Supplier will make the required design modifications, and assigned the task that the Supplier must complete.

**Step 2. The Supplier Makes Design Modifications Within the Project**

This section provides a specific example of the activities an external supplier might complete in order to collaborate with you and your product team on a particular aspect of your design project.

When the Supplier logs in to the project, Windchill displays the home page for Supplier. From the **Product** and **Project** tabs, the Supplier has access only to the Bucket Update project and the product data you have added to that project.

For purposes of this scenario, the Supplier will complete the following steps:

1. Log on to the system as the Supplier.

2. Select the Update Bucket Design task from the **Assignments** table in order to view the details of the task.
Tip: Typically a supplier would be provided with a markup and set of instructions for the required modifications. In this scenario, the Supplier simply reviews the text of the assigned task.

3. Proceed with the Bucket design modifications in Pro/ENGINEER Wildfire. (These procedures may vary slightly, depending on the Pro/ENGINEER Wildfire version you are using.)
   a. Launch Pro/ENGINEER Wildfire and navigate to the Tools/Server Registry.
   b. Select Add from the Server Register window and enter a server Name and Location.
   c. Click Check to verify the server connection.
   d. After Pro/ENGINEER Wildfire has connected to the server, the list of products and projects to which the Supplier role has access is displayed. Select Bucket Update as the active project within this server, select the name you just provided, and click Set.
   e. Select the File/Open command to navigate to the server and the Bucket Update project. Select the AL-Bucket part (AL-PDM-010-0007.prt) to open it.

4. Modify the AL-Bucket by changing the length to 110 and the cut pattern to 5.
   Tip: If you are prompted to check out the object, accept the warning.

5. Once the modifications are complete, select File > Check-in > Custom Check-in to update the design changes in the project.
   a. Select CAD Model and CAD Viewable in the Custom Check-in window, and click OK. Click OK in the Check-in window.
   b. The Supplier’s design modifications have now been checked into the Bucket Update project.

6. Exit Pro/ENGINEER Wildfire and return to Windchill to mark the Supplier task as complete.
   a. Select Update Bucket Design from the Assignments table on the home page to navigate to the task details page.
   b. Select Update from the Actions drop-down menu on the task details page (alternatively, click the See Actions link, depending upon your system configuration).
   c. Select Resolution from the Step list on the Update Action Item window to change the execution state to Resolved, and click OK.

At this point, the Supplier has completed the task of modifying the AL-Bucket design.
Step 3. Submitting the Updated Bucket Design and Completing the ECN Task

As the Engineering Manager, you are notified that the Supplier has completed the assigned design changes. In this step, you will submit the updated design to the PDM system and mark the ECN task as complete.

1. Log on to Windchill as Engineering Manager, and navigate to the Project tab and the Bucket Update project.

2. Click the link on the AL-Bucket part (AL-PDM-100-0007.prt) and review the updated bucket design in Windchill ProductView.

   **Tip:** Before proceeding to the next step, select PDM candidate check-in from the Current View drop-down menu on the Folders table in order to restrict the display to those objects eligible for check in to the PDM system.

3. Select the AL-Bucket part (AL-PDM-010-0007.prt) and then select the Send to PDM action from the Actions list.

4. Accept the default settings in the check-in user interface and click OK to check the part back into the PDM system.

5. Navigate to your home page in order to mark the Supplier Bucket Update task as complete.

   a. Select the Complete ECN task in your Assignments table and click the link to the ECN in order to open it.

   b. From the drop-down menu on the ECN page, select Update. Within the Update window, select the Implementation Plan tab and expand the Supplier Bucket Update task. Select Add Resulting Items to search for the AL-Bucket, AL-Upper-Arm, AL-Lower-Arm, and AL-Holder parts (AL-PDM-0010-0007, AL-PDM-100-0007, AL-PDM-100-0005, and AL-PDM-100-0006) to add as the resulting items. Click OK to complete the operation.

   **Tip:** This step identifies the objects resulting from AL-Bulldozer product design activities; later, all object modifications and new objects resulting from this effort will be published to your ERP system.

6. Navigate to the home page and select the Complete ECN task for the modification of the bucket. Click Task Complete.

You have now completed the submission of the Supplier’s design changes and have marked the ECN task as complete.

**Task 4. Making Design Changes in the PDM System**

In a typical product development environment there is a combination of concurrent design modifications occurring in the PDM system and in Windchill ProjectLink. This section demonstrates how, as a member of a product team, you can make design modifications within the PDM system in order to complete CMII
change activities while other design activities are being performed in collaborative projects. In a later task, you will see how members of the project teams can be kept aware of changes occurring within the PDM system. For this task, you will be assuming the role of Engineer2.

1. Log on to the system as Engineer2.

2. From your assignment list, select the Complete ECN task with the name Seat and Toolbox Update.

3. Select the appropriate link on the **Complete ECN Task** form to display the ECN form.

4. Expand the Seat and Toolbox Update task in the list to review the details.

5. Proceed with the design modifications in Pro/ENGINEER Wildfire. (These instructions may vary slightly, depending upon the Pro/ENGINEER Wildfire version you are using.).

   a. Launch Pro/ENGINEER Wildfire and navigate to the **Tools/Server Registry**.

   b. Select **Add** from the **Server Register** window and enter a server **Name** and **Location**.

   c. Click **Check** to verify the server connection.

   d. After Pro/ENGINEER Wildfire has connected to the server, the list of products and projects to which the Engineer2 role has access is displayed.

   e. Select AL-Bulldozer as the active product within this server, select the name you just provided, and click **Set**.

6. From the Pro/ENGINEER Wildfire Folder Browser, select the server you created in order to open the server home page in the embedded browser.

7. Review the tasks in the **Assignments** table on the home page. From your list of assignments, select the Complete ECN task for modification of the seat and toolbox.

8. Select the **ECN Task** link on the **Complete ECN Task** form to display the ECN.

9. Expand the Modify Toolbox and Add Seat Cushion item in the task list to review the specific task details.

10. Select the AL-Frame part listed in the task, then drag and drop it into your Pro/ENGINEER Wildfire user interface. This opens the AL-Frame assembly in Pro/ENGINEER Wildfire.

11. After the assembly has been opened in Pro/ENGINEER Wildfire, add the Cushion, PDM-010-0024.prt, located in the General library and assemble it to the seat.
Tip: If you are prompted to check out the object, accept the warning.

12. Go back to your assembly and interchange PDM-030-0001.prt with PDM-030-0002.prt. (Assume that both components belong to the same interchange group.)

13. Once the modifications are complete, select File > Check-in > Custom Check-in to update the design changes in the product.
   a. Select CAD Model and CAD Viewable in the Custom Check-in window, and click OK. Click OK in the Check-in window.
   b. The seat and toolbox design modifications have now been checked into the AL-Bulldozer product.

14. Navigate to your home page in order to mark the Seat and Toolbox Update task as complete.
   a. Select the Complete ECN task in your Assignments table and click the link to the ECN to open it.
   b. From the drop-down menu on the ECN page, select Update. Within the Update window, select the Implementation Plan tab and expand the Seat and Toolbox Update task. Select Add Resulting Items to search for the AL-Frame assembly (AL-PDM-100-0003.asm) to add as the resulting item. Click OK to complete the operation.

   Tip: This step identifies the object resulting from AL-Bulldozer product design activities; later, all object modifications and new objects resulting from this effort will be published to your ERP system.

15. Return to the home page and select the Complete ECN task for the modification of the seat and toolbox. Click Task Complete.

You have now completed the submission of your design changes and have marked the ECN task as complete.

Task 5. Updating a Collaborative Project

This section provides further demonstration of the ways in which a project (created in Task 2) can be used as a collaborative environment for design changes that involve multiple users and organizations. Although the design modification tasks for this scenario have been performed sequentially, these tasks are typically performed concurrently in a production environment.

To begin this task, you will return to the Blade Removal project created in Task 2. The steps described below illustrate how changes that have occurred concurrently can be incorporated into the design changes of this project team. In addition, you will use the Pro/ENGINEER Wildfire embedded browser to perform common Windchill activities from within your Pro/ENGINEER Wildfire environment.

1. Log on to the system as Engineer1.
2. Launch Pro/ENGINEER Wildfire and navigate to the **Tools/Server Registry**.
   a. Select **Add** from the **Server Register** window and enter a server **Name** and **Location**.
   b. Click **Check** to verify the server connection.
   c. After Pro/ENGINEER Wildfire has connected to the server, the list of products and projects to which the Engineer1 role has access are displayed. Select Bulldozer Blade Removal as the active project within this server, select the name you just provided, and click **Set**.

3. From the Pro/ENGINEER Wildfire Folder Browser select the link to the server you created in order to open the server home page in the embedded browser. Select the **Project** tab and navigate to the Bulldozer Blade Removal project.

4. Click the **Refresh Project** icon to update shared objects for which design changes have been made in the PDM system. In the **Refresh Project** window select all of the objects listed in the table, click the **Set Refresh** icon, and then click **OK**. The shared objects in the project are updated to reference the latest iterations of the objects in the PDM system.

5. Select the URL for AL-Bulldozer, and drag and drop the AL-Bulldozer assembly into the Pro/ENGINEER Wildfire user interface. This opens the AL-Bulldozer in the Pro/ENGINEER Wildfire session.

   **Tip:** If you are prompted to check out the object, accept the warning.
6. Right-click on Blade (PDM-010-0023) in the model tree and select **Delete**.

7. Once the blade is removed, select **File > Check-in > Custom Check-in** to update the design changes in the product.
   a. Select **CAD Model** and **CAD Viewable** in the **Custom Check-in** window, and click **OK**. Click **OK** in the **Check-in** window.
   b. The updated AL-Bulldozer assembly has now been checked into the Bulldozer Blade Removal project.

Now that the project team’s design changes are complete, the changes are ready for submission to the PDM system.

8. Exit Pro/ENGINEER Wildfire and return to Windchill. Navigate to the Bulldozer Blade Removal project.

9. Select the AL-Bulldozer assembly (AL-PDM-001-0001.asm) and then select the **Send to PDM** action from the **Actions** list.

10. Accept the default settings in the check-in user interface and click the **OK** button to check the assembly back into the PDM system.

11. Navigate to your home page in order to mark the Bulldozer Blade Removal task as complete.
   a. Select the Complete ECN task in your **Assignments** table and click the link to the ECN to open it.
   b. From the drop-down menu on the ECN page, select **Update**. Within the **Update** window, select the **Implementation Plan** tab and expand the Remove Blade task. Select **Add Resulting Items** to search for the AL-Bulldozer part (AL-PDM-001-0001.asm) to add as the resulting item. Click **OK** to complete the operation.

   **Tip:** This step identifies the objects resulting from AL-Bulldozer product design activities; later, all object modifications and new objects resulting from this effort will be published to your ERP system.

12. Navigate to the home page and select the Complete ECN task for the modification of the bucket. Click **Task Complete**.

You have now completed the submission of the Blade Removal and have marked the ECN task as complete.

**Task 6. Reviewing Changes and Publishing Updates to the ERP System**

This task can only be completed if Windchill ESI has been installed and configured with an ERP system.

To complete this scenario, assume that you are again acting in the role of Engineering Manager and that your final tasks are as follows:
• Review all modifications made to the AL-Bulldozer design
• Review all new objects
• Assign distribution targets to the new objects
• Publish all changes to your ERP system

The following is a specific example of how you might complete these tasks. While this scenario assumes that all change activities have been completed satisfactorily, the change management capabilities and workflows in Windchill allow you to reroute objects that require additional changes.

Step 1. Reviewing the New Assembly

The following is a specific example of the steps involved in reviewing the work done to satisfy the ECN described in previous sections:

1. Log on as Engineering Manager and search for AL-PDM-100-0001.asm. Click the (information) icon next to the assembly in the search results to access its details page.
2. On the AL-Bulldozer details page, click on the thumbnail icon to open Windchill ProductView. Review the modifications.
3. From the Assignments table on your Home tab, select Task Complete for each of the Review ECN tasks related to bulldozer modification.

Step 2. Assigning Distribution Targets and Publishing to Your ERP System

The following is a specific example of how the completed design can be published to the ERP system:

1. From the Product tab, select the AL-Bulldozer product and then click the Product Structure link.
2. Within the Product Structure table, select all parts and then select Expand All from the Actions drop-down menu. Select AL-PDM-100-0001.asm, AL-PDM-100-0003, AL-PDM-100-0005, AL-PDM-100-0006, AL-PDM-100-0007, and AL-PDM-010-0007 to be published to the ERP system. Click the Update Distribution Targets icon.
3. Select Add to add existing distribution targets to the list, enter an asterisk (*) in the Name field, and click Search. From the search results table, select a distribution target (Berlin in this example). Click OK in the Update Distribution Targets window to complete the definition of the ERP instance to which the parts should be published.
4. The CMII change process requires that the Change Administrator III review and audit the ECN. Assuming that you are also acting as Change Administrator III, return to the home page, select the Review ECN task, and,
after completing your review, click **Complete Task**. Complete the same process for the Audit ECN task. This completes and releases the ECN.

Release of the ECN automatically releases all resulting objects and triggers publication to the ERP system.

5. If you have Site Administrator privileges or are logged in as wcadmin, you can go to **Site > Utilities > Enterprise Systems Activity Log** to see the publication transaction history. Alternatively, you can go to the details page for any of the released parts and click **Distribution Targets** to see that the part has been published.